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11
Developing Your  
Data Model
In This Chapter

● Setting up the data, analysis, and presentation layers

● Applying data model best practices

● Leveraging Excel functions to deliver data

● Using Excel tables that expand with data

A data model provides the foundation upon which your dashboard or report is built. When you col-
lect and analyze data, you’re essentially building a data model that feeds your presentation. In this 
chapter, we discuss how to build and manage an efficient data model. Although you’ll discover how 
to build cool dashboard components in later chapters, they won’t do you any good if you can’t con-
struct an effective data model. On that note, let’s get started.

Building a Data Model
Building an effective data model isn’t as complicated as you may think. The problem is that most 
people spend little time thinking about the data model that supports a final presentation. If they 
think about it at all, they usually start by imagining a mock-up of the finished dashboard and work 
backward from there.
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So try thinking a bit about the end-to-end process. Where does the source data reside? How should 
that data be organized? What calculations do you need to perform? How will those results be fed to 
the dashboard? How will the dashboard be updated?

Obviously, the answers to these questions are situation-specific. But here is a good place to start.

Separating the data, analysis, and presentation layers
One of the key concepts of a data model is the organization of data into three layers: data, analysis, 
and presentation. The basic idea is that you don’t want your data to become too tied into any one 
particular way of presenting that data.

For example, think about a business invoice. The financial data on that invoice is not the true source 
of that data. It’s merely a presentation of the actual data that’s stored in some database. That data 
can then be organized and presented to you in many ways: in charts, in tables, on dashboards, or 
even on websites. This sounds obvious, but Excel users often fuse the data, analysis, and presentation 
layers together into one final project.

The best approach is to create three layers in your data model. You can think of these layers as three 
different worksheets in an Excel workbook. Sometimes this also is a good way to organize your data 
model. One sheet holds the raw data that feeds your report, one sheet serves as a staging area where 
the calculations are performed, and one serves as the final presentation. Figure 11-1 illustrates the 
three layers of an effective data model.

Tip  

You don’t necessarily have to place your data, analysis, and presentation layers on dif-
ferent worksheets . In small data models, you may find it easier to place your data in one 
area of a worksheet while building your staging tables in another area of the same 
worksheet .

Why even bother with the three-tiered data model? Imagine that you have only the table in Figure 
11-2. Hard-coded tables, such as this one, are common. This table is a combination of data, calcula-
tions, and presentation. Not only does this table tie you to a specific analysis but also there’s little to 
no transparency into the content of the analysis. Also, what happens when you need to report by 
quarters or when another dimension of analysis is needed? Do you import a table that consists of 
more columns and rows? How does that affect your data model?

Taking the easy route and avoiding the extra work of separating the data, analysis, and presentation 
layers can lead to more problems later. Take a moment to review each layer and the role it plays in 
building out your dashboard model.

The data layer
As you can see in Figure 11-1, the data layer consists of the raw data that feeds your dashboard. The 
data in the data layer is typically used “as is” from whatever source you derived it from. That is to say, 
you perform no analysis in the data layer.
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Figure 11-1: An effective data model separates data, analysis, and presentation layers.

Figure 11-2: Avoid using hard-coded tables that fuse data, analysis, and presentation.
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However, you’ll find that not all data makes for effective data modeling. For example, the data shown 
in Figure 11-3 would make it impractical to apply any analysis outside what’s already there. For 
instance, how would you calculate and present the average of all bike sales? How would you calcu-
late a list of the top ten best performing markets?

Figure 11-3: Not all data can be a good source for your data layer.

With this setup, you’re forced into very manual processes that are difficult to maintain month after month. 
Any analysis outside the high-level ones already in the report is basic at best — even with fancy formulas. 
Furthermore, what happens when you’re required to show bike sales by month? When your data model 
requires analysis with data that isn’t in the worksheet report, you’re forced to search for other data.

Ideally, you want your data layer to come in one of two forms:

➤ Flat data tables: Data repositories are organized by row and column. Each row corresponds to a 
set of data elements, or a record. Each column is a field. A field corresponds to a unique data ele-
ment in a record. Figure 11-4 contains the same data as the data shown in Figure 11-3, but is in 
flat data table format. Flat tables lend themselves nicely to data modeling in Excel because they 
can be detailed enough to hold the data that you need and still be conducive to a wide array of 
simple formulas and calculations in your analysis layer — SUM, AVERAGE, VLOOKUP, and SUMIF, 
just to name a few. Later in this chapter, we discuss functions that come in handy in a data model.

Figure 11-4: A flat data table.
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➤ Tabular data set: Ideal for pivot-table-driven data models. Figure 11-5 illustrates a tabular data 
set. Note that the primary difference between a tabular data set, as shown in Figure 11-5, and a 
flat data file is that the column labels don’t double as actual data. For instance, in Figure 11-4, 
the month identifiers are integrated into the column labels. In Figure 11-5, the Sales Period col-
umn contains the month identifier. This subtle difference in structure is what makes tabular 
data sets optimal data sources for pivot tables. This structure ensures that key pivot table func-
tions, such as sorting and grouping, work the way they should.

Figure 11-5: A tabular data set.

The analysis layer
The analysis layer consists primarily of formulas that analyze and pull data from the data layer into 
formatted tables (commonly referred to as staging tables). These staging tables ultimately feed the 
reporting components in your presentation layer. In short, the sheet that contains the analysis layer 
becomes the staging area where data is summarized and shaped to feed the reporting components.

This setup offers a couple of benefits: 

➤ You can easily update the entire data model simply by replacing the raw data with updated 
data. The formulas in the analysis tab then continue to work with the latest data.

➤ You can create any added analyses easily by using different combinations of formulas on the 
analysis tab. If you need data that doesn’t exist in the data layer, you can add a column to the 
end of the raw data without disturbing the analysis or presentation layers.

The presentation layer
The presentation layer is your storefront. It contains all the charts, visualizations, and dashboard com-
ponents that you want your audience to see. The presentation layer is the most flexible because you 
can choose a plethora of tools, graphics, and charts to create the theme and style of your dashboard. 
Also, because the presentation layer feeds from the analysis layer, the data needed for each compo-
nent is always consistent in content and format.
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Data Model Best Practices
One of Excel’s most attractive features is its flexibility. You can construct an intricate system of calculations, 
linked cells, and formatted summaries that work together to create your final presentation. But creating a 
successful dashboard requires more than just slapping data onto a worksheet. A poorly designed data 
model can lead to hours of excess work maintaining and updating your presentation. On the other hand, 
an effective data model enables you to easily repeat monthly update processes without damaging your 
dashboards or your sanity.

In this section, we discuss some data modeling best practices that help you start on the right foot 
with your dashboard projects.

Avoid storing excess data
In Chapter 1, you may have read that measures used on a dashboard should absolutely support the 
initial purpose of that dashboard. The same concept applies to the back-end data model. You should 
import only data that’s necessary to fulfill the purpose of your dashboard or report.

In an effort to have as much data as possible at their fingertips, many Excel users bring into their 
worksheets every piece of data they can get their hands on. You can spot these people by the 40MB 
files they send through e-mail. You’ve seen these worksheets — two tabs that contain presentation 
and then six hidden tabs that contain thousands of lines of data (most of which isn’t used). They 
essentially build a database in their worksheet.

What’s wrong with utilizing as much data as possible? Well, here are a few issues:

➤ Excess data increases the number of formulas. If you’re bringing in all raw data, you have 
to aggregate that data in Excel. This inevitably causes you to exponentially increase the num-
ber of formulas you have to employ and maintain. Remember your data model is a vehicle 
for presenting analyses, not processing raw data. The data that works best in the presenta-
tion layer is what’s already been aggregated and summarized into useful views that can be 
navigated and fed to dashboard components. Importing data that’s already been aggre-
gated as much as possible is far better. For example, if you need to report on Revenue by 
Region and Month, there’s no need to import sales transactions into your data model. 
Instead, use an aggregated table consisting of Region, Month, and Sum of Revenue.

➤ Excess data degrades the performance of your presentation layer. In other words, 
because your dashboard is fed by your data model, you need to maintain the model behind 
the scenes (likely in hidden tabs) when distributing the dashboard. Besides the fact that it 
causes the file size to be unwieldy, including too much data in your data model can actually 
degrade the performance of your dashboard. Why? When you open an Excel file, the entire 
file is loaded into memory (or RAM) to ensure quick data processing and access. The draw-
back to this behavior is that Excel requires a great deal of RAM to process even the smallest 
change in your worksheet. You may have noticed that when you try to perform an action on 
a large formula-intensive data, Excel is slow to respond, giving you a Calculating indicator in 
the status bar. The larger your data is, the less efficient the data crunching in Excel is.

➤ Excess data limits the scalability of your data model. Imagine that you’re working in a small 
company and you’re using monthly transactions in your data model. Each month holds 80,000 
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lines of data. As time goes on, you build a robust process complete with all the formulas, pivot 
tables, and macros you need to analyze the data that’s stored in your neatly maintained tab. Now 
what happens after one year? Do you start a new tab? How do you analyze two data on two dif-
ferent tabs as one entity? Are your formulas still good? Do you have to write new macros?

You can avoid such issues by importing only aggregated and summarized data that’s useful to the 
core purpose of your dashboard.

Use tabs to document and organize your data model
Wanting to keep your data model limited to one worksheet tab is natural. In our opinion, keeping 
track of one tab is much simpler than using different tabs. However, limiting your data model to one 
tab has its drawbacks, including the following:

➤ Limits the quality of your analysis. Because only so much text can fit on a tab, using one 
tab imposes real-estate restrictions that can limit your analyses. Consider adding tabs to your 
data model to provide additional data and analysis that may not fit on just one tab.

➤ Makes for a confusing data model. When working with a large quantity of data, you need 
plenty of staging tables to aggregate and shape the raw data so that it can be fed to your 
dashboard components. If you use only one tab, you’re forced to position these staging 
tables below or to the right of your data. Although this may provide all the elements needed 
to feed your presentation layer, a good deal of scrolling is necessary to view all the elements 
positioned in a wide range of areas. This makes the data model difficult to understand and 
maintain. Use separate tabs to hold your staging tables, particularly in data models that con-
tain large quantities of data that take a lot of real estate.

➤ Limits the amount of documentation you can include. You’ll find that your data models 
easily become a complex system of intertwining links among components, input ranges, 
output ranges, and formulas. Sure, it all makes sense while you’re building your data model, 
but try coming back to it after a few months. You’ll find that you’ve forgotten what each data 
range does and how each range interacts with the final presentation layer. To avoid this 
problem, consider adding a data model map tab to your data model. The map tab essentially 
summarizes the key ranges in the data model and allows you to document how each range 
interacts with the dashboard components in the final presentation layer. As you can see in 
Figure 11-6, the data model map is nothing fancy; just a table that lists some key information 
about each range in the model.

Figure 11-6: A data model map provides documentation that outlines how your data model works.
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You can include any information you think appropriate in your data model map. The idea is to give 
yourself a handy reference that guides you through the elements in your data model.

Test your data model before building  
presentation components
This best practice is simple. Make sure that your data model does what it’s supposed to do before 
building dashboard components on top of it. In that vein, here are a few things to watch for:

➤ Test your formulas to be sure that they’re working properly. Make sure your formulas 
don’t produce errors and that each formula outputs expected results.

➤ Double-check your main data to be sure that it’s complete. Check that your data table 
has not truncated when transferring to Excel. Also, be sure that each column of data you 
need is present with appropriate data labels.

➤ Make sure all numeric formatting is appropriate. Be sure that the formatting of your data 
is appropriate for the field. For example, check to see that dates are formatted as dates, cur-
rency values are formatted properly, and that the correct number of decimal places is dis-
played where needed.

The obvious goal here is to eliminate easily avoidable errors that may cause complications later.

Speaking of documenting your data model . . .
Another way to document the logic in your data model is to use comments and labels liberally. It’s 
amazing how a few explanatory comments and labels can help clarify your worksheets. The general 
idea here is that the logic in your model should be clear to you even after you’ve been away from 
your data model for a long period of time.

Also, consider using colors to identify the ranges in your data model. Using colors in your data 
model enables you to quickly look at a range of cells and get a basic indication of what that range 
does. The general concept behind this best practice is that each color represents a range type. For 
example, you could use yellow to represent staging tables used to feed the charts and the tables in 
your presentation layer. You could use gray to represent formulas that aren’t to be altered or 
touched, or purple to represent reference tables used for lookups and drop-down lists.

You can use any color you want; it’s up to you to give these colors meaning. The important thing is 
that you have a visual distinction between the various ranges being used in your data model. If you 
use different colors, it’s important to fully document what each color means.
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Excel Functions for Your Data Model
As we discussed, the optimal data model for any dashboard separates data, analysis, and presenta-
tion into three distinct layers. Although all three layers are important, the analysis layer is where the 
real art comes into play. The fundamental task of the analysis layer is to extract information from the 
data layer for use in the staging tables that feed your charts, tables, and other dashboard compo-
nents. To do this effectively, you need to use formulas that serve as data delivery mechanisms — for-
mulas that deliver data to a destination range.

You see, the information you need lives in your data layer (typically, a table containing aggregated 
data). Data delivery formulas are designed to get that data and deliver it to the analysis layer so it can 
be analyzed and shaped. The cool thing is that after you’ve set up your data delivery formulas, your 
analysis layer automatically updates each time your data layer is refreshed.

Now, take a look at a few Excel functions that work particularly well in data delivery formulas. As you 
go through the examples here, you’ll start to see how these concepts come together.

Understanding lookup tables
In the following sections, you’ll see frequent use of the term lookup table. A lookup table is essentially 
a range of data that holds information in a structure that can be used to extract the needed data 
points. In the context of these examples, you can assume the lookup table will be the data layer.

A lookup table can come in several forms:

➤ One column or row: You may have a list of manager names in a single column. That list can 
be used as a lookup table to find a manager based on his name or his position number 
within the column.

➤ Range with multiple data columns: You may have a table with product numbers and 
prices. You can use a list table as a lookup to find a specific price based on its corresponding 
product number. In this scenario, you need a formula that performs lookup on the product 
number to get the appropriate price.

➤ A position array: In some cases, you need to look up a value solely based on a particular 
position within an array of values. For instance, you may need to find the revenue amount 
for the 14th week in a year. If you have every value for each week in the year listed in order, 
you can extract the revenue amount for the 14th value in the list.

The VLOOKUP function
The VLOOKUP function finds a specific value in the first column of a lookup table and returns the cor-
responding value in a specified table column. The lookup table is arranged vertically. In Figure 11-7, 
the table on the top shows sales by month and product number. The table on the bottom translates 
those product numbers to actual product names. The VLOOKUP function connects the appropriate 
product name to each respective product number.
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Figure 11-7: The VLOOKUP function finds the appropriate product name for each product number.

VLOOKUP basics
To see how the VLOOKUP function works, take a moment to review the basic syntax. A VLOOKUP 
function requires four arguments:

VLOOKUP(lookup_value,table_array,col_index_num,range_lookup)

➤ lookup_value: The value that you want to look up in the first column of the lookup table. In 
Figure 11-7, the lookup_value is the product number. Therefore, the first argument for all the 
formulas shown in Figure 11-7 references column C.

➤ table_array: The range that contains the lookup table. In Figure 11-7, that range is D16:E22. 
Please note that for the VLOOKUP function to work, the leftmost column of the table must be 
the matching value. For example, if you’re matching product numbers, product numbers 
must be in the first column of the lookup table. Also, the reference that you use for this argu-
ment is an absolute reference. This means that the column and row references are prefixed 
with dollar ($) signs — as in $G$2:$H$8. This ensures that the references don’t shift while you 
copy the formulas down or across.

➤ col_index_num: The column number from within the lookup table that contains the match-
ing value. In Figure 11-7, the second (column E) contains the product name, so the formula 
uses the number 2. If the product name column were the fourth column in the lookup table, 
the number 4 would be used.

➤ range_lookup: Optional. You can specify whether you’re looking for an exact match for 
your value or an approximate match. If an exact match is needed, type FALSE for this argu-
ment. If the closest match will do, type TRUE or leave the argument blank.
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Adding VLOOKUP formulas to a data model
Using a few VLOOKUP formulas and a simple drop-down list, you can create a data model that not 
only delivers data to the appropriate staging table but also allows you to dynamically change data 
views based on a selection you make. Figure 11-8 illustrates the setup.

On the Web 

To see this effect in action, go to www.wiley.com/go/exceldr to get the Chapter 
11 Samples.xlsx workbook . Open that workbook to see the VLOOKUP1 tab . 

Figure 11-8: Using the VLOOKUP function to extract data and change data views.

The data layer in Figure 11-8 resides in the range A9:F209. The analysis layer displays in range E2:F6. 
The data layer consists of all the formulas that extract the appropriate data. As you can see, if you 
select Chevron in cell C3, the VLOOKUP formula extracts the data for Chevron from the data layer.

Note  

You may notice that the VLOOKUP formulas in Figure 11-8 specify a table_array argu-
ment of $C$9:$F$5000 . So the lookup table that the formulas point to stretches from C9 
to F5000 . That may seem strange because the table ends at F209 . Why would you force 
your VLOOKUP formulas to look at a range far past the end of the data table?

Remember that the idea behind separating the data layer and the analysis layer is that 
your analysis layer can automatically update when you update your data . So when you 
get new data next month, you can simply replace the data layer in the model without 
having to rework your analysis layer . Allowing for more rows than necessary in your 
VLOOKUP formulas ensures that if your data layer grows, records won’t fall outside the 
lookup range of the formulas .

Later in this chapter (in the “Working with Excel Tables” section), we show you how to 
automatically keep up with growing data tables by using the Excel table feature .
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Using drop-down lists
In the example illustrated in Figure 11-8, the data model allows you to select customer names (that 
is, the AccountName field) from a drop-down list when you click cell C3. The customer name serves 
as the lookup value for the VLOOKUP formulas. Changing the customer name extracts a new set of 
data from the data layer. This allows you to quickly switch from one customer to another without 
having to remember and type the customer name.

Now, as cool as this seems, the reasons for this setup aren’t all cosmetic. There are practical reasons 
for adding drop-down lists to your data models.

Many of your models consist of multiple analysis layers. Although each analysis layer is different, the 
layers often need to revolve around a shared dimension, such as the same customer name, the  
market, or the region. For instance, when you have a data model that reports on Financials, Labor 
Statistics, and Operational Volumes, you want to ensure that when the model is reporting Financials 
for the South region, the Labor Statistics are for the South region as well.

An effective way to ensure that this happens is to force your formulas to use the same dimension ref-
erences. If cell C3 is where you switch customers, every analysis that is customer-dependent should 
reference cell C3. Drop-down lists allow you to have a predefined list of valid variables located in a 
single cell. With a drop-down list, you can easily switch dimensions while building and testing multi-
ple analysis layers.

Adding a drop-down list is a relatively easy thing to do with Excel’s Data Validation functionality. To 
add a drop-down list:

 1. Click the Data tab on the Ribbon.

 2. Click the Data Validation button.

 3. In the Data Validation dialog box, click the Settings tab (see Figure 11-9).

 4. In the Allow drop-down list, select List.

 5. In the Source box, specify the range of cells that contain your predefined selection list.

 6. Click OK.

Figure 11-9: You can use data validation to create a predefined list of valid variables for your data 
model.
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The HLookup function
The HLOOKUP function is the less popular cousin of the VLOOKUP function. The H in HLOOKUP 
stands for horizontal. Because Excel data is typically vertically oriented, most situations require a ver-
tical lookup (or VLOOKUP). However, some data structures are horizontally oriented, requiring a hori-
zontal lookup; thus the HLOOKUP function comes in handy. The HLOOKUP searches a lookup table to 
find a single value from a row of data where the column label matches a given criterion.

HLOOKUP basics
Figure 11-10 demonstrates a typical scenario where HLOOKUP formulas are used. The table in C3 
requires quarter-end numbers (March and June) for 2012. The HLOOKUP formulas use the column 
labels to find the correct month columns and then locate the 2012 data by moving down the appro-
priate number of rows. In this case, 2012 data is in row 4, so the number 4 is used in the formulas.

Figure 11-10: HLOOKUP formulas help find March and June numbers from the lookup table.

To get your mind around how this works, take a look at the basic syntax of the HLOOKUP function.

HLOOKUP(lookup_value,table_array,row_index_num,range_lookup)

➤ lookup_value: The value that you want to look up. In most cases, these values are column 
names. In the example in Figure 11-10, the column labels are being referenced for the lookup_
value. This points the HLOOKUP function to the appropriate column in the lookup table.

➤ table_array: The range that contains the lookup table. In Figure 11-10, that range is B9:H12. 
Like the VLOOKUP examples earlier in this chapter, the references used for this argument are 
absolute, which means the column and row references are prefixed with dollar ($) signs — as 
in $B$7:$H$10. This ensures that the reference doesn’t shift while you copy the formula 
down or across.

➤ row_index_num: The row number that contains the value that you’re looking for. In the 
example in Figure 11-10, the 2012 data is located in row 4 of the lookup table. Therefore, the 
formulas use the number 4.

➤ range_lookup: You can specify whether you’re looking for an exact match or an approxi-
mate match. If an exact match is needed, enter FALSE for this argument. If the closest match 
will do, enter TRUE or leave the argument blank.
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Applying HLOOKUP formulas to a data model
HLOOKUPs are especially handy for shaping data into structures appropriate for charting or other 
types of reporting. A simple example is demonstrated in Figure 11-11. With HLOOKUPs, the data 
shown in the raw data table at the bottom of the figure is reoriented in a staging table at the top. 
When the raw data is changed or refreshed, the staging table captures the changes.

Figure 11-11: In this example, HLOOKUP formulas pull and reshape data without disturbing the raw  
data table.

The SUMPRODUCT function
The SUMPRODUCT function is actually listed under the math and trigonometry category of Excel 
functions. Because the primary purpose of SUMPRODUCT is to calculate the sum product, most peo-
ple don’t know you can actually use it to look up values. In fact, you can use this versatile function 
quite effectively in most data models.

SUMPRODUCT basics
The SUMPRODUCT function is designed to multiply values from two or more ranges of data and then 
add the results together to return the sum of the products. Take a look at Figure 11-12 to see a typi-
cal scenario where the SUMPRODUCT is useful.

In Figure 11-12, you see a common analysis where you need the total sales for the years 2012 and 
2011. As you can see, to get the total sales for each year, you first have to multiply Price by the num-
ber of Units to get the total for each Region. Then you have to sum those results to get the total sales 
for each year.

With the SUMPRODUCT function, you can perform the two-step analysis with just one formula. 
Figure 11-13 shows the same analysis with SUMPRODUCT formulas. Instead of using 11 formulas, you 
can accomplish the same analysis with just three!
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Figure 11-12: Without the SUMPRODUCT, getting the total sales for each year involves a two-step process: First 
multiply price and units and then sum the results.

Figure 11-13: The SUMPRODUCT function allows you to perform the same analysis with just three formulas 
instead of 11.

The syntax of the SUMPRODUCT function is fairly simple:

SUMPRODUCT(array1,array2, ...)

The array argument represents a range of data. You can use anywhere from two to 255 arrays in a 
SUMPRODUCT formula. The arrays are multiplied together and then added. The only hard-and-fast 
rule you have to remember is that all the arrays must have the same number of values. That is to say, 
you can’t use the SUMPRODUCT if range X has 10 values and Range Y has 11 values. Otherwise, you 
get the #VALUE! error.

A twist on the SUMPRODUCT function
The interesting thing about the SUMPRODUCT function is that you can use it to filter out values. Take 
a look at Figure 11-14 to see what I mean.

The formula in cell E12 is pulling the sum of total units for just the North region. Meanwhile, cell E13 
is pulling the units logged for the North region in the year 2011.
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Figure 11-14: You can use the SUMPRODUCT function to filter data based on criteria.

To understand how this works, take a look at the formula in cell E12 shown in Figure 11-14. That for-
mula reads SUMPRODUCT((C3:C10=”North”)*(E3:E10)).

In Excel, TRUE evaluates to 1 and FALSE evaluates to 0. Every value in Column C that equals “North” 
evaluates to TRUE or 1. Where the value is not “North”, it evaluates to FALSE or 0. The part of the for-
mula that reads (C3:C10=”North”) enumerates through each value in the range C3:C10, assigning a 1 
or 0 to each value. Then internally, the SUMPRODUCT formula translates to

(1*E3)+(0*E4)+(0*E5)+(0*E6)+(1*E7)+(0*E8)+(0*E9)+(0*E10).

This gives you the answer of 1628 because this next formula equals 1628.

(1*751)+(0*483)+(0*789)+(0*932)+(1*877)+(0*162)+(0*258)+(0*517)

Applying SUMPRODUCT formulas to a data model
As always in Excel, you don’t have to hard-code the criteria in your formulas. Instead of explicitly 
using “North” in the SUMPRODUCT formula, you can reference a cell that contains the filter value. 
You can imagine that cell A3 contains the word “North”, in which case, you can use (C3:C10=A3) 
instead of (C3:C10=”North”). This way, you can dynamically change your filter criteria, and your for-
mula keeps up.

Figure 11-15 demonstrates how you can use this concept to pull data into a staging table based on 
multiple criteria. Note that each of the SUMPRODUCT formulas shown here references cells B3 and 
C3 to filter on Account and Product Line. Again, you can add data validation drop-down lists to cells 
B3 and C3, allowing you to easily change criteria.
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Figure 11-15: You can use the SUMPRODUCT function to pull summarized numbers from the data layer into 
staging tables.

The Choose function
The CHOOSE function returns a value from a specified list of values based on a specified position 
number. For instance, if you enter the formulas CHOOSE(3,”Red”, “Yellow”, “Green”, “Blue”) into a cell, 
Excel returns Green because Green is the third item in the list of values. The formula CHOOSE(1,”Red”, 
“Yellow”, “Green”, “Blue”) returns Red. Although this may not look useful on the surface, the CHOOSE 
function can enhance your data models dramatically.

CHOOSE basics
Figure 11-16 illustrates how CHOOSE formulas can help pinpoint and extract numbers from a range 
of cells. Note that instead of using hard-coded values, like Red, Green, and so on, you can use cell ref-
erences to list the choices.

Figure 11-16: The CHOOSE function allows you to find values from a defined set of choices.
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Take a moment to review the basic syntax of the CHOOSE function:

CHOOSE(index_num,value1,value2,...)

➤ index_num: Allows you to specify the position number of the chosen value in the list of val-
ues. If the third value in the list is needed, the Index_num is 3. The Index_num argument 
must be an integer between one and the maximum number of values in the defined list of 
values. That is to say, if there are ten choices defined in the CHOOSE formula, the Index_num 
argument can’t be more than ten.

➤ value: Represents a choice in the defined list of choices for that CHOOSE formula. The value 
arguments can be hard-coded values, cell references, defined names, formulas, or functions. 
Starting in Excel 2007, you can have up to 255 choices listed in your CHOOSE functions. In 
Excel 2003, you were limited to 29 value arguments.

Applying CHOOSE formulas to a data model
The CHOOSE function is especially valuable in data models where there are multiple layers of data 
that need to be brought together. Figure 11-17 illustrates an example where CHOOSE formulas help 
pull data together.

In this example, you have two data tables: one for Revenues and one for Net Income. Each contains 
numbers for separate regions. The idea is to create a staging table that pulls data from both tables so 
that the data corresponds to a selected region.

To understand what’s going on, focus on the formula in cell F3 shown in Figure 11-17. The formula is 
CHOOSE($C$2,F7,F8,F9,F10). The index_num argument is actually a cell reference that looks at the value 
in cell C2, which happens to be the number 2. As you can see, cell C2 is actually a VLOOKUP formula that 
pulls the appropriate index number for the selected region. The list of defined choices in the CHOOSE for-
mula is essentially the cell references that make up the revenue values for each region: F7, F8, F9, and F10. 
So the formula in cell F3 translates to CHOOSE(2, 27474, 41767, 18911, 10590). The answer is 41,767.

Figure 11-17: The CHOOSE formulas ensure that the appropriate data is synchronously pulled from multiple 
data feeds.
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Working with Excel Tables
One of the challenges you can encounter when building a data model is a data table that expands 
over time. That is to say, as you add new data, the number of records increases. Take a look at Figure 
11-18. In this figure, you see a simple table that serves as the source for the bar chart. Notice that the 
table lists data for January through June.

Imagine that next month, this table expands to include July data. You’ll have to manually update 
your chart to include July data. Now imagine that you have this same issue across your data model, 
with multiple data tables that link to multiple staging tables and dashboard components. You can 
see that keeping up with changes each month would be an extremely painful task.

Figure 11-18: This table has the potential to grow every month.

To solve this issue, you can use Excel’s table feature (you can tell they spent all night coming up with that 
name). The table feature allows you to convert a range of data into a defined table that’s treated indepen-
dently of other rows and columns on the worksheet. After a range is converted to a table, Excel views the 
individual cells in the table as a single object that has the functionality a normal data range doesn’t have.

For instance, Excel tables offer the following features:

➤ Drop-down lists in the Header row that allow you to filter and sort data in each column easily

➤ A Total row feature with various aggregate functions

➤ Ability to apply distinct formatting to the table independent of the rest of the worksheet

➤ Ability to automatically expand in dimensions to accommodate new data (key for data mod-
eling purposes)

Tip  

The table feature did exist in Excel 2003 under a different name . In Excel 2003, this fea-
ture was the List feature (found in Excel’s Data menu) . The benefit of this fact is that 
Excel tables are fully compatible with Excel 2003!
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Converting a range to an Excel table
To convert a range of data to an Excel table, follow these steps:

 1. Highlight the range of cells that contain the data you want to include in your Excel table.

 2. On the Insert tab of the Ribbon, click the Table button.

  The Create Table dialog box opens, as shown in Figure 11-19.

 3. In the Create Table dialog box, verify the range for the table and specify whether the first row 
of the selected range is a Header row.

 4. Click OK.

Figure 11-19: Converting a range of data to an Excel table.

After the conversion takes place, notice a few small changes. Excel put drop-down lists in each 
Header row, the rows in your table now have alternate shading, and any header that didn’t have a 
value has been named by Excel.

You can use Excel tables as the source for charts, pivot tables, list boxes, or anything else for which 
you normally use a data range. In Figure 11-20, a bar chart has been linked to the Excel table.

Figure 11-20: Excel tables can be used as source data for charts, pivot tables, named ranges, and so on.
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Here’s the impressive bit. When data is added to the table, Excel automatically expands the range of the 
table and incorporates the new range into any linked object. That’s just a fancy way of saying that any 
chart or pivot table tied to an Excel table automatically captures new data without manual intervention.

For example, if I add July and August data to the end of the Excel table, the chart automatically 
updates to capture the new data. In Figure 11-21, I added July with no data and August with data to 
show you that the chart captures any new records and automatically plots the data given.

Figure 11-21: An Excel table automatically expands when new data is added.

Take a moment to think about what Excel tables mean to a data model. Pivot tables never have to be 
reconfigured, charts automatically capture new data, and ranges automatically keep up with changes.

Converting an Excel table back to a range
If you want to convert an Excel table back to a normal range, you can follow these steps:

 1. Place your cursor in any cell inside the Excel table and select the Table Tools Design tab in 
the Ribbon.

 2. Choose the Convert to Range command, as shown in Figure 11-22.

 3. When asked if you’re sure (via a message box), click Yes.

Figure 11-22: To remove Excel table functionality, convert the table back to a range.

Any object you have connected to the range (pivot tables, charts, and so on) will continue to work. 
However, they will no longer dynamically update as you add or remove data from the range.

www.it-ebooks.info

http://www.it-ebooks.info/


Part III: Advanced Dashboarding Concepts246

www.it-ebooks.info

http://www.it-ebooks.info/


247

12
Adding Interactive 
Controls to Your 
Dashboard
In This Chapter

● Introducing Form controls

● Using a button control

● Using a check box control to toggle a chart series

● Using an option button to filter your views

● Using a combo box to control multiple pivot tables

● Using a list box to control multiple charts

Today, business professionals increasingly want to be empowered to switch from one view of data to 
another with a simple list of choices. For those who build dashboards and reports, this empowerment 
comes with a whole new set of issues. The overarching question is — how do you handle a user who 
wants to see multiple views for multiple regions or markets?

Fortunately, Excel offers a handful of tools that enable you to add interactivity into your presentations. 
With these tools and a bit of creative data modeling, you can accomplish these goals with relative ease. 
In this chapter, we discuss how to incorporate various controls (such as buttons, check boxes, and scroll 
bars) into your dashboards and reports, and present you with several solutions that you can implement.

www.it-ebooks.info

http://www.it-ebooks.info/


Part III: Advanced Dashboarding Concepts248

Getting Started with Form Controls
Excel offers a set of controls called Form controls, designed specifically for adding UI elements  
directly onto a worksheet. After you place a Form control on a worksheet, you can then configure it 
to perform a specific task. Later in the chapter, we demonstrate how to apply the most useful con-
trols to a presentation.

Finding Form controls
You can find Excel’s Form controls on the Developer tab, which is initially hidden in Excel 2010. To 
enable the Developer tab, follow these steps:

 1. Go to the Ribbon and select the File tab.

 2. To open the Excel Options dialog box, click the Options button.

 3. Click the Customize Ribbon button.

  In the list box on the right, you’ll see all the available tabs.

 4. Select the check box next to the Developer tab (see Figure 12-1).

 5. Click OK.

Figure 12-1: Enabling the Developer tab.

Now, select the Developer tab and choose the Insert command, as shown in Figure 12-2. Here you 
find two sets of controls: Form controls and ActiveX controls. Form controls are designed specifically 
for use on a spreadsheet, whereas ActiveX Controls are typically used on Excel UserForms. Because 
Form controls need less overhead and can be configured far easier than their ActiveX counterparts, 
you generally want to use Form controls.
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Figure 12-2: Form controls and ActiveX controls.

Here are the nine Form controls that you can add directly to a worksheet (see Figure 12-3). They are 
as follows:

➤ Button: Executes an assigned macro when a user clicks the button.

➤ Combo Box: Gives a user an expandable list of options from which to choose.

➤ Check Box: Provides a mechanism for a select/deselect scenario. When selected, it returns a 
value of True. Otherwise, it returns False.

➤ Spin Button: Enables a user to easily increment or decrement a value by clicking the up and 
down arrows.

➤ List Box: Gives a user a list of options from which to choose.

➤ Option Button: Enables a user to toggle through two or more options one at a time. 
Selecting one option automatically deselects the others.

➤ Scroll Bar: Enables a user to scroll to a value or position using a sliding scale that can be 
moved by clicking and dragging the mouse.

➤ Label: Allows you to add text labels to your worksheet. You can also assign a macro to the 
label, effectively using it as a button of sorts.

➤ Group Box: Typically used for cosmetic purposes, this control serves as a container for 
groups of other controls.

Figure 12-3: Nine Form controls labeled so that you can add to your worksheet.
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Adding a control to a worksheet
To add a control to a worksheet, simply click the control that you require and click the approximate 
location that you want to place the control. You can easily move and resize the control later just as 
you would a chart or shape.

After you add a control, you want to configure it to define its look, behavior, and utility. Each control 
has its own set of configuration options that allows you to customize it for your purposes. To get to 
these options, right-click the control and select Format Control. This opens the Format Control dialog 
box (illustrated in Figure 12-4) with all the configuration options for that control.

Figure 12-4: Right-click and select Format Control to open a dialog box with the configuration options.

Each control has its own set of tabs that allows you to customize everything from formatting, to  
security, to configuration arguments. You’ll see different tabs based on which control you’re using, 
but most Form controls have the Control tab. The Control tab is where the meat of the configuration 
lies. Here, you find the variables and settings that need to be defined in order for the control to  
function.

Note  

The button and label controls don’t have the Control tab . They have no need for  
one . The button simply fires whichever macro you assign it . As for the Label, it’s not 
designed to run macro events .

Throughout the rest of the chapter, you walk through a few exercises that demonstrate how to  
use the most useful controls in a reporting environment. At the end of this chapter, you’ll have  
a solid understanding of Form controls and how they can enhance your dashboards and reports.

www.it-ebooks.info

http://www.it-ebooks.info/


Chapter 12: Adding Interactive Controls to Your Dashboard 251

Using the Button Control
The button control gives your audience a clear and easy way to execute the macros you’ve recorded. 
To insert and configure a button control, follow these steps:

 1. Select Insert drop-down list under the Developer tab.

 2. Select the button Form control.

 3. Click the location in your spreadsheet where you want to place your button.

  The Assign Macro dialog box appears and asks you to assign a macro to this button (see 
Figure 12-5).

 4. Edit the text shown on the button by right-clicking the button, highlighting the existing text, 
and then overwriting it with your own.

Figure 12-5: Assign a macro to the newly added button.

Tip
 

To assign a different macro to the button, simply right-click and select Assign Macro to 
reactivate the Assign Macro dialog box, as shown in Figure 12-5 .

Using the Check Box Control
The check box control provides a mechanism for selecting/deselecting options. When a check box is 
selected, it returns a value of True. When it isn’t selected, False is returned. To add and configure a 
check box control, follow these steps:

 1. Select the Insert drop-down list under the Developer tab.

 2. Select the check box Form control.
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 3. Click the location in your spreadsheet where you want to place your check box.

 4. After you drop the check box control onto your spreadsheet, right-click the control and 
select Format Control.

 5. Click the Control tab to see the configuration options, as shown in Figure 12-6.

 6. Select the state in which the check box should open.

  The default selection (Unchecked) typically works for most scenarios, so you rarely have to 
update this selection.

 7. In the Cell Link box, enter the cell to which you want the check box to output its value.

  By default, a check box control outputs either True or False, depending on whether it’s 
checked. Notice in Figure 12-6 that this particular check box outputs to cell A5.

 8. (Optional) You can check the 3-D property if you want the control to have a 3-D appearance.

 9. Click OK to apply your changes.

Figure 12-6: Formatting the check box control.

Tip  

To rename the check box control, right-click the control, select Edit Text, and then over-
write the existing text with your own .

As Figure 12-7 illustrates, the check box outputs its value to the specified cell. If the check box is 
selected, a value of True is output. If the check box isn’t selected, a value of False is output.

Figure 12-7: The two states of the check box.
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If you’re having a hard time figuring out how this could be useful, take a stab at this next exercise, 
which illustrates how you can use a check box to toggle a chart series on and off.

Check box example: Toggling a chart series on and off
Figure 12-8 shows the same chart twice. Notice that the top chart contains only one series, with a check 
box offering to Show 2011 Trend data. The bottom chart shows the same chart with the check box 
selected. The on/off nature of the check box control is ideal for interactivity that calls for a visible/not 
visible state.

Figure 12-8: A check box can help create the disappearing data series effect.

On the Web 

To download the Chapter 12 Samples.xlsx file, go to the book’s companion web-
site at www.wiley.com/go/exceldr .

You start with the raw data (in Chapter 12 Sample File.xlsx) that contains both 2011 and 2012 data 
(see Figure 12-9). In the first column is a cell where the check box control will output its value (cell 
A12, in this example). This cell will contain either True or False.

Figure 12-9: Start with raw data and a cell where a check box control can output its value.
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Next, you create the analysis layer (staging table) that consists of all formulas, as shown in Figure 
12-10. The idea is that the chart actually reads from this data, not the raw data. This way, you can 
control what the chart sees.

Figure 12-10: Create a staging table that will feed the chart. The values of this data are all formulas.

As you can see in Figure 12-10, the formulas for the 2012 row simply reference the cells in the raw 
data for each respective month. You do that because you want the 2012 data to show at all times.

For the 2011 row, you test the value of cell A12 (the cell that contains the output from the check box). 
If A12 reads True, you reference the respective 2011 cell in the raw data. If A12 doesn’t read True, the 
formula uses Excel’s NA() function to return an #N/A error. Excel charts can’t read a cell with the #N/A 
error. Therefore, they simply don’t show the data series for any cell that contains #N/A. This is ideal 
when you don’t want a data series to be shown at all.

Tip  

Notice that the formula shown in Figure 12-10 uses an absolute reference with cell A12 . 
That is, the reference to cell A12 in the formula is prefixed with a $ sign ($A12) . This 
ensures that the column references in the formulas don’t shift when they’re copied 
across .

Figure 12-11 illustrates the two scenarios in action in the staging tables. In the scenario shown at the 
bottom of Figure 12-11, cell A12 is True, so the staging table actually brings in 2011 data. In the sce-
nario shown at the top of Figure 12-11, cell A12 is False, so the staging table returns #N/A for 2011.

Figure 12-11: When cell A12 reads True, 2011 data is displayed; when it reads False, the 2011 row shows only 
#N/A errors.
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Finally, you create the chart that you saw earlier in this section (refer to Figure 12-8) using the staging 
table. Keep in mind that you can scale this to as many series as you like.

Figure 12-12 illustrates a chart that has multiple series whose visibility is controlled by check box 
controls. This allows you to make all but two series invisible so you can compare those two series 
unhindered. Then you can make another two visible, comparing those.

Figure 12-12: You can use check boxes to control how much data is shown in your chart at one time.

Using the Option Button Control
Option buttons allow users to toggle through several options one at a time. The idea is to have two 
or more option buttons in a group. Then selecting one option button automatically deselects the 
others. To add option buttons to your worksheet, follow these steps:

 1. Click the Insert drop-down list under the Developer tab.

 2. Select the option button Form control.

 3. Click the location in your spreadsheet where you want to place your option button.

 4. After you drop the control onto your spreadsheet, right-click the control and select Format 
Control.

 5. Click the Control tab to see the configuration options, as shown in Figure 12-13.

 6. First, select the state in which the option button should open.

  The default selection (Unchecked) typically works for most scenarios, so you rarely have to 
update this selection.

 7. In the Cell Link box, enter the cell to which you want the option button to output its value. 
By default, an option button control outputs a number that corresponds to the order it was 
put onto the worksheet. For instance, the first option button you place on your worksheet 
outputs a number 1, the second outputs a number 2, the third outputs a number 3, and so 
on. Notice in Figure 12-13 that this particular control outputs to cell A1.

 8. (Optional) You can check the 3-D property if you want the control to have a three- 
dimensional appearance.
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 9. Click OK to apply your changes.

 10. To add another option button, simply copy the button you created and paste as many 
option buttons as you need. The nice thing about copying and pasting is that all the configu-
rations you made to the original persist in all the copies.

Figure 12-13: Formatting the option button control.

Tip  

To give your option button a meaningful label, right-click the control, select Edit Text, 
and then overwrite the existing text with your own .

Option button example: Showing many views  
through one chart
One of the ways you can use option buttons is to feed a single chart with different data, based on the 
option selected. Figure 12-14 illustrates an example of this. When each category is selected, the sin-
gle chart is updated to show the data for that selection.

Figure 12-14: This chart is dynamically fed different data based on the selected option button.
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Now, you could create three separate charts and show them all on your dashboard at the same time. 
However, using this technique as an alternative saves on valuable real estate by not having to show 
three separate charts. Plus, it’s much easier to troubleshoot, format, and maintain one chart than 
three.

To create this example, you start with three raw datasets (as shown in Figure 12-15) that contain 
three categories of data; Income, Expense, and Net. Near the raw data, you reserve a cell where the 
option buttons output their values (Cell A8, in this example). This cell contains the ID of the option 
selected: 1, 2, or 3.

Figure 12-15: Start with the raw datasets and a cell where the option buttons can output their values.

You then create the analysis layer (the staging table) that consists of all formulas, as shown in Figure 
12-16. The idea is that the chart reads from this staging table, allowing you to control what the chart 
sees. The first cell of the staging table contains the following formula:

=IF($A$8=1,B9,IF($A$8=2,B13,B17))

This formula tells Excel to check the value of cell A8 (the cell where the option buttons output their 
values). If the value of cell A8 is 1, which represents the value of the Income option, the formula 
returns the value in the Income dataset (cell B9). If the value of cell A8 is 2, which represents the value 
of the Expense option, the formula returns the value in the Expense dataset (cell B13). If the value of 
cell B1 is not 1 or 2, the value in cell B17 is returned.

Figure 12-16: Create a staging table and enter this formula in the first cell.
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Notice that the formula shown in Figure 12-16 uses absolute references with cell A8 . 
That is, the reference to cell A8 in the formula is prefixed with $ signs ($A$8) . This 
ensures that the cell references in the formulas don’t shift when they’re copied down 
and across .

To test that the formula is working fine, you could change the value of cell A8 manually, from 1 to 3. 
When the formula works, you simply copy the formula across and down to fill the rest of the staging 
table.

When the setup is created, all that’s left to do is create the chart using the staging table. Again, the 
major benefits you get from this type of setup are that any formatting changes can be made to  
one chart and it’s easy to add another dataset by adding another option button and editing your  
formulas.

Using the Combo Box Control
The combo box control allows users to select from a list of predefined options from a drop-down list. 
The idea is that when an item from the combo box control is selected, some action is taken with that 
selection. To add a combo box to your worksheet, follow these steps:

 1. Click the Insert drop-down list under the Developer tab.

 2. Select the combo box Form control.

 3. Click the location in your spreadsheet where you want to place your combo box.

 4. After you drop the control onto your spreadsheet, right-click the control and select Format 
Control.

 5. Click the Control tab to see the configuration options, as shown in Figure 12-17.

 6. In the Input Range setting, identify the range that holds the predefined items you want to 
present as choices in the combo box.

 7. In the Cell Link box, enter the cell to which you want the combo box to output its value. 

  A combo box control outputs the index number of the selected item. This means that if the 
second item on the list is selected, the number 2 will be output. If the fifth item on the list is 
selected, the number 5 will be output. Notice in Figure 12-17 that this particular control out-
puts to cell E15.

 8. In the Drop Down Lines box, enter the number of items you want shown at one time. You 
see in Figure 12-17 that this control is formatted to show 12 items at one time. This means 
when the combo box is expanded, the user sees 12 items.

Tip
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 9. (Optional) You can check the 3-D property if you want the control to have a three-dimen-
sional appearance.

 10. Click OK to apply your changes.

Figure 12-17: Formatting the combo box control.

Combo box example: Changing chart data  
with a drop-down selector
You can use combo box controls to give your users an intuitive way to select data via a drop-down 
selector. Figure 12-18 shows a thermometer chart controlled by the combo box above it. When a 
user selects the Southwest region, the chart responds by plotting the data for the selected region.

Figure 12-18: Use combo boxes to give your users an intuitive drop-down selector.

To create this example, you start with the raw dataset shown in Figure 12-19. This dataset contains the 
data for each region. Near the raw data, you reserve a cell where the combo box will output its value 
(Cell M7, in this example). This cell will catch the index number of the combo box entry selected.
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Figure 12-19: Start with the raw dataset and a cell where the option buttons can output their values.

You then create the analysis layer (the staging table) that consists of all formulas, as shown in Figure 
12-20. The idea is that the chart reads from this staging table, allowing you to control what the chart 
sees. The first cell of the staging table contains the following INDEX formula:

=INDEX(P7:P14,$M$7)

Figure 12-20: Create a staging table that uses the INDEX function to extract the appropriate data from the raw 
dataset.

The INDEX function converts an index number to a value that can be recognized. An INDEX function 
requires two arguments in order to work properly. The first argument is the range of the list you’re 
working with. The second argument is the index number.

In this example, you’re using the index number from the combo box (in cell M7) and extracting the 
value from the appropriate range (2012 data in P7:P14). Again, notice the use of the absolute $ signs. 
This ensures that the cell references in the formulas don’t shift when they’re copied down and across.

Take another look at Figure 12-20 to see what’s happening. The INDEX formula in cell P2 points to 
the range that contains the 2012 data. It then captures the index number in cell M7 (which traps the 
output value of the combo box). The index number happens to be 7. So the formula in cell P2 will 
extract the 7th value from the 2012 data range.

When you copy the formula across, Excel adjusts the formula to extract the seventh value from each 
year’s data range. 
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After your INDEX formulas are in place, you have a clean staging table that you can use to create your 
chart (see Figure 12-21). 

Figure 12-21: A clean staging table to use to create your chart.

Using the List Box Control
The list box control allows users to select from a list of predefined choices. The idea is that when an 
item from the list box control is selected, some action is taken with that selection. To add a list box to 
your worksheet, follow these steps:

 1. Select the Insert drop-down list under the Developer tab.

 2. Select the list box Form control.

 3. Click the location in your spreadsheet where you want to place your list box.

 4. After you drop the control onto your worksheet, right-click the control and select Format 
Control.

 5. Click the Control tab to see the configuration options, as shown in Figure 12-22.

 6. In the Input Range setting, identify the range that holds the predefined items you want to 
present as choices in the combo box.

  As you can see in Figure 12-22, this list box is filled with region selections.

 7. In the Cell Link box, enter the cell where you want the list box to output its value.

  By default, a list box control outputs the index number of the selected item. This means that 
if the second item on the list is selected, the number 2 will be output. If the fifth item on the 
list is selected, the number 5 will be output. Notice in Figure 12-22 that this particular control 
outputs to cell P2. The Selection Type setting allows users to choose more than one selection 
in the list box. The choices here are Single, Multi, and Extend. Always leave this setting on 
Single, as Multi and Extend work only in the VBA environment.
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 8. (Optional) You can check the 3-D property if you want the control to have a 3-D appearance.

 9. Click OK to apply your changes.

Figure 12-22: Formatting the list box control.

List box example: Controlling multiple charts  
with one selector
One of the more useful ways to use a list box is to control multiple charts with one selector. Figure 
12-23 illustrates an example of this. As a region selection is made in the list box, all three charts are 
fed the data for that region, adjusting the charts to correspond with the selection made. Happily, all 
this is done without VBA code, just a handful of formulas and a list box.

Figure 12-23: This list box feeds the region selection to multiple charts, changing each chart to correspond with 
the selection made.

To create this example, you start with three raw datasets (as shown in Figure 12-24) that contain 
three categories of data: Revenues, Net Income %, and Gross Margin. Each dataset contains a sepa-
rate line for each region (including one for All Regions).
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Figure 12-24: Start with the raw datasets that contain one line per region.

You then add a list box that outputs the index number of the selected item to cell P2 (see Figure 12-25).

Figure 12-25: Add a list box and note the cell where the output value will be placed.

Next, you create a staging table that will consist of all formulas. In this staging table, you use the 
Excel’s CHOOSE function to select the correct value from the raw data tables based on the selected 
region.

Tip  

In Excel, the Choose function returns a value from a specified list of values based on a 
specified position number . For instance, the formula CHOOSE(3,”Red”, “Yellow”, 
“Green”, “Blue”) returns Green because Green is the third item in the list of values . The 
formula CHOOSE(1, “Red”, “Yellow”, “Green”, “Blue”) returns Red . See Chapter 11 to get 
a detailed look at the CHOOSE function .

As you can see in Figure 12-26, the CHOOSE formula retrieves the target position number from Cell 
P2 (the cell where the list box outputs the index number of the selected item) and then matches that 
position number to the list of cell references given. The cell references come directly from the raw 
data table.
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In the example shown in Figure 12-26, the data that will be returned with this CHOOSE formula is 
41767. Why? Because cell P2 contains the number 3, and the third cell reference within the CHOOSE 
formula is cell B9.

Figure 12-26: Use the CHOOSE function to capture the correct data corresponding to the selected region.

You entered the same type of CHOOSE formula into the Jan column and then copied it across (see 
Figure 12-27).

Figure 12-27: Create similar CHOOSE formulas for each row/category of data and then copy the choose formu-
las across months.

To test that your formulas are working, change the value of cell P2 manually, entering 1, 2, 3, 4, or 5. 
When the formulas work, all that’s left to do is create the charts using the staging table.

Note  

If Excel functions like CHOOSE or INDEX are a bit intimidating for you, don’t worry . There 
are literally hundreds of ways to use various combinations of form controls and Excel 
functions to achieve interactive reporting . The examples given in this chapter are 
designed to give you a sense of how you can incorporate form controls into your dash-
boards and reports . There are no set rules on which form controls or Excel functions you 
need to use in your model .

Start with basic improvements to your dashboard, using controls and formulas you’re 
comfortable with . Then gradually try to introduce some of the more complex controls 
and functions . With a little imagination and creativity, you can take the basics found in 
this chapter and customize your own dynamic dashboards .
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13
Macro-Charged Reporting
In This Chapter

● Introducing macros

● Recording macros

● Setting up trusted locations for your macros

● Adding macros to your dashboards and reports

A macro is essentially a set of instructions or code that you create to tell Excel to execute any number 
of actions. In Excel, macros can be written or recorded. The key word here is recorded.

Recording a macro is like programming a phone number into your cell phone. You first manually dial 
and save a number. Then when you want, you can redial those numbers with the touch of a button. 
Just as on a cell phone, you can record your actions in Excel while you perform them. While you 
record, Excel gets busy in the background, translating your keystrokes and mouse clicks to written 
code (also known as Visual Basic for Applications, VBA). After a macro is recorded, you can play back 
those actions anytime you want.

In this chapter, you explore macros and discover how to simplify your life by using macros to auto-
mate recurring processes.

Why Use a Macro?
Macros can help you solve some common data-analysis problems.

➤ Problem 1: Repetitive tasks . As each new month rolls around, you have to make the donuts 
(that is, crank out those reports). You have to import that data. You have to update those pivot 
tables. You have to delete those columns, and so on. Wouldn’t it be nice if you could fire up a 
macro and have those more redundant parts of your dashboard processes done automatically?

➤ Problem 2: Human error . When you do hand-to-hand combat with Excel, you’re bound to 
make mistakes. When you’re repeatedly applying formulas, sorting, and moving things 
around manually, there’s always that risk of catastrophe. Add to that the looming deadlines 
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and constant requests for changes, and your error rate goes up. Why not calmly record a 
macro, ensure that everything is running correctly, and then forget it? The macro is sure to 
perform every action the same way every time you run it, reducing the chance for errors.

➤ Problem 3: Awkward navigation . Remember that you’re creating these dashboards and 
reports for an audience that probably has a limited knowledge of Excel. If your reports are a 
bit too difficult to use and navigate, you’ll slowly lose support for your cause. It’s always help-
ful to make your dashboard more user-friendly. Here are some ideas for macros that make 
things easier for everyone:

● A macro to format and print a worksheet or range of worksheets at the touch of a button

● Macros that navigate a multisheet worksheet with a navigation page or with a go to but-
ton for each sheet in your workbook

● A macro that saves the open document in a specified location and then closes the appli-
cation at the touch of a button.

Obviously, you can perform each of the preceding examples in Excel without the aid of a macro. 
However, your audience will appreciate the little touches that help make perusing your dashboard a 
bit more pleasant.

Recording Your First Macro
If you’re starting off with dashboard automation, it’s unlikely that you will be able to write the VBA 
code by hand. Without full knowledge of Excel’s object model and syntax, writing the code needed 
would be impossible for most beginning users. This is where recording a macro comes in handy. You 
record the desired action and then run the macro each time you want that action to be performed.

On the Web 

To start creating your first macro, open the Chapter 13 Samples .xlsm file found in  
the sample files for this book . When the file is open, go to the Recording Your First 
Macro tab .

To begin, you first need to unhide the Developer tab. The full macro toolset in Excel 2013 is found on 
the Developer tab, which is initially hidden. You have to explicitly tell Excel to make it visible. To 
enable the Developer tab, follow these steps:

 1. Go to the Ribbon and select the File tab.

 2. To open the Excel Options dialog box, click the Options button.

 3. Click the Customize Ribbon button.

  In the list on the right, you see all the available tabs.

 4. Select the Developer tab (see Figure 13-1).

 5. Click OK.
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Figure 13-1: Enabling the Developer tab.

When you see the Developer tab on the Ribbon, you can select it and click the Record Macro com-
mand. This opens the Record Macro dialog box, as shown in Figure 13-2.

Figure 13-2: The Record Macro dialog box.

Here are the four fields in the Record Macro dialog box:

➤ Macro Name: Excel gives a default name to your macro, such as Macro1, but it’s best practice 
to give your macro a name more descriptive of what it actually does. For example, you might 
name a macro that formats a generic table as AddDataBars.

➤ Shortcut Key: (Optional) Every macro needs an event, or something to happen, in order for it 
to run. This event can be a button press; a workbook opening; or, in this case, a keystroke 
combination. When you assign a shortcut key to your macro, entering that combination of 
keys triggers the macro to run. You don’t need to enter a shortcut key to run the macro.

➤ Store Macro In: This Workbook is the default option. Storing your macro in This Workbook 
simply means that the macro is stored along with the active Excel file. The next time you 
open that particular workbook, the macro will be available. Similarly, if you send the work-
book to another user, that user can run the macro as well (provided the macro security is 
properly set by your user — but more on that later).

➤ Description: (Optional) Useful if you have numerous macros in a spreadsheet or if you need 
to give a user a detailed description about what the macro does.
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Follow these steps to start recording an action:

 1. Enter the name in the Macro Name field.

  For this example, type AddDataBars.

 2. Select This Workbook in the Store Macro In option (see Figure 13-3).

 3. Click OK.

Figure 13-3: Start recording a new Macro called AddDataBars.

Excel is now recording your actions.

While Excel is recording, you can perform any actions you want. The following example records a 
macro to add data bars to a column of numbers.

 1. Highlight cells C1:C21.

 2. Go to the Home tab and select Conditional Formatting➜New Rule.

  The New Formatting Rule dialog box opens.

 3. In the New Formatting Rule dialog box, go to the Format Style drop-down menu and select 
Data Bar.

  The New Formatting Rule dialog box now shows a new set of options related to Data Bars. 

 4. Place a check in the Show Bar Only check box.

 5. Click OK to apply your change.

 6. Go to the Develop tab and click the Stop Recording command.

At this point, Excel stops recording. You now have a macro that replaces the data in C1:C21 with  
data bars.

Now, record a new macro to remove the data bars:

 1. Go to the Developer tab and click the Record Macro command.

 2. Enter RemoveDataBars in the Macro Name field and select This Workbook in the Store 
Macro In option (see Figure 13-4). Click OK.
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Figure 13-4: Start recording a new macro called RemoveDataBars.

 3. Highlight cells C1:C21.

 4. Go to the Home tab and select Conditional Formatting➜Clear Rules➜Clear Rules from 
Selected Cells.

 5. Go to the Developer tab and click the Stop Recording command.

  Excel stops recording.

You now have a new macro that removes conditional formatting rules from cells C1:C21.

Running your macros
To see your macros in action, follow these steps:

 1. Select the Macros command from the Developer tab.

  The dialog box in Figure 13-5 activates, allowing you to select the macro you want to run.

 2. Select the AddDataBars macro.

 3. Click the Run button.

Figure 13-5: Use the Macro dialog box to select a macro and run it.
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If all goes well, the AddDataBars macro plays back your actions to a T and applies the data bars as 
designed (see Figure 13-6).

Figure 13-6: Your macro applied data bars automatically!

You can now call up the Macro dialog box again and test the RemoveDataBars macro shown in 
Figure 13-7.

Figure 13-7: The RemoveDataBars macro will remove the applied data bars.

Assigning a macro to a button
When you create macros, you want to give your audience a clear and easy way to run each macro. A 
button, used directly in the dashboard or report, can provide a simple but effective UI.

Excel Form controls (refer to Chapter 12 for more information) enable you to create UI directly on 
your worksheets, simplifying work for your users. Form controls range from buttons (the most- 
commonly used control) to scroll bars and check boxes.

For a macro, you can place a Form control in a worksheet and then assign that macro to it — that is, a 
macro you’ve already recorded. When a macro is assigned to the control, that macro is executed, or 
played, each time the control is clicked.
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Take a moment to create buttons for the two macros (AddDataBars and RemoveDataBars) you cre-
ated earlier. Here’s how:

 1. Click the Insert drop-down list under the Developer tab.

 2. Select the Button Form control (see Figure 13-8).

 3. Click the location you want to place your button. When you drop the button control into 
your worksheet, the Assign Macro dialog box, shown in Figure 13-9, opens and asks you to 
assign a macro to this button.

 4. Select the macro that you want to assign. In this case, you can select the AddDataBars macro 
and then click OK.

 5. Repeat Steps 1 through 4 for the RemoveDataBars macro.

Figure 13-8: You can find the Form Controls in the Developer tab.

Figure 13-9: Assign a macro to the newly added button.

At this point, you have two buttons that run your macros. Keep in mind that all the controls in the 
Forms toolbar work the same way as the Command button — you assign a macro to run when the 
control is selected.

Tip  

The buttons you create come with a default name, such as Button3 . To rename your but-
ton, right-click the button and then select Edit Text .
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Enabling Macros in Excel 2013
With the release of Office 2013, Microsoft introduced significant changes to its Office security model. 
One of the most significant changes is the concept of Trusted Documents. Without getting into the 
technical minutia, a Trusted Document is essentially a workbook you have deemed safe by enabling 
macros.

Viewing the new Excel security message
If you open a workbook that contains macros in Excel 2013, you’ll get a message in the form of a yel-
low bar under the Ribbon stating that Macros (active content) has, in effect, been disabled.

If you click Enable, the workbook automatically becomes a Trusted Document. This means you will no 
longer be prompted to enable the content as long as you open that file on your computer. The idea 
is that if you told Excel that you trust a particular workbook by enabling macros, it’s highly likely that 
you’ll enable macros each time you open it. Thus Excel remembers that you’ve enabled macros 
before and inhibits any further messages about macros (for that workbook).

This is great news for you and your clients. After enabling your macros just one time, they won’t be 
annoyed by the constant messages about macros, and you won’t have to worry that your macro-
enabled dashboard will fall flat because macros have been disabled.

Setting up trusted locations
If the thought of any macro message coming up (even one time) unnerves you, you can set up a 
trusted location for your files. A trusted location is a directory that is deemed a safe zone where only 
trusted workbooks are placed. A trusted location allows you and your clients to run a macro-enabled 
workbook with no security restrictions as long as the workbook is in that location.

Form controls versus ActiveX controls
Although the Form controls and ActiveX controls look similar, they’re quite different:

● Form controls are designed specifically for use on a worksheet
● ActiveX controls are typically used on Excel UserForms.

As a general rule, you want to use Form controls when working on a worksheet. Why? Form controls 
need less overhead, so they perform better, and configuring Form controls is far easier than config-
uring their ActiveX counterparts.
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To set up a trusted location, follow these steps:

 1. Select the Macro Security button on the Developer tab.

 2. Click the Trusted Locations button.

  This opens the Trusted Locations menu (see Figure 13-10). You see all the directories that 
Excel considers trusted.

 3. Click the Add New Location button.

 4. Click Browse to find and specify the directory that will be considered a trusted location.

Figure 13-10: The Trusted Locations menu allows you to add directories that are considered trusted.

Macro-enabled file extensions
Microsoft has created a separate file extension for workbooks that contain macros.

Excel 2007, 2010, and 2013 workbooks have the standard file extension .xlsx. Files with the 
.xlsx extension cannot contain macros. If your workbook contains macros and you then save that 
workbook as an .xlsx file, your macros are removed automatically. Of course, Excel warns you that 
macro content will be disabled when saving a workbook with macros as an .xlsx file.

If you want to retain the macros, you must save your file as an Excel Macro-Enabled Workbook. This 
gives your file an .xlsm extension. The idea is that all workbooks with an .xlsx file extension are 
automatically known to be safe, whereas you can recognize .xlsm files as a potential threat.
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After you specify a trusted location, all Excel files opened from this location will have macros automati-
cally enabled. The idea is to have your clients specify a trusted location and use your Excel files from 
there.

Excel Macro Examples
Covering the fundamentals of building and using macros is one thing. Coming up with good ways to 
incorporate them into your reporting processes is another. Take a moment to review a few examples 
of how you can implement macros in your dashboards and reports.

On the Web 

Open the Chapter 13 Samples.xlsm file to follow along in the next section .

Building navigation buttons
The most common use of macros is navigation. Workbooks that have many worksheets or tabs can 
be frustrating to navigate. To help your audience, you can create some sort of switchboard, such as 
the one shown in Figure 13-11. When a user clicks the Example 1 button, he’s taken to the Example 1 
sheet.

Figure 13-11: Use macros to build buttons that help users navigate your reports.

Creating a macro to navigate to a sheet is quite simple.

 1. Start at the sheet that will become your switchboard or starting point.

 2. Start recording a macro.

 3. While recording, click the destination sheet (the sheet this macro will navigate to).

 4. After you click in the destination sheet, stop recording the macro.

 5. Assign the macro to a button.
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Excel has a built-in hyperlink feature, allowing you to convert the contents of a cell into 
a hyperlink that links to another location . That location can be a separate Excel work-
book, a website, or even another tab in the current workbook . Although using a hyper-
link may be easier than setting up a macro, you can’t apply a hyperlink to Form controls 
(like buttons) . Instead of a button, you use text to let users know where they’ll go when 
they click the link . 

Dynamically rearranging pivot table data
In the example illustrated in Figure 13-12, macros allow a user to change the perspective of the chart 
simply by selecting any one of the buttons shown.

Cross-Ref 

For more information about pivot tables, see Chapter 14 . For more information about 
pivot charts, see to Chapter 15 .

Figure 13-12: This report allows users to choose their perspective.

Figure 13-13 reveals that the chart is actually a pivot chart tied to a pivot table. The recorded macros 
assigned to each button are doing nothing more than rearranging the pivot table to slice the data 
using various pivot fields.

Figure 13-13: The macros behind these buttons rearrange the data fields in a pivot table.

Tip
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Here are the high-level steps needed to create this type of setup:

 1. Create your pivot table and a pivot chart.

 2. Start recording a macro.

 3. While recording, move a pivot field from one area of the pivot table to the other. When 
you’re done, stop recording the macro.

 4. Record another macro to move the data field back to its original position.

 5. After both macros are set up, assign each one to a separate button.

You can fire your new macros in turn to see your pivot field dynamically move back and forth.

Offering one-touch reporting options
The last two examples demonstrate that you can record any action that you find of value. That is, if 
you think users would appreciate a certain feature being automated for them, why not record a 
macro to do so?

In Figure 13-14, notice that you can filter the pivot table for the top or bottom 20 customers. Because 
the steps to filter a pivot table for the top and bottom 20 have been recorded, anyone can get the 
benefit of this functionality without knowing how to do it themselves. Also, recording specific 
actions allows you to manage risk a bit. That is, you’ll know that your users will interact with your 
reports in a method that has been developed and tested by you.

This not only saves them time and effort but it also allows users who don’t know how to take these 
actions to benefit from them.

Figure 13-14: Offering prerecorded views saves time and effort and allows users who don’t know how to use 
advanced features to benefit from them.

Tip  

Feel free to visit Chapter 14 for a refresher on how to create the top and bottom reports 
you see in Figure 13-14 .
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Figure 13-15 demonstrates how you can give your audience a quick-and-easy way to see the same 
data on different charts. Don’t laugh too quickly at the uselessness of this example. It’s not uncom-
mon to be asked to see the same data in different ways. Instead of taking up real estate, just record a 
macro that changes the Chart Type of the chart. Your clients will be able to switch views to their 
hearts’ content.

Figure 13-15: You can give your audience a choice in how they view data.
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14
Using Pivot Tables
In This Chapter

● Using pivot tables as your data model

● Creating and modifying a pivot table

● Customizing pivot table fields, formats, and functions

● Filtering data using Pivot Table views

In Chapter 11, we discuss using a data model as the foundation for your dashboards and reports.  
This data model helps you to organize your information into three logical layers: data, analysis, and 
presentation. As you discover in this chapter, pivot tables lend themselves nicely to this data model  
concept. With pivot tables, you can build data models that are easy to set up and that can then be 
updated with a simple press of a button. So you can spend less time maintaining your dashboards 
and reports and more time doing other things. No utility in Excel enables you to achieve a more  
efficient data model than a pivot table.

Introducing the Pivot Table
A pivot table is a tool that allows you to create an interactive view of your source data (commonly referred 
to as a pivot table report). A pivot table can help transform endless rows and columns of numbers into a 
meaningful presentation of data. You can easily create groupings of summary items — for example, com-
bine Northern Region totals with Western Region totals, filter that data using a variety of views, and insert 
special formulas that perform new calculations.

Pivot tables get their namesake from your ability to interactively drag and drop fields within the  
pivot table to dynamically change (or pivot) the perspective, giving you an entirely new view using 
the same source data. You can then display subtotals and interactively drill down to any level of 
detail that you want. Note that the data itself doesn’t change and is not connected to the pivot table. 
The reason a pivot table is so well suited to a dashboard is that you can quickly update the view of 
your pivot table by changing the source data that it points to. This allows you to set up both your 
analysis and presentation layers at one time. You can then simply press a button to update your  
presentation.
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Anatomy of a pivot table
A pivot table is composed of four areas: Values, Row Labels, Column Labels, and Filters. The data you 
place in these areas defines both the use and presentation of the data in your pivot table. We now 
discuss the function of each of these four areas.

Values area
The Values area allows you to calculate and count the source data. In Figure 14-1, it is the large rect-
angular area below and to the right of the column and row headings. In this example, the Values area 
contains a sum of the values in the Sales Amount field.

The data fields that you drag and drop here are typically those that you want to measure — fields, 
such as the sum of revenue, a count of the units, or an average of the prices.

Figure 14-1: The Values area of a pivot table calculates and counts the data.

Row Labels area
The Row Labels area is shown in Figure 14-2. Dragging a data field into the Row Labels area displays 
the unique values from that field down the rows of the left side of the pivot table. The Row Labels 
area typically has at least one field, although it’s possible to have no fields.

The types of data fields that you drop here include those that you want to group and categorize, 
such as products, names, and locations.

Column Labels area
The Column Labels area contains headings that stretch across the top of columns in the pivot table, 
as you can see in Figure 14-3. In this example, the Column Labels area contains the list of unique 
business segments.
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Figure 14-2: The Row Labels area of a pivot table gives you a row-oriented perspective.

Figure 14-3: The Column Labels area of a pivot table gives you a column-oriented perspective.

Placing a data field into the Column Labels area displays the unique values from that field in a  
column-oriented perspective. The Column Labels area is ideal for creating a data matrix or showing 
trends over time.

Filter area
At the top of the pivot table, the Filter area is an optional set of one or more drop-down controls. In 
Figure 14-4, the Filter area contains the Region field, and the pivot table is set to show all regions.

Placing data fields into the Filter area allows you to change the views for the entire pivot table based 
on your selection. The types of data fields that you drop here include those that you want to isolate 
and focus on — for example, region, line of business, and employees.
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Figure 14-4: The Filter area allows you to easily apply filters to your pivot table, focusing on specific data items.

Creating the basic pivot table
Now that you have a good understanding of the structure of a pivot table, follow these steps to cre-
ate your first pivot table.

On the Web
 

You can find the example file for this chapter on this book’s companion website at www.
wiley.com/go/exceldr in the workbook named Chapter 14 Samples .xlsx . 

 1. In the Chapter 14 sample file, go to the tab called Sample Data and click any single cell inside 
the source data (the table you’ll use to feed the pivot table).

 2. Click the Insert tab on the Ribbon.

  Find the PivotTable icon, as shown in Figure 14-5.

 3. From the drop-down list under the PivotTable icon, select PivotTable.

Figure 14-5: Start a pivot table by clicking the PivotTable icon found on the Insert tab.
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  This opens the Create PivotTable dialog box, as shown in Figure 14-6.

 4. Specify the location of your source data.

 5. Specify the worksheet where you want to put the pivot table.

  In Figure 14-6, note that the default location for a new pivot table is New Worksheet. This 
means your pivot table will be placed in a new worksheet within the current workbook. To 
change this, select the Existing Worksheet option and specify the worksheet in which you 
want to place the pivot table.

Figure 14-6: The Create PivotTable dialog box.

 6. Click OK.

  At this point, you have an empty pivot table report on a new worksheet.

Laying out the pivot table
Next to the empty pivot table, you see the PivotTable Fields List dialog box, as shown in Figure 14-7.

You can add the fields you need into the pivot table by dragging and dropping the field names to 
one of the four areas found in the PivotTable Fields List — Filters, Columns, Rows, and Values.

Note  

If clicking the pivot table doesn’t activate the PivotTable Fields List dialog box, you can 
manually activate it by right-clicking anywhere inside the pivot table and selecting 
Show Field List . Alternatively, you can go to the Ribbon, click Option, and then select 
Field List in the Show group .

Now before you start dropping fields into the various areas, ask yourself two questions: “What am I 
measuring?” and “How do I want to see it?” The answers to these questions will help guide you in 
determining which fields go where.

For your first pivot table example, you want to measure the dollar sales by market. This tells you that 
you need to work with the Sales Amount field and the Market field.
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Figure 14-7: The PivotTable Fields List dialog box.

How do you want to view that? You want markets to go down the left side of the report and the sales 
amount to be calculated next to each market. You need to add the Market field to the Row Labels 
area and the Sales Amount field to the Values area.

 1. In the fields list, select the Market field (see Figure 14-8).

  Now that you have regions in your pivot table, it’s time to add the dollar sales.

Figure 14-8: Select the Market field to add it to the fields selector list.
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 2. In the fields selector area, select the Sales Amount field (see Figure 14-9).

Figure 14-9: Add the Sales Amount field.

Note  

Placing a check next to any field that is non-numeric (text or date) automatically places 
that field into the Row Labels area of the pivot table . Placing a check next to any field 
that is numeric automatically places that field in the Values area of the pivot table .

One more thing: When you add new fields, you may find it difficult to see all the fields in the box for 
each area. You can expand the PivotTable Fields List dialog box by clicking and dragging the borders 
of the dialog box to avoid that problem.

As you can see, you have just analyzed the sales for each market in just nine steps! That’s an amazing 
feat, considering you start with over 60,000 rows of data. With a little formatting, this modest pivot 
table can become the starting point for a dashboard or report.

Modifying the pivot table
Now here’s the wonderful thing about pivot tables. For your data model, you can add as many analysis 
layers as possible by changing or rearranging the fields in your source data table. Say that you want to 
show the dollar sales each market earned by business segment. Because your pivot table already con-
tains the Market and Sales Amount fields, all you have to add is the Business Segment field.

So simply click anywhere on your pivot table to reactivate the PivotTable Fields List dialog box and 
then select the Business Segment field. Figure 14-10 illustrates what your pivot table now looks like.

Note  

If clicking the pivot table doesn’t activate the PivotTable Fields List dialog box, you can 
manually activate it by right-clicking anywhere inside the pivot table and selecting 
Show Field List .
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Figure 14-10: Adding a new analysis layer to your data model is as easy as selecting another field.

What if this layout doesn’t work for you? Maybe you want to see business segments listed at the top 
of the pivot table results. No problem. Simply drag the Business Segment field from the Row Labels 
area to the Column Labels area. As you can see in Figure 14-11, this instantly restructures the pivot 
table to your specifications.

Figure 14-11: Your business segments are now column-oriented.

Changing the pivot table view
Often you’re asked to produce reports for one particular region, market, product, and so on. Instead 
of working hours and hours building separate pivot tables for every possible scenario, you can lever-
age pivot tables to help create multiple views of the same data. For example, you can do so by creat-
ing a region filter in your pivot table.
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Click anywhere on your pivot table to reactivate the PivotTable Fields List dialog box and then drag 
the Region field to the Filter area. This adds a drop-down control to your pivot table, as shown in 
Figure 14-12. You can then use this control to view one particular region at a time.

Figure 14-12: Add the Region field to view data for a specific geographic area.

Updating your pivot table
As time goes by, your data may change and grow with newly added rows and columns. You use the 
Refresh command to update your pivot table with these changes. To do so, simply right-click inside 
the pivot table and select Refresh, as demonstrated in Figure 14-13.

Figure 14-13: Use the Refresh command to update the data in your pivot table.

Sometimes, the source data that feeds your pivot table changes in structure. For example, you may 
want to add or delete rows or columns from your data table. These types of changes then affect the 
range of your data source, not just a few data items in the table.

In this case, a simple update of your pivot table data won’t do. You have to update the range that is 
captured by the pivot table. Here’s how:

 1. Click anywhere inside your pivot table to activate the PivotTable Tools context tab in the Ribbon.

 2. Click the Analyze tab.

www.it-ebooks.info

http://www.it-ebooks.info/


Part IV: Pivot Table Driven Dashboards290

 3. Click the Change Data Source button, as demonstrated in Figure 14-14.

 4. Change the range selection to include any new rows or columns (see Figure 14-15).

 5. Click OK.

Figure 14-14: Changing the data range that feeds your pivot table.

Figure 14-15: Select the new range that feeds your pivot table.

Pivot tables and worksheet bloat
It’s important to understand that pivot tables do come with space and memory implications for your 
dashboards and reports. When you create a pivot table, Excel takes a snapshot of your source data 
and stores it in a pivot cache. A pivot cache is essentially a memory container that holds this snap-
shot of your data. Each pivot table that you create from a separate data source creates its own pivot 
cache, which increases your workbook’s memory usage and file size. The increase in memory usage 
and file size depends on the size of the original data source that Excel duplicates to create the pivot 
cache.

Simple enough, right? Well, here’s the rub: You often need to create separate pivot tables from the 
same data source in order to create two distinct analysis layers in your data model. If you create two 
pivot tables from the data source, Excel automatically creates a new pivot cache even though one 
may already exist for the same data source. This means that you’re bloating your worksheet with 
redundant data each time you create a new pivot table using the same data source.

To work around this potential problem, you can use the copy and paste commands. That’s right; 
simply copying a pivot table and pasting it somewhere else creates another pivot table, without 
duplicating the pivot cache. This enables you to create multiple pivot tables that use the same 
source data, with negligible increase in memory and file size.

www.it-ebooks.info

http://www.it-ebooks.info/


Chapter 14: Using Pivot Tables 291

Customizing Your Pivot Table
The pivot tables you create often need to be tweaked in order to get the look and feel that you’re 
looking for. In this section, we cover some of the ways that you can customize your pivot tables to 
suit your dashboard’s needs.

Changing the pivot table layout
Excel 2013 gives you a choice in the layout of your data in a pivot table. The three layouts, shown 
side by side in Figure 14-16, are the Compact Form, Outline Form, and Tabular Form. Although no 
layout stands out as being better than the others, most people prefer using the Tabular Form layout 
because it seems easiest to read, and it’s the layout that most people who have seen pivot tables in 
the past are used to.

Figure 14-16: The three layouts for a pivot table report.

The layout you choose not only affects the look and feel of your reporting mechanisms but also  
it may affect the way you build and interact with any dashboard models based on your pivot  
tables.

Changing the layout of a pivot table is easy. Follow these steps:

 1. Click anywhere inside your pivot table to activate the PivotTable Tools context tab in the 
Ribbon.

 2. Select the Design tab on the Ribbon.

 3. Click the Report Layout icon and choose the layout you like (see Figure 14-17).
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Figure 14-17: Changing the layout for your pivot table.

Renaming the fields
Notice that every field in your pivot table has a name. The fields in the row, column, and filter areas 
inherit their names from the data labels in your source data. For example, the fields in the Values area 
are given a name, such as Sum of Sales Amount.

Now, you might prefer the name Total Sales instead of the unattractive default name, like Sum of 
Sales Amount. In this situation, the ability to change your field name is handy. To change a field 
name, perform the following steps:

 1. Right-click any value within the target field.

  For example, if you want to change the name of the field Sum of Sales Amount, you right-
click any value under that field.

 2. Select Value Field Settings (see Figure 14-18).

  This opens the Value Field Settings dialog box.

 3. Type the new name in the Custom Name box (see Figure 14-19).

 4. Click OK.

Figure 14-18: Right-click any value in the target field to select the Value Field Settings option.
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Figure 14-19: Use the Custom Name box to change the name.

Note  

If you use the same name of the data label that you specified in your source data, you 
receive an error . In this example, if you try to rename the Sum of Sales Amount field as 
Sales Amount, you do get an error message . To get around this, you can add a space to 
the end of any field name . Excel considers Sales Amount (followed by a space) to be dif-
ferent from Sales Amount . This way, you can use the name that you want, and no one 
will notice any difference .

Formatting numbers
You can format numbers in a pivot table to fit your needs (such as currency, percent, or number). For 
example, you can control the numeric formatting of a field using the Value Field Settings dialog box. 
Here’s how:

 1. Right-click any value within the target field.

  For example, if you want to change the format of the values in the Sales Amount field, right-
click any value under that field.

 2. To display the Select Value Field Settings dialog box, select Value Field Settings.

 3. To display the Format Cells dialog box, click Number Format.

 4. Indicate the number format you desire, just as you normally would on your worksheet.

 5. Click OK.

After you set a new format for a field, the applied formatting will persist even if you refresh or rear-
range your pivot table.
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Changing summary calculations
When you create your pivot table, Excel, by default, summarizes your data by either counting or sum-
ming the items. Instead of Sum or Count, you may want to choose other functions, such as Average, 
Min, Max, and so on. In all, 11 options are available, including:

➤ Sum: Adds all numeric data.

➤ Count: Counts all data items within a given field, including numeric-, text-, and date-formatted 
cells.

➤ Average: Calculates an average for the target data items.

➤ Max: Displays the largest value in the target data items.

➤ Min: Displays the smallest value in the target data items.

➤ Product: Multiplies all target data items together.

➤ Count Nums: Counts only the numeric cells in the target data items.

➤ StdDevP and StdDev: Calculates the standard deviation for the target data items. Use 
StdDevP if your data source contains the complete population. Use StdDev if your data 
source contains a sample of the population.

➤ VarP and Var: Calculates the statistical variance for the target data items. Use VarP if your 
data contains a complete population. If your data contains only a sampling of the complete 
population, use Var to estimate the variance.

To change the summary calculation for any given field, perform the following steps:

 1. Right-click any value within the target field.

 2. To display the Value Field Settings dialog box, select Value Field Settings.

 3. Select the type of calculation you want to use from the list of calculations (see Figure 14-20).

 4. Click OK.

Figure 14-20: Change the type of calculation used for a field.
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Did you know that a single blank cell causes Excel to count instead of sum? That’s right . 
If all the cells in a column contain numeric data, Excel chooses Sum . If just one cell is 
either blank or contains text, Excel chooses Count . Be sure to pay attention to the fields 
that you place into the Values area of the pivot table . If the field name starts with Count 
Of, Excel’s counting the items in the field instead of summing the values .

Suppressing subtotals
Notice that each time you add a field to your pivot table, Excel adds a subtotal for that field. There 
may be, however, times when the inclusion of subtotals either doesn’t make sense or just hinders a 
clear view of your pivot table report. For example, Figure 14-21 shows a pivot table where the subto-
tals inundate the report with totals that serve only to hide the real data you’re trying to report.

Figure 14-21: Subtotals sometimes muddle the data you’re trying to show.

Removing all subtotals at one time
You can remove all subtotals at once by performing these steps:

 1. To activate the PivotTable Tools context tab on the Ribbon, click anywhere inside your pivot 
table.

 2. Click the Design tab.

 3. Select the Subtotals icon and select Do Not Show Subtotals (see Figure 14-22).

Note
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Figure 14-22: Use the Do Not Show Subtotals option to remove all subtotals at once.

As you can see in Figure 14-23, the same report without subtotals is much more pleasant to review.

Figure 14-23: The same report without subtotals.

Removing the subtotals for only one field
Maybe you want to remove the subtotals for only one field? In such a case, you can perform the fol-
lowing steps:

 1. Right-click any value within the target field.

 2. To display the Field Settings dialog box, select Field Settings.

 3. Select None under the Subtotals options (see Figure 14-24).

 4. Click OK.
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Figure 14-24: Select the None option to remove subtotals for one field.

Removing grand totals
You may want to remove the Grand Totals field from your pivot table.

 1. Right-click anywhere on your pivot table.

 2. To display the Options dialog box, select PivotTable Options.

 3. Click the Totals & Filters tab.

 4. Deselect Show Grand Totals for Rows.

 5. Deselect Show Grand Totals for Columns.

 6. Click the OK button to confirm your change.

Hiding and showing data items
A pivot table summarizes and displays all the information in your source data. There may, however, 
be situations when you want to inhibit certain data items from being included in your pivot table 
summary. In these situations, you can choose to hide a data item.

In terms of pivot tables, hiding doesn’t just mean preventing the data item from displaying on the 
dashboard; hiding a data item also prevents it from being factored into the summary calculations.

The pivot table in Figure 14-25 shows sales amounts for all Business Segments by Market. In this 
example, however, you want to show totals without taking sales from the Bikes segment into consid-
eration. In other words, you want to hide the Bikes segment.
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Figure 14-25: You want to remove Bikes from this analysis.

To hide the Bikes Business Segment, in the Business Segment drop-down list, deselect Bikes (see 
Figure 14-26).

Figure 14-26: Removing the check from the Bike items hides the Bikes segment.

After clicking OK, the pivot table instantly recalculates, leaving out the Bikes segment. As you can see 
in Figure 14-27, the Market total sales now reflect the sales without Bikes.

Also note in Figure 14-27 that the filter icon next to Business Segment gives you a visual indicator 
that a filter is being applied.

Figure 14-27: Segment analysis without the Bikes segment.
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You can just as quickly reinstate all hidden data items for the field. Simply click the Business Segment 
drop-down list and choose Select All (see Figure 14-28).

Figure 14-28: Placing a check next to Select All forces all data items in that field to become unhidden.

Hiding or showing items without data
By default, your pivot table shows only data items that have data. This may cause unintended prob-
lems for your data.

Look at Figure 14-29, which shows a pivot table with the SalesPeriod field in the Row Labels area and 
the Region field in the Filter area. Note that the Region field is set to (All), and every sales period 
appears in the report.

Figure 14-29: All sales periods are showing.

If you display only Europe in the filter area, only a portion of all the sales periods now show (see 
Figure 14-30).
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Figure 14-30: Filtering for the Europe region causes some of the sales periods to not display.

But displaying only those items with data could cause trouble if we plan on using this pivot table as 
the source for your charts or other dashboard components. With that in mind, it isn’t ideal if half the 
year disappears each time a customer selects Europe.

Here’s how you can prevent Excel from hiding pivot items without data:

 1. Right-click any value within the target field.

  In this example, the target field is the SalesPeriod field.

 2. To display the Field Settings dialog box, select Field Settings.

 3. Click the Layout & Print tab in the Field Settings dialog box.

 4. Select Show Items with No Data (see Figure 14-31).

 5. Click OK.

Figure 14-31: Select the Show Items with No Data option to display all data items.

As you can see in Figure 14-32, after you select the Show Items with No Data option, all the sales peri-
ods appear whether the selected region had sales that period or not.
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Figure 14-32: All sales periods display even if there is no data.

Now that you’re confident that the structure of the pivot table is locked, you can use it as the source 
for all charts and other components in your dashboard.

Tip  

When you show items with no data, you will see plenty of empty cells . Excel gives you 
the option of replacing empty cells with a value of your own (such as 0 or n/a) . This will 
give your customers a clear indication that there is truly no data for the items that show 
empty . To replace empty cells with your own value, right-click your pivot table and 
select PivotTable Options . In the PivotTable Options dialog box, you see a For Empty 
Cells Show setting . Simply enter the value you want to show instead of empty cells .

Sorting your pivot table
By default, items in each pivot field are sorted in ascending sequence based on the item name. Excel 
gives you the freedom to change the sort order of the items in your pivot table.

Like many actions that you can perform in Excel, lots of different ways exist to sort data within a pivot 
table. The easiest way, and the way that we use the most, is to apply the sort directly in the pivot 
table. Here’s how:

 1. Right-click any value within the target field (the field you need to sort).

  In the example shown in Figure 14-33, you want to sort by Sales Amount.

 2. Select Sort and then select the sort direction.

Figure 14-33: Applying a sort to a pivot table field.

The changes take effect immediately and persist while you work with your pivot table.
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Examples of Filtering Your Data
At this point in your exploration of pivot tables, you know enough to start creating your own pivot 
table and specifying unique views. In this section, we share a few ways we like to view the data. 
Although you could specify these views by hand, using the pivot table feature saves you hours of 
work and allows you to more easily update and maintain your information.

Producing top and bottom views
You’ll often find that people are interested in the top and bottom measurement of things — for 
example, the top 50 customers, the bottom 5 sales reps, the top 10 products. Although you may 
think this is because they have the attention span of a four-year-old, there’s a more logical reason for 
focusing on the outliers.

Effective dashboards and reports are often about showing actionable data. If you, as a manager, 
know which accounts are the bottom ten revenue-generating accounts, you could apply your effort 
and resources in building up those accounts. Because you most likely wouldn’t have the resources to 
focus on all accounts, viewing a manageable subset of accounts would be more useful.

Luckily, pivot tables make it easy to filter your data for the top five, the bottom ten, or any conceiv-
able combination of top or bottom records. Here’s an example.

Imagine that in your company, the Accessories Business Segment is a high-margin business — you 
make the most profit for each dollar of sales in the Accessories segment. To increase sales, your man-
ager wants to focus on the 50 customers who spend the least amount of money on Accessories. He 
obviously wants to spend his time and resources on getting those customers to buy more accesso-
ries. Here’s what to do:

 1. Build a pivot table with Business Segment in the Filter area, Customer in the Row Labels area, 
and Sales Amount in the Values area (see Figure 14-34). For cosmetic value, change the lay-
out to Tabular Form.

Figure 14-34: Build this pivot table to start.
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 2. Right-click any customer name in the Customer field, select Filter, and then select Top 10 
(see Figure 14-35).

Figure 14-35: Select the Top 10 filter option.

 3. In the Top 10 Filter dialog box (see Figure 14-36), define the view you’re looking for.

  In this example, you want the Bottom 50 Items (Customers), as defined by the Sum of Sales 
Amount field.

Figure 14-36: Specify the filter you want to apply.

 4. Click OK.

 5. In the Filter area, click the drop-down list for the Business Segment field and select 
Accessories (see Figure 14-37).

Figure 14-37: Filter your pivot table report to show Accessories.

At this point, you have exactly what you need — the 50 customers who spend the least amount of 
money on accessories. You can go a step further and format the report a bit by sorting on the Sum of 
Sales Amount and applying a currency format to the numbers (see Figure 14-38).
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Figure 14-38: Your final report.

Note that because you built this view using a pivot table, you can now filter according to any new 
field. For example, you can add the Market field to the Filter area to get the 50 United Kingdom cus-
tomers who spend the least amount of money on accessories. This, my friends, is the power of using 
pivot tables for the basis of your dashboards and reports. Continue to play around with the Top 10 
filter option to see what kind of reports you can come up with (see Figure 14-39).

Figure 14-39: You can easily adapt this report to produce any combination of views.

Note  

You may notice that in Figure 14-39, the bottom 50 view is showing only 23 records . 
This is because there are fewer than 50 customers in the United Kingdom market that 
have accessories sales . Because I asked for the bottom 50, Excel shows up to 50 
accounts; but fewer if there are fewer than 50 . If there’s a tie for any rank in the bottom 
50, Excel shows you all the tied records .
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You can remove the applied filters in your pivot tables by taking these actions:

 1. Click anywhere inside your pivot table to activate the PivotTable Tools context tab in the Ribbon.

 2. Click the Analyze tab.

 3. Select the Clear icon and select Clear Filters, as shown in Figure 14-40.

Figure 14-40: Select Clear Filters to remove the applied filters in a field.

Creating views by month, quarter, and year
Raw transactional data is rarely aggregated by month, quarter, or year for you. This type of data is often 
captured by the day. However, people often want reports by month or quarters instead of detail by day. 
Fortunately, pivot tables make it easy to group date fields into various time dimensions. Here’s how:

 1. Build a pivot table with Sales Date in the Row Labels area and Sales Amount in the Values 
area, similar to the one in Figure 14-41.

Figure 14-41: Build this pivot table to start.

 2. Right-click any date and select Group, as shown in Figure 14-42.

  The Grouping dialog box appears, as shown in Figure 14-43.

 3. Select the time dimensions that you want.

  In this example, you can select Months, Quarters, and Years.

 4. Click OK.
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Figure 14-42: Select the Group option.

Figure 14-43: Select the time dimensions that suit your needs.

Here are several interesting things to note about the resulting pivot table. First, notice that Quarters 
and Years have been added to your field list. Keep in mind that your source data hasn’t changed to 
include these new fields; instead, these fields are now part of your pivot table. Another interesting 
thing to note is that, by default, the Years and Quarters fields are automatically added next to the 
original date field in the pivot table layout, as shown in Figure 14-44.

Figure 14-44: Your pivot table is now grouped by Years and Quarters.

After your date field is grouped, you can use each added time grouping just as you would any other 
field in your pivot table. For instance, in Figure 14-45, I moved the Years and Quarters fields to the 
Column area and filtered on 2011.
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Figure 14-45: You can use your newly created time dimensions just like a normal pivot field.

Creating a percent distribution view
A percent distribution (or percent contribution) view allows you to see how much of the total is made 
up of a specific data item. This view is useful when you’re trying to measure the general impact of a 
particular item.

The pivot table, as shown in Figure 14-46, gives you a view into the percent of sales that comes from 
each business segment. Here, you can tell that bikes make up 81 percent of Canada’s sales, whereas 
only 77 percent of France’s sales come from bikes.

Figure 14-46: This view shows percent of total for the row.

You’ll also notice in Figure 14-46 that this view was created by selecting the % of Row Total option in 
the Value Field Settings dialog box. Here are the steps to create this type of view:

 1. Right-click any value within the target field.

  For example, if you want to change the settings for the Sales Amount field, right-click any 
value under that field.

 2. Select Show Values As.

 3. Select % of Row Total.
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The pivot table in Figure 14-47 gives you a view into the percent of sales that comes from each mar-
ket. Here, you have the same type of view, but this time, you use the % of Column Total option.

Figure 14-47: This view shows percent of total for the column.

Again, remember that because you built these views in a pivot table, you have the flexibility to slice 
the data by region, bring in new fields, rearrange data, and most importantly, refresh this view when 
new data comes in.

Creating a YTD totals view
Sometimes, it’s useful to capture a running totals view to analyze the movement of numbers on a 
year-to-date (YTD) basis. Figure 14-48 illustrates a pivot table that shows a running total of revenue 
by month for each year. In this view, you can see where the YTD sales stand at any given month in 
each year. For example, you can see that in August 2010 revenues were about a million dollars lower 
than the same point in 2009.

Figure 14-48: This view shows a running total of sales for each month.

Note  

In the sample data for this chapter, you don’t see Months and Years . You have to create 
them by grouping the SalesDate field . Feel free to review the “Creating views by month, 
quarter, and year” section earlier in this chapter to find out how .
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To create this type of view, follow these steps:

 1. Right-click any value within the target field.

  For example, if you want to change the settings for the Sales Amount field, right-click any 
value under that field.

 2. Select Value Field Settings.

  The Value Field Settings dialog box appears.

 3. Click the Show Values As tab.

 4. Select Running Total In from the drop-down list.

 5. In the Base Field list, select the field that you want the running totals to be calculated 
against.

  In most cases, this will be a time series such as, in this example, the SalesDate field.

 6. Click OK.

Creating a month-over-month variance view
Another commonly requested view is a month-over-month variance. How did this month’s sales 
compare to last month’s sales? The best way to create these types of views is to show the raw num-
ber and the percent variance together.

In that light, you can start creating this view by building a pivot table similar to the one shown in 
Figure 14-49. Notice that you bring in the Sales Amount field twice. One of these remains untouched, 
showing the raw data. The other is changed to show the month-over-month variance.

Figure 14-49: Build a pivot table that contains the Sum of Sales Amount twice.

Figure 14-50 illustrates the settings that convert the second Sum of Sales Amount field into a month-
over-month variance calculation.
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Figure 14-50: Configure the second Sum of Sales Amount field to show month-over-month variance.

As you can see, after applying these settings, the pivot table gives you a nice view of raw sales dollars 
and the variance over last month. You can obviously change the field names (see the “Renaming the 
fields” section earlier in this chapter) to reflect the appropriate labels for each column.

Note  

In the sample data for this chapter, you don’t see Months and Years . You have to create 
them by grouping the SalesDate field . Feel free to review the section, “Creating views by 
month, quarter, and year,” earlier in this chapter to find out how .

To create the view in Figure 14-50, follow these steps:

 1. Right-click any value within the target field.

  In this case, the target field is the second Sum of Sales Amount field.

 2. Select Value Field Settings.

  The Value Field Settings dialog box appears.

 3. Click the Show Values As tab.

 4. Select % Difference From in the drop-down list.

 5. In the Base Field list, select the field that you want the running totals to be calculated 
against.

  In most cases, this is a time series like, in this example, the SalesDate field.

 6. In the Base Item list, select the item you want to compare against when calculating the per-
cent variance. In this example, you want to calculate each month’s variance to the previous 
month. Therefore, select the (previous) item.
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15
Using Pivot Charts
In This Chapter

● Creating your first pivot chart

● Understanding the link between pivot charts and pivot tables

● Using conditional formatting with pivot tables

● Examining alternatives to using pivot charts

A pivot chart is a graphical representation of a data summary displayed in a pivot table. A pivot chart 
is always based on a pivot table. Excel lets you create a pivot table and a pivot chart at the same time, 
but you can’t create a pivot chart without a pivot table.

If you’re familiar with creating charts in Excel, you’ll have no problem creating and customizing pivot 
charts. Most of Excel’s charting features are available in a pivot chart. But as you’ll see, pivot charts 
are actually a completely different animal.

Cross-Ref 

The discussion here assumes that you’re familiar with the inner workings of pivot tables, 
which is covered in Chapter 14 . Feel free to refer to Chapter 14 if you need a refresher on 
pivot tables .

Getting Started with Pivot Charts
When you create a standard chart from data that isn’t in a pivot table, you feed the chart a range made 
up of individual cells holding individual pieces of data. Each cell is an individual object with its own 
piece of data, so your chart treats each cell as an individual data point, charting each one separately.
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However, the data in your pivot table is part of a larger object. The pieces of data you see inside your 
pivot table aren’t individual pieces of data that occupy individual cells. Rather, they are items inside a 
larger pivot table object that is occupying space on your worksheet.

When you create a chart from your pivot table, you’re not feeding it individual pieces of data inside 
individual cells; you’re feeding it the entire pivot table layout. Thus your pivot chart can interactively 
add, remove, filter, and refresh data fields inside the chart just like your pivot table. The result of all 
this action is a graphical representation of the data you see in your pivot table.

Cross-Ref
 

If you’re new to Excel charts, we highly recommend you first read through Part II of this 
book . 

Creating a pivot chart
To see how to create a pivot chart, look at the pivot table in Figure 15-1. This pivot table provides a 
simple view of revenue by market. In the Business Segment field in the report filter area, you can 
parse out revenue by line of business.

Figure 15-1: This basic pivot table shows revenue by market and allows for filtering by line of business.

To start the process, place your cursor anywhere in the pivot table, go to the Ribbon, and click the 
Insert tab. Find the Charts group, where you can choose the chart type you want to use for your pivot 
chart. For this example, click the Column Chart icon and select the first 2-D column chart, as demon-
strated in Figure 15-2. A chart appears, as shown in Figure 15-3.

Notice that pivot charts are now, by default, placed on the same sheet as the source pivot table. If 
you long for the days when pivot charts were located on their own chart sheet, you are in luck. All 
you have to do is place your cursor in your pivot table and then press F11 on your keyboard, and a 
pivot chart is created on its own sheet.
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Figure 15-2: Select the chart type you want to use.

Figure 15-3: Excel creates your pivot chart on the same sheet as your pivot table.

You can easily change the location of your pivot charts by simply right-clicking on the chart (outside 
the plot area) and selecting Move Chart. This activates the Move Chart dialog box, where you can 
specify the new location.

Tip  

In Figure 15-3, notice the pivot field buttons on the pivot chart — the gray buttons with 
drop-down arrows . Using these pivot field buttons, you can rearrange the chart and 
apply filters to the underlying pivot table .

If you aren’t too keen on showing the pivot field buttons directly on your pivot charts, 
you can remove them by clicking on the chart and selecting the Analyze tab . On the 
Analyze tab, you can use the Field Buttons drop-down button to hide some or all of the 
pivot field buttons .

You now have a chart that is a visual representation of your pivot table. Moreover, because the pivot 
chart is tied to the underlying pivot table, changing the pivot table in any way changes the chart. For 
example, as Figure 15-4 illustrates, adding the Region field to the pivot table adds a region dimen-
sion to your chart.
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Figure 15-4: Your pivot chart displays the same fields your underlying pivot table displays.

In addition, selecting a Business Segment from the Page field filter filters both the pivot table and the 
pivot chart. All this behavior occurs because pivot charts use the same pivot cache and pivot layout 
as their corresponding pivot tables. Thus, if you add or remove data from your data source and 
refresh your pivot table, your pivot chart updates to reflect the changes.

Take a moment to think about the possibilities. You can essentially create a fairly robust interactive 
reporting tool on the power of one pivot table and one pivot chart; no programming is necessary.

Understanding the link between pivot charts  
and pivot tables
The primary rule to remember is that your pivot chart is merely an extension of your pivot table. If 
you refresh, move a field, add a field, remove a field, hide a data item, show a data item, or apply a  
filter, your pivot chart reflects your changes.

One common mistake people make when using pivot charts is assuming that Excel will place the  
values in the column area of the pivot table in the x-axis of the pivot chart.

For instance, the pivot table in Figure 15-5 is in a format that’s easy to read and comprehend. The 
structure chosen shows Sales Periods in the column area and the Region in the row area. This structure 
works fine in the pivot table view.

Figure 15-5: The placement of your data fields may work for a pivot table, but not for a pivot chart.
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Suppose you decide to create a pivot chart from this pivot table. You would instinctively expect to 
see fiscal periods across the x-axis and lines of business along the y-axis. However, as you can see in 
Figure 15-6, your pivot chart comes out with Region in the x-axis and Sales Period in the y-axis.

Figure 15-6: Creating a pivot chart from your nicely structured pivot table doesn’t yield the results you expected.

So why doesn’t the structure in your pivot table translate to a clean pivot chart? The answer has to do 
with the way pivot charts handle the different areas of your pivot table.

In a pivot chart, both the x-axis and the y-axis correspond to a specific area in your pivot table.

➤ The y-axis of your pivot chart corresponds to the column area in your pivot table.

➤ The x-axis of your pivot chart corresponds to the row area in your pivot.

Given this new information, look at the pivot table in Figure 15-5 again. This structure says that the 
Sales_Period field will be treated as the y-axis because it is in the column area. Meanwhile, the Region 
field will be treated as the x-axis because it is in the row area.

Now suppose you rearrange the pivot table to show fiscal periods in the row area and lines of busi-
ness in the column area, as shown in Figure 15-7. This format makes reading more difficult in a pivot 
table view, but it gives your pivot chart the effect you want (see Figure 15-8).

Figure 15-7: Moving fiscal periods to the row area allows your pivot chart to accurately plot the data.
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Figure 15-8: With the new arrangement in your pivot table, you get a pivot chart that makes sense.

Limitations of pivot charts
Overall, the look and feel of pivot charts in Excel 2013 is similar to the look and feel of standard 
charts, making them much more of a viable reporting option. However, a few limitations persist in 
this version of Excel.

➤ You cannot use XY (scatter) charts, bubble charts, or stock charts when creating a pivot chart.

➤ Applied trend lines are often lost when adding or removing fields in the underlying pivot 
table.

➤ The chart titles in the pivot chart cannot be resized.

Tip
 

Although you cannot resize the chart titles in a pivot chart, making the font bigger or 
smaller indirectly resizes the chart title . 

Using conditional formatting with pivot tables
In Excel 2007, Microsoft introduced a robust set of conditional formatting visualizations, including 
data bars, color scales, and icon sets. These new visualizations allow users to build dashboard-style 
reporting that goes far beyond the traditional red, yellow, and green designations. What’s more, con-
ditional formatting was extended to integrate with pivot tables, which means that conditional for-
matting is now applied to a pivot table’s structure, not just the cells it occupies.
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In this section, you find out how to leverage the magic combination of pivot tables and conditional 
formatting to create interactive visualizations that serve as an alternative to pivot charts.

To start the first example, create the pivot table shown in Figure 15-9.

Figure 15-9: Create this pivot table.

Suppose you want to create a report that allows your managers to see the performance of each sales 
period graphically. You could build a pivot chart, but you decide to use conditional formatting. In this 
example, go the easy route and quickly apply some data bars:

 1. Select all the Sum of Sales_Amount2 values in the values area.

 2. Click the Home tab and select Conditional Formatting➜Data Bars as shown in Figure 15-10.

Figure 15-10: Apply data bars to the values in your pivot table.
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You immediately see data bars in your pivot table under the values in the Sum of Sales_Amount2 
field. Notice that the Data Bars coexist with the data values. To get a clean visualization, you want to 
show only the Data Bars by following these steps:

 1. Go to the Home tab, click the Conditional Formatting button, and select Manage Rules.

  The Rules Manager dialog box appears.

 2. Select the Data Bar rule you just created and then select Edit Rule.

  The Edit Formatting Rule dialog box appears.

 3. Click the Show Bar Only option (see Figure 15-11).

Figure 15-11: Click the Show Bar Only option to get a clean view of just the data bars.

As you can see in Figure 15-12, you now have a set of bars that correspond to the values in your pivot 
table. This visualization looks like a sideway chart, doesn’t it? What’s more impressive is that as you 
filter the markets in the report filter area, the data bars dynamically update to correspond with the 
data for the selected market.

Figure 15-12: You have applied conditional data bars with just three easy clicks!
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Excel 2013 has a handful of preprogrammed scenarios that can be leveraged when you want to 
spend less time configuring your conditional formatting and more time analyzing your data. For 
example, to create the data bars you’ve just employed, Excel uses a predefined algorithm that  
takes the largest and smallest values in the selected range and calculates the condition levels for 
each bar.

Other examples of preprogrammed scenarios include

Top Nth Items

Top Nth %

Bottom Nth Items

Bottom Nth %

Above Average

Below Average

To remove the applied conditional formatting, place your cursor in the pivot table and then select 
Home➜Conditional Formatting➜Clear Rules➜Clear Rules from This PivotTable.

Customizing conditional formatting
You are by no means limited to preprogrammed scenarios. You can create your own custom condi-
tions. To see what we mean, create the pivot table shown in Figure 15-13.

Figure 15-13: This pivot shows Sales_Amount, Contracted_Hours, and a calculated field that calculates Dollars 
per Hour.
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Here you want to evaluate the relationship between total revenue and dollars per hour. The idea is 
that some strategically applied conditional formatting helps identify opportunities for improvement. 
Follow these steps:

 1. Place your cursor in the Sales_Amount column.

 2. Click the Home tab and select Conditional Formatting.

 3. Select New Rule. 

  The New Formatting Rule dialog box appears, as shown in Figure 15-14.

Figure 15-14: The New Formatting Rule dialog box.

The objective in this dialog box is to identify the cells where the conditional formatting will be 
applied, specify the rule type to use, and define the details of the conditional formatting.

 1. Identify the cells where your conditional formatting will be applied. 

  You have three choices:

● Selected Cells: This selection applies conditional formatting to only the selected cells.

● All cells showing Sales_Amount values: This selection applies conditional formatting to all 
values in the Sales_Amount column, including all subtotals and grand totals. This selection 
is ideal for use in analyses in which you’re using averages, percentages, or other calcula-
tions where a single conditional formatting rule makes sense for all levels of analysis.

● All cells showing Sales_Amount values for Market: This selection applies conditional for-
matting to all values in the Sales_Amount column at the Market level only (excludes sub-
totals and grand totals). This selection is ideal for use in analyses where you’re using 
calculations that make sense only within the context of the level being measured.
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The words Sales_Amount and Market are not permanent fixtures of the New Formatting 
Rule dialog box . These words change to reflect the fields in your pivot table . Sales_
Amount is used because your cursor is in that column . Market is used because the active 
data items in the pivot table are in the Market field .

  In this example, the third selection (All cells showing Sales_Amount values for Market) makes 
the most sense, so click that radio button, as demonstrated in Figure 15-15.

Figure 15-15: Click the radio button next to All cells showing “Sales_Amount” values for “Market”.

 2. In the Select a Rule Type section, you need to specify the rule type you want to use for the 
conditional format.

  You can select one of five rule types:

● Format All Cells Based on Their Values: This selection allows you to apply conditional for-
matting based on some comparison of the actual values of the selected range. That is, 
the values in the selected range are measured against each other. This selection is ideal 
when you want to identify general anomalies in your dataset.

● Format Only Cells That Contain: This selection allows you to apply conditional formatting 
to those cells that meet specific criteria you define. Keep in mind that the values in your 
range aren’t measured against each other when you use this rule type. This selection is 
useful when you’re comparing your values against a predefined benchmark.

● Format Only Top or Bottom Ranked Values: This selection allows you to apply conditional 
formatting to those cells that are ranked in the top or bottom nth number or percent of 
all the values in the range.

● Format Only Values That Are Above or Below the Average: This selection allows you to 
apply conditional formatting to those values that are mathematically above or below the 
average of all values in the selected range.

Note
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● Use a Formula to Determine Which Cells to Format: This selection allows you to specify 
your own formula and evaluate each value in the selected range against that formula. If 
the values evaluate as true, the conditional formatting is applied. This selection comes in 
handy when you’re applying conditions based on the results of an advanced formula or 
mathematical operation.

  Data bars, color scales, and icon sets can be used only when the selected cells are formatted 
based on their values. This means that if you want to use data bars, color scales, and icon 
sets, you must select the Format All Cells Based on Their Values rule type.

  In this scenario, you want to identify problem areas using icon sets; therefore, you want to 
format the cells based on their values.

 3. Define the details of the conditional formatting in the Edit the Rule Description section.

  Again, you want to identify problem areas using the slick new icon sets offered by Excel 
2013. Select Icon Sets from the Format Style drop-down menu.

 4. Select a style appropriate to your analysis.

  The style selected in Figure 15-16 is ideal for situations in which your pivot tables cannot 
always be viewed in color.

Figure 15-16: Select Icon Sets from the Format Style drop-down menu.

  With this configuration, Excel applies the sign icons based on the percentile bands >=67, 
>=33, and <33. Keep in mind that the actual percentile bands can be changed based on your 
needs. In this scenario, the default percentile bands are sufficient.
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 5. Click OK to apply the conditional formatting.

  As you can see in Figure 15-17, you now have icons that allow you to quickly determine 
where each market falls in relation to other markets as it pertains to revenue.

Figure 15-17: You have applied your first custom conditional formatting!

 6. Apply the same conditional formatting to the Dollars per Hour field.

  When you are done, your pivot table should look similar to the one shown in Figure 15-18.

Figure 15-18: You have successfully created an interactive visualization.

Take a moment to analyze what you have here. With this view, a manager can analyze the relationship 
between total revenue and dollars per hour. For example, the Dallas market manager can see that he is 
in the bottom percentile for revenue but in the top percentile for dollars per hour. With this informa-
tion, he immediately sees that his dollars per hour rates may be too high for his market. Conversely, the 
New York market manager can see that she is in the top percentile for revenue but in the bottom per-
centile for dollars per hour. This tells her that her dollars-per-hour rates may be too low for her market.

And all this is driven by a pivot table and some conditional formatting!
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Alternatives to Pivot Charts
There are generally two reasons why you need an alternative to using pivot charts: You don’t want 
the overhead that comes with a pivot chart, and you want to avoid some of the formatting limita-
tions of pivot charts.

In fact, sometimes you may create a pivot table simply to summarize and shape your data in prepara-
tion for charting. In these situations, you don’t plan on keeping your source data, and you definitely 
don’t want a pivot cache taking up memory and file space.

In the example in Figure 15-19, you can see a pivot table that summarizes revenue by quarter for 
each product.

Figure 15-19: This pivot table was created to summarize and chart revenue by quarter for each product.

The idea here is that you create this pivot table only to summarize and shape your data for charting. 
You don’t want to keep the source data, nor do you want to keep the pivot table with all its over-
head. The problem is that if you try to create a chart using the data in the pivot table, you inevitably 
create a pivot chart, which means you have all the overhead of the pivot table looming in the back-
ground. Of course, this could be problematic if you don’t want to share your source data with end 
users or you don’t want to inundate them unnecessarily with large files.

The good news is that with a few simple techniques, you can create a chart from a pivot table, but 
not end up with a pivot chart. 

Disconnecting charts from pivot tables
Sometimes you want to chart the data in your pivot table, but don’t need the chart to remain con-
nected to the pivot table. Maybe you want to e-mail just the chart to someone without the pivot 
table. Maybe you need a quick one-time chart and don’t need to keep the connection to the pivot 
table. Whatever the case, you can use any of these three alternative techniques for creating charts 
that are disconnected from pivot tables.

Create a standard chart from current pivot table values
After you’ve created and structured your pivot table appropriately, select the entire pivot table and 
copy it. Then under the Insert tab, select Paste Values, as shown in Figure 15-20.
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Figure 15-20: The Paste Values functionality is useful when you want to create hard-coded values  
from pivot tables.

This action essentially deletes your pivot table, leaving you with the last values that were displayed in 
the pivot table. These values can subsequently be used to create a standard chart.

This technique disables the dynamic functionality of your pivot chart. That is, your pivot chart 
becomes a standard chart that cannot be interactively filtered or refreshed.

Delete the underlying pivot table
If you’ve already created your pivot chart, you can turn it into a standard chart by simply deleting the 
underlying pivot table. To do so, select the entire pivot table and press Delete on the keyboard.

With this method, you are left with none of the values that made up the source data for the chart. In 
other words, if anyone asks for the data that feeds the chart, you will not have it.

Tip  

If you ever find that you have a chart but the data source isn’t available, activate the 
chart’s data table . The data table lets you see the data values that feed each series in the 
chart . See Chapter 7 to learn how to add the data table to a chart . 

Create a picture of the pivot chart
A picture of your pivot chart freezes all of the text and numbers without any other information. In 
addition to very small file sizes, you get the added benefit of controlling what your clients get to see.

To use this method, follow these steps:

 1. Copy the pivot chart by right-clicking on the chart (outside the plot area) and selecting Copy.

 2. Open a new workbook.

 3. Right-click anywhere in the new workbook and select Paste Special; then select the picture 
format you prefer.

  A picture of your pivot chart is then placed in the new workbook.
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If you have pivot field buttons on your chart, they will also show up in the copied  
picture, which may confuse your audience about why the buttons don’t work . Be  
sure to hide all pivot field buttons before copying a pivot chart as a picture . You  
can remove them by clicking your chart and then selecting the Analyze tab . On the 
Analyze tab, use the Field Buttons drop-down button to hide all of the pivot field  
buttons .

Create standalone charts that are connected  
to your pivot table
To retain key functionality in your pivot table, such as report filters and top ten ranking, you can link a 
standard chart to your pivot table without creating a pivot chart.

In the example in Figure 15-21, a pivot table shows the top ten markets by contracted hours along 
with their total revenue. Notice that the report filter area allows you to filter by business segment so 
you can see the top ten markets segment.

Figure 15-21: This pivot table allows you to filter by business segment to see the top ten markets by total  
contracted hours and revenue.

Suppose you want to turn this view into an XY scatter chart to be able to point out the relationship 
between the contracted hours and revenues. You need to keep the capability to filter out ten records 
by model number; however, you also want the ability to create XY.

A pivot chart is definitely out because you can’t build pivot charts with certain chart types (such as  
XY scatter charts). The preceding techniques are also out because those methods disable the interac-
tivity you need. So what’s the solution? Use the cells around the pivot table to link back to the data 
you need and then chart those cells. That is, you can build a mini dataset that feeds your standard 
chart.

Caution
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This dataset links back to the data items in your pivot table, so when your pivot table changes, your 
dataset changes. Follow these steps to create a standalone chart that is connected to your pivot table:

 1. Click in a cell next to your pivot table (see Figure 15-22) and reference the first data item you 
want plotted on your chart.

Figure 15-22: Start your linked dataset by referencing the first data item you need to capture.

 2. Copy the formula you just entered and paste it down and across to create your complete 
dataset.

  At this point, you have a dataset that looks similar to the one in Figure 15-23.

Figure 15-23: Copy the formula and paste it down and across to create your complete dataset.

 3. After your linked dataset is complete, use it to create a standard chart.

  In this example, you create an XY scatter chart with this data, which you can’t do with a pivot 
chart.

Figure 15-24 demonstrates how this solution offers the best of both worlds:

➤ You kept the ability to filter out a particular business segment using the Page field.

➤ You have all the formatting freedom of a standard chart without any of the issues related to 
using a pivot chart.
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Figure 15-24: This solution provides the functionality of your pivot table without the formatting limitations of a 
pivot chart.
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16
Adding Interactivity 
with Slicers
In This Chapter

● Understanding slicers

● Creating and formatting standard slicers

● Using Timeline slicers

● Using slicers as command buttons

Slicers allow you to filter your pivot table, similar to the way Filter fields filter a pivot table. The difference is 
that slicers offer a user-friendly interface, enabling you to better manage the filter state of your pivot table 
reports. Happily, Microsoft has added another dimension to slicers with the introduction of Timeline 
slicers. Timeline slicers are designed to work specifically with date-based filtering.

In this chapter, you explore slicers and their potential to add an attractive as well as interactive user 
interface to your dashboards and reports.

Understanding Slicers
If you’ve worked your way through Chapter 14, you know that pivot tables allow for interactive filter-
ing using Filter fields. Filter fields are the drop-down lists you can include at the top of your pivot 
table, allowing users to interactively filter for specific data items. As useful as Filter fields are, they’ve 
always had a couple of drawbacks:
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➤ Filter fields are not cascading filters. They don’t work together to limit selections when needed.

 For example, look at Figure 16-1. You can see that the Region filter is set to the North region. 
However, the Market filter still allows you to select markets that are clearly not in the North 
region (California, for example). Because the Market filter is not in any way limited based on 
the Region Filter field, you have the annoying possibility of selecting a market that could 
yield no data because it isn’t in the North region.

Figure 16-1: Default pivot table Filter fields don’t work together to limit filter selections.

➤ Filter fields don’t provide an easy way to tell what exactly is being filtered when you select 
multiple items.

 Figure 16-2 shows an example of this. As you can see, the Region filter has been limited to 
three regions: Midwest, North, and Northeast. However, notice that the Region filter value 
shows (Multiple Items). By default, Filter fields will show (Multiple Items) when you select 
more than one item. The only way to tell what has been selected is to click the drop-down. 
You can imagine the confusion on a printed version of this report, when there is no way to 
click down to see which data items make up the numbers on the page.

Figure 16-2: Filter fields show “(Multiple Items)” when multiple selections are made.
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By contrast, slicers don’t have these issues. Slicers respond to one another. As illustrated in  
Figure 16-3, the Market slicer visibly highlights the relevant markets when the North region  
is selected. The rest of the markets are muted, signaling that they’re not part of the North  
region.

Figure 16-3: Slicers work together to show you relevant data items based on your selection.

When selecting multiple items in a slicer, you can easily see that multiple items have been chosen. In 
Figure 16-4, the pivot table is filtered by the Midwest, North, and Northeast regions. No more (Multiple 
Items).

Figure 16-4: Slicers do a better job at displaying multiple item selections.

Creating a Standard Slicer
It’s time to create your first slicer. Follow these steps:

 1. Place your cursor anywhere inside your pivot table; then go to the Ribbon and select the 
Analyze tab.

 2. Click the Insert Slicer icon (see Figure 16-5).
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Figure 16-5: Inserting a slicer.

  The Insert Slicers dialog box appears. 

 3. Click the filter values to filter your pivot table (see Figure 16-6).

  The idea is to select the dimensions you want to filter. In this example, the Region and 
Market slicers will be created.

Figure 16-6: Select the dimensions for which you want slicers created.

  As you can see in Figure 16-7, clicking Midwest in the Region slicer not only filters your pivot table, 
but also the Market slicer responds by highlighting the markets that belong to the Midwest region.

Figure 16-7: Select the dimensions you want filtered using slicers.

  You can also select multiple values by holding the Ctrl key while selecting the needed filters. 
As illustrated in Figure 16-8, you press Ctrl while selecting Baltimore, California, Charlotte, 
and Chicago, which highlights the selected markets in the Market slicer and their associated 
regions in the Region slicer.
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Figure 16-8: The fact that you can visually see the current filter state gives slicers a unique advantage 
over the Filter field.

To clear the filtering on a slicer, simply click the Clear Filter icon on the target slicer (shown in Figure 16-9).

Figure 16-9: Clearing the filters on a slicer.

Formatting slicers
When using slicers in a dashboard environment, you must do a bit of formatting to make your slicers 
match the theme and layout of your dashboard. The following subsections describe a few common 
formatting adjustments you can make to slicers.

Size and placement
A slicer behaves like a standard Excel shape object in that you can move it around and adjust its size 
by clicking on it and dragging its position points (see Figure 16-10).

Figure 16-10: Adjust the slicer size and placement by dragging its position points.

www.it-ebooks.info

http://www.it-ebooks.info/


Part IV: Pivot Table Driven Dashboards334

You can also right-click the slicer and select Size and Properties, which accesses the Format Slicer 
pane illustrated in Figure 16-11. Here you can adjust the size of the slicer, how the slicer behaves 
when cells are shifted, and whether the slicer will be shown when the worksheet is printed.

Figure 16-11: The Format Slicer pane offers more control over how the slicer behaves in relation to the worksheet 
it’s on.

Data item columns
By default, all slicers are created with one column of data items. You change this by right-clicking the 
slicer and selecting Size and Properties. This accesses the Format Slicer pane. Under the Position and 
Layout section, you specify the number of columns. Adjusting the number to 2 (as demonstrated in 
Figure 16-12) forces the data times to be displayed in two columns. Adjusting the number to 3 forces 
the data items to display in three columns, and so on.

Figure 16-12: Adjust the Number of Columns property to display the slicer data items in more than  
one column.
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Color and style
You can quickly change the color and style of your slicer. Click it; then select a style from the Slicer 
Style gallery on the Slicer Tools’ Options tab (see Figure 16-13). The default styles available will suit 
the majority of your dashboards.

If you want more control over the color and style of your slicer, click the New Slicer Style button at 
the lower-left corner of the Slicer Style gallery shown in Figure 16-13. A dialog box appears where 
you can apply detailed formatting for each component part of the slicer.

Figure 16-13: Use the Slicer Style gallery to apply a default style or create your own.

Other slicer settings
Right-clicking your slicer and selecting Slicer Settings activates the Slicer Settings dialog box shown 
in Figure 16-14. With this dialog box, you can control the look of your slicer’s header, how your slicer 
is sorted, and how filtered items are handled.

Figure 16-14: The Slicer Settings dialog box.
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With minimal effort, you can integrate your slicers nicely into your dashboard layout. Figure 16-15, 
illustrates two slicers and a pivot chart working together as a cohesive dashboard component.

Figure 16-15: With a little formatting, slicers can be made to adopt the look and feel of your overall dashboard.

Controlling multiple pivot tables
Another advantage you gain with slicers is that each slicer can be tied to more than one pivot table. 
That is to say, any filter you apply to your slicer can be applied to multiple pivot tables.

To connect your slicer to more than one pivot table, simply right-click the slicer and select Report 
Connections. This activates the Report Connections dialog box shown in Figure 16-16. Place a check 
next to any pivot table that you want to filter using the current slicer.

Figure 16-16: Choose the pivot tables that will be filtered by this slicer.

At this point, any filter you apply to the slicer will be applied to all the connected pivot tables. 
Controlling the filter state of multiple pivot tables is a powerful feature, especially in dashboards that 
run on multiple pivot tables.
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Creating a Timeline Slicer
The Timeline slicer is new in Excel 2013. The Timeline slicer is similar to a standard slicer: You filter a 
pivot table using a visual selection mechanism instead of the old Filter fields. The difference is that 
the Timeline slicer is designed to work exclusively with date fields, providing an excellent visual 
method to filter and group the dates in your pivot table.

To create a Timeline slicer, your pivot table must contain a field where all the data is formatted as a 
date. It’s not enough to have a column of data that contains a few dates. All the values in your date 
field must be a valid date and be formatted as such.

To create a Timeline slicer, follow these steps:

 1. Place your cursor anywhere inside your pivot table; then go up to the Ribbon and select the 
Analyze tab.

 2. Click the Timeline Slicer icon (see Figure 16-17).

Figure 16-17: Inserting a Timeline slicer.

  The Insert Timelines dialog box, shown in Figure 16-18, activates, showing you all the avail-
able date fields in the chosen pivot table.

 3. Select the date fields for which you want to create the timeline.

Figure 16-18: Select the date fields for which you want slicers created.

www.it-ebooks.info

http://www.it-ebooks.info/


Part IV: Pivot Table Driven Dashboards338

After your Timeline slicer is created, you can filter the data in your pivot table and pivot chart, using 
this dynamic data selection mechanism. Figure 16-19 demonstrates how selecting Mar, Apr, and May 
in the Timeline slicer automatically filters the pivot chart.

Figure 16-19: Click a date selection to filter your pivot table or pivot chart.

Figure 16-20 illustrates how you can expand the slicer range with the mouse to include a wider range 
of dates in your filtered numbers.

Figure 16-20: You can expand the range on the Timeline slicer to include more data in the filtered numbers.

Want to quickly filter your pivot table by quarters? Well, that’s easy with a Timeline slicer. Simply click 
the time period drop-down menu and select Quarters. As you can see in Figure 16-21, you also have 
the option of switching to Years or Days, if needed.
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Figure 16-21: Quickly switch between Quarters, Years, Months, and Days.

Note  

Timeline slicers apply filters based on standard calendar years . In other words, Q1 
means Jan, Feb, and Mar . However, if your fiscal year starts in October, your Q1 is  
made up of Oct, Nov, and Dec . So the quarter slicers may not be as useful for your  
organization . Currently you can’t force a slicer to adjust to your own custom fiscal  
year .

Note  

Timeline slicers are not backward-compatible, meaning they are usable only in Excel 
2013 . If you open a workbook with Timeline slicers in Excel 2010 or previous versions, 
the Timeline slicers will be disabled .

Using Slicers as Form Controls
In Chapter 12, you discovered how to add interactivity to a dashboard using data modeling tech-
niques and Form controls. Although the techniques in that chapter are powerful, the one drawback 
is that Excel Form controls are starting to look a bit dated, especially when paired with the modern-
looking charts that come with Excel 2013.

One clever way to alleviate this problem is to highjack the slicer feature for use as a proxy Form con-
trol of sorts. Figure 16-22 demonstrates this option with a chart that responds to the slicer on the left. 
When you click Income, the chart fills with income data. When you click Expense, the chart fills with 
expense data. Keep in mind that the chart is no way connected to a pivot table.
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Figure 16-22: You can highjack pivot slicers and use them as more attractive Form controls for models not built 
on pivot tables.

 

If you skipped Chapter 12, you may want to visit it now in order to better understand 
the data modeling and setup demonstrated in this example .

To build this basic model, follow these steps:

 1. Create a simple table that holds the names you want for your controls, along with  
some index numbering. In this case, the table contains three rows under a field called  
Metric.

  Each row contains a metric name and index number for each metric (Income, Expense,  
and Net).

 2. Using this simple table, create a pivot table (see Figure 16-23).

Figure 16-23: Create a simple table that holds the names for your controls along with some index 
numbering; then using that table, create a pivot table.

 3. Place your cursor anywhere inside the newly created pivot table, select the Analyze tab, and 
then click the Insert Slicer icon. In the Insert Slicer dialog box, create a slicer for the Metric 
field.

  At this point, you have a slicer with the three metric names.

 4. Right-click the slicer and choose Slicer Settings to activate the Slicer Settings dialog box.

Cross-Ref
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 5. In the Slicer Settings dialog box, uncheck the Display Header option (see Figure 16-24).

Figure 16-24: Create a slicer for the Metric field and remove the header.

  Each time the Metric slicer is clicked, the associated pivot table is filtered to show only the 
selected metric.

  Figure 16-25 demonstrates that this action also filters the index number for that metric. The 
filtered index number always shows up in the same cell (N8 in this case). So this cell can now 
be used as a trigger cell for VLOOKUP formulas, INDEX formulas, and If statements.

Figure 16-25: Clicking an item in the slicer filters out the correct index number for the selected metric.

 6. Use the slicer-fed trigger cell (N8) to drive the formulas in your staging area, as demonstrated 
in Figure 16-26.

Figure 16-26: Use the filtered trigger cell to drive the formulas in your staging area.
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  This formula tells Excel to check the value of cell N8:

 ● If the value of cell N8 is 1, which represents the value of the Income option, the formula 
returns the value in the Income dataset (cell G9).

 ● If the value of cell N8 is 2, which represents the value of the Expense option, the formula 
returns the value in the Expense dataset (cell G13). 

 ● If the value of cell N8 is neither 1 nor 2, the value in the Net dataset (cell G17) is returned.

 7. Copy the formula down and across to build out the full staging table (see Figure 16-27).

Figure 16-27: The final staging table fed via the slicer.

 8. Create a chart using the staging table as the source.

With this simple technique, you can provide your customers with an attractive interactive menu that 
more effectively adheres to the look and feel of their dashboards. 
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17
Using the Internal Data 
Model and Power View
In This Chapter

● Understanding the internal Data Model

● Starting a Power View dashboard

● Creating and working with Power View charts

● Visualizing data on a Power View map

Excel 2013 introduces a new feature called Power View. Power View is essentially an interactive  
canvas that allows you to display charts, tables, maps, and slicers in one dashboard window. The 
components in the Power View window are inherently linked so that they all work together and 
respond to any filtering or slicing you apply while using the dashboard. Select a region in one chart, 
and the other components in the Power View dashboard automatically respond to show you data for 
only that region.

This powerful feature runs on the new internal Data Model found in Excel 2013. The internal Data 
Model is an in-memory analytics engine that allows you to store disparate data sources in a kind of 
OLAP cube within Excel. OLAP is a category of data warehousing that allows you to mine and analyze 
vast amounts of data with ease and efficiency.

This chapter shows you how to combine the internal Data Model and Power View to create powerful 
interactive dashboards.

Note  

Sadly, Microsoft has made Power View available only with Office 2013 Professional Plus 
or the Office 365 Small Business Premium subscription service . You won’t even see the 
options for Power View if you don’t have one of these versions of Office 2013 . However, 
the internal Data Model discussed in this chapter is happily available in all versions of 
Excel 2013 . This feature is powerful enough on its own as you will see in the following 
section .
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Understanding the Internal Data Model
Excel 2013 introduces a new in-memory analytics engine called the internal Data Model. Every  
workbook has one internal Data Model that allows you to work with analyze disparate data sources 
like never before.

The idea behind the Data Model is simple. Let’s say you have two tables — a Customers table and an 
Orders table. The Orders table has basic information about invoices (Customer Number, Invoice Date, 
and Revenue). The Customers table has basic information like Customer Number, Customer Name, 
and State.

If you want to analyze revenue by state, you must join the two tables and aggregate the Revenue 
field in the Orders table by the State field in the Customers table.

In the past, you would have to go through a series of gyrations involving VLOOKUPs, SUMIFs, or other 
formulas. With the new Excel 2103 data model, however, you can simply tell Excel how the two tables 
are related (in this case, they both have a customer number) and then pull them into the internal 
Data Model. The Excel Data Model will then build an internal analytical database based on that  
customer number relationship and expose the data through a pivot table. With the pivot table, you 
can create the aggregation by state with a few clicks of the mouse.

Building out your first data model
Imagine that you have the Transactions table you see in Figure 17-1. On another worksheet, you have 
a Generators table (see Figure 17-2) that contains location information about each generator.

Figure 17-1: This table shows transactions by generator number.

Figure 17-2: This table provides location information on each generator.
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You can find the example file for this chapter on this book’s companion website at  
www.wiley.com/go/exceldr in the workbook named Chapter 17 Samples .xlsx .

The first step in building your data model is to convert your separate data ranges to named Excel 
Tables. Converting a range to a table ensures that the internal Data Model will recognize it as an 
actual data source.

Convert your data ranges to Tables
For each data range you want to import into the internal Data Model, follow these steps:

 1. Click anywhere in the Transactions data table and press Ctrl+T on your keyboard.

  The Create Table dialog box opens, as shown in Figure 17-3.

 2. Ensure that the range for the table is correct and click OK.

Figure 17-3: Convert your first data range into an Excel Table.

  Click inside your Excel Table, and you will see a Table Tools Design tab on the Ribbon. Note 
that if you create multiple tables in a worksheet, the Table Tools Design tab will apply to the 
Excel Table you have selected. 

 3. Click the Table Tools Design tab and enter a friendly name for your table in the Table Name 
box (see Figure 17-4).

  This step ensures that you will be able to recognize the table when adding it to the internal 
Data Model.

Figure 17-4: Give your newly created Excel Table a friendly name.

In this scenario, you use the same steps to convert your Generators range to an Excel Table.

On the Web
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Add your Tables to the internal Data Model
Each 2013 workbook has an internal Data Model that (by default) is exposed as a connection called 
ThisWorkbookDataModel when you add data sources to it. You can add your newly created Tables to 
the internal Data Model using the Workbook Connections dialog box. Follow these steps:

 1. Go to the Ribbon, click the Data tab, and select Connections.

 2. In the Workbook Connections dialog box, click the drop-down arrow beside the Add button 
and select Add to the Data Model (see Figure 17-5).

Figure 17-5: Open the Workbook Connections dialog box and select Add to the Data Model.

  The Existing Connections dialog box opens, as shown in Figure 17-6.

 3. Click the Tables tab, choose the table you want to add, and click OK.

Figure 17-6: Choose a table to add and click OK.

 4. Repeat Steps 2 and 3 for each Table you want to add to the internal Data Model.

  After adding all your tables, the Workbook Connections dialog box shows a connection 
called ThisWorkbookDataModel, listing all the data sources associated with it.

As you can see in Figure 17-7, you now have your two tables in the internal Data Model.
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Figure 17-7: The internal Data Model now contains the Transactions and Generators tables.

Note  

Any changes made to your tables (such as adding records, deleting records, and adding 
columns) are automatically captured in the internal Data Model . No need to perform a 
refresh action .

Build relationships for the Tables in the internal Data Model
Although your data now exists in the internal Data Model, Excel doesn’t inherently know how your 
tables relate to one another. For example, your two tables have a column called Generator_ID (refer 
to Figures 17-1 and 17-2). This column is the key that connects the two tables, allowing you to match 
transactions with customer location.

You need to explicitly define this relationship before Excel recognizes how to handle the data in the 
Data Model. Follow these steps:

 1. Go to the Ribbon, click the Data tab, and select Relationships.

  The Manage Relationships dialog box opens.

 2. Click the New button.

  The Create Relationship dialog box opens, as shown in Figure 17-8.

 3. Select the tables and fields that define the relationship.

  In Figure 17-8, note that the Transactions table has a Generator_ID field; it’s related to the 
Generators table via the Generator_ID field.

 4. Click OK to confirm the relationship.

  You are returned to the Manage Relationships dialog box (see Figure 17-9). Here you can  
add any additional relationships you may need. Notice that you can also delete and edit  
relationships in this dialog box.
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Figure 17-8: Create the relationships between your tables, defining each table and the associated fields.

Figure 17-9: Use the Manage Relationships dialog box to add, delete, and edit relationships.

 

In Figure 17-8, at the lower right, notice the Related Column (Primary) drop-down field . 
The term Primary means that the internal Data Model will use this field from the  
associated table as the primary key . Every relationship must have a field you designate 
as the primary key . Primary key fields are necessary in the Data Model to prevent  
aggregation errors and duplications . Thus the Excel Data model must impose some 
strict rules around the primary key . You cannot have duplicates or null values in a field 
being used as the primary key . So the Generators table (shown in Figure 17-8) must 
have all unique values in its Generator_ID field, with no blanks or null values . This is the 
only way Excel can ensure data integrity when joining multiple tables .

Using your Data Model in a pivot table
After you fill your internal Data Model, you can start using it. Later, in the “Creating a Power View 
Dashboard” section, you find out how to leverage it with Power View. First, explore how to leverage 
the Data Model in pivot tables to analyze the data within. To create a pivot table from the internal 
Data Model, follow these steps:

 1. Click the Insert tab and select PivotTable to start a pivot table.

 2. In the Create PivotTable dialog box, select Use an External Data Source and click the Choose 
Connection button (see Figure 17-10).

  The Existing Connections dialog box opens, as shown in Figure 17-11.

 3. Click the Tables tab and choose Tables in Workbook Data Model. Click Open to confirm.

  You return to the Create PivotTable dialog box.

 4. Click OK to finalize the pivot table.

Note
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Figure 17-10: Start a pivot table and opt to choose an external connection.

Figure 17-11: Select the Tables in Workbook Data Model option to use the internal Data Model as the source for 
your pivot table.

After you create the pivot table, you’ll see that the Pivot Field list shows each table in the internal 
Data Model (similar to Figure 17-12).

Figure 17-12: Pivot tables that use the internal Data Model as the source will show all the tables within the Data 
Model in the pivot field list.
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With a Data Model–driven pivot table, you can merge disparate data sources into one analytical 
engine. Figure 17-13 demonstrates how you can build a view using data fields from the different 
tables in the Data Model.

Figure 17-13: With a Data Model–driven pivot table, you can analyze data using the fields for each table in the 
Data Model.

Using external data sources in your internal Data Model
The internal Data Model isn’t limited to using only data that already exists in your Excel workbooks. 
You can fill your Data Model with all kinds of external data sources. In Chapter 18, you dive into  
using external data sources in your dashboarding models. Now, though, take a look at how to bring 
external data sources into the Data Model.

Say that you have an Access database that contains a normalized set of tables. You want to analyze 
the data in that database in Excel. You decide to use the new internal Data Model to present the data 
you need through a pivot table.

On the Web
 

You can find the Facility Services Access database on this book’s companion website at 
www.wiley.com/go/exceldr .

To use external tables in your Data Model, follow these steps.

 1. On the Data tab of the Ribbon, select the From Access icon, as shown in Figure 17-14.

Figure 17-14: Click the From Access button to get data from your Access database.
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 2. Browse to your target Access database and open it.

  The Select Data dialog box opens.

 3. In the Select Data dialog box, place a check next to Enable Selection of Multiple Tables  
(see Figure 17-15).

Figure 17-15: Enable the selection of multiple tables.

 4. Place a check next to each table you want to bring into the internal Data Model, as  
demonstrated in Figure 17-16.

 5. Click OK.

  The Import Data dialog box opens, as shown in Figure 17-17.

Figure 17-16: Place a check next to each table you want to import to the internal Data Model; then 
click OK.

 6. In the Import Data dialog box, click the Properties drop-down arrow and remove the check 
next to Import Relationships Between Tables.

  This ensures that Excel doesn’t error out because of misinterpretations about how the tables 
are related. In other words, you want to create relationships yourself.
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Figure 17-17: Remove the check next to Import Relationships Between Tables.

 7. In the Import Data dialog box, choose PivotTable Report and click OK to create the base 
pivot.

 8. Go to the Ribbon, click the Data tab, and choose Relationships.

  The Manage Relationships dialog box opens, as shown in Figure 17-18.

 9. Create the needed relationships and then click the Close button.

Note  

As mentioned earlier in this chapter (in the section called “Build Relationships for the 
Tables in the Internal Data Model”), when creating the relationships for your Data 
Model, you will need to remain aware of which table you designate in the Related 
Column (Primary) drop-down field on the Manage Relationships dialog box . The table 
you use in this field cannot have duplicates or null values in a field being used as the  
primary key . So in this scenario, you will not be able to designate the TransactionMaster 
table in this field, as it contains transactional line items that may contain duplicates .

Figure 17-18: Create the needed relationships for the tables you just imported.

  If all went well, you should end with a pivot table similar to the one illustrated in  
Figure 17-19. In just a few clicks, you created a powerful platform to build and maintain pivot 
table analysis based on data in an Access database!
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Figure 17-19: You’re ready to build your pivot table analysis based on multiple external data tables.

Creating a Power View Dashboard
After you have data in your internal Data Model, you can create a Power View dashboard from that 
Data Model. Just go to the Ribbon, click the Insert tab, and click Power View. Excel takes a moment to 
create a new worksheet called Power ViewX, where X represents a number that will make the sheet 
name unique (for example, Power View1).

This new worksheet has the three main sections shown in Figure 17-20: Canvas, Filter Pane, and Field 
List.

The canvas contains the charts, tables, and maps you add to your dashboard. The filter pane contains 
the data filters you define. You use the field list to add and configure the data for your dashboard.

Figure 17-20: The three main sections of a Power View worksheet.

You build up your Power View dashboard by dragging the fields from the field list to the respective 
sections. For example, dragging the Generator_Size field to the filter pane creates a list of filterable 
items (see Figure 17-21) that can be checked and unchecked. The filter pane has a few icons that help 
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you work with the filters. These icons enable you to expand or collapse the entire filter pane, clear 
applied filters, call up advanced filter options, or delete the filter.

Figure 17-21: The filter pane has a few icons that help you work with the filters. 

To add data to the canvas, use the field list to drag the needed data fields to the FIELDS drop zone. In 
Figure 17-22, you can see that the Waste_Code field and the Generated_Qty field have been moved 
to the FIELDS drop zone. This results in a new table of data on the canvas.

Figure 17-22: Use the field list to drag data fields to the FIELDS drop zone, resulting in a table on the canvas.

Creating and working with Power View charts
All data in Power View starts off as a table, as shown in Figure 17-22. Again, dragging fields to the 
FIELDS drop zone creates these tables. After you have a data table on the canvas, you can transform 
it into a chart by clicking it, selecting the Design tab, and choosing a chart type. Figure 17-23 demon-
strates the selection of a Clustered Bar chart.

www.it-ebooks.info

http://www.it-ebooks.info/


Chapter 17: Using the Internal Data Model and Power View 355

Figure 17-23: Transform data tables in the canvas by selecting the table and choosing a chart type on the 
Design tab.

In Figure 17-24, note that after the data is converted to a chart, new drop zones appear in the field 
list. These new drop zones are used to configure to the look and utility of the chart.

Figure 17-24: When your table is transformed into a chart, new drop zones appear in the field list.

When you click a Power View chart, a context menu appears above the chart. With this menu,  
you can sort the chart series, filter the chart, and expand/collapse the chart to full screen (see  
Figure 17-25).

Figure 17-25: Clicking a Power View chart activates a context menu for that chart.
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When you select a chart in the Power View canvas, the filter pane provides a CHART option. Clicking 
that link allows you to see and apply custom filters to the selected chart. Figure 17-26 demonstrates 
filtering by the Generated_Qty field using a nifty slider.

Figure 17-26: You can use the filter pane to apply chart-specific custom filters.

You can slice your chart series by dragging a new data field into the LEGEND drop zone. In the  
example shown in Figure 17-27, the On_Site_Management field is placed in the LEGEND drop zone; 
as a result, the original chart is sliced by the data items in the newly placed field.

Figure 17-27: Use the LEGEND drop zone to slice your chart series.

Alternatively, you can use the VERTICAL MULTIPLES or the HORIZONTAL MULTIPLES drop zone to 
turn your original chart into a panel of charts. Figure 17-28 illustrates how your original chart has 
been replicated to show a separate chart for each data item in the On_Site_Management field.
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Figure 17-28: Dragging the On_Site_Management field to the VERTICAL MULTIPLES drop zone creates a panel 
of charts.

Another neat trick is to add drill-down capabilities to a chart, which you do by dragging a new data 
field to the AXIS drop zone. Figure 17-29 shows the Gen_State field dragged to the AXIS drop zone. 
Initially, it will seem as though nothing happened. But in the background, Power View has layered in 
the newly selected field as a new category axis. 

Figure 17-29: Dragging a new field to the AXIS drop zone creates a drill-down effect.

After you add your new field to the AXIS drop zone, double-click any data point in the chart. The 
chart automatically drills into the next level. In this case, because you added Gen_State (generator 
state) to the AXIS drop zone, the chart drills down to show the breakdown by state for the data point 
that you double-clicked (see Figure 17-30). Note the arrow icon that allows you to drill back up.
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Figure 17-30: With multiple data fields in the AXIS drop zone, you can drill into the next layer of data and then 
drill back up using the arrow icon.

You can create as many charts as you want to your Power View canvas. And as mentioned at the 
beginning of this chapter, all components in the Power View window are automatically linked so that 
they respond to one another. For instance, Figure 17-31 shows two charts on the same Power View 
canvas. Clicking the pie slice for Arkansas (AR) dynamically recolors the bar chart so that it highlights 
the portion of the bar that’s made up by the Arkansas data — all without any extra work from you!

Figure 17-31: Charts in a Power View dashboard automatically respond to one another.

Visualizing data in a Power View map
The latest buzz in the dashboarding world is location intelligence: visualizing data on a map to 
quickly compare performance by location. Since Excel 2003, we haven’t had a good way of building 
map-based visualizations without convoluted workarounds. Excel 2013 changes all that with the 
introduction of Power View maps.
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To add a map to your Power View dashboard, follow these steps:

 1. Start with some location data in the Power View canvas.

  Figure 17-32 illustrates some Zip Code data from your Data Model.

Figure 17-32: Add location data to your Power View canvas.

 2. With your location data selected, click the Design tab.

 3. Choose Map from the Switch Visualization group (see Figure 17-33).

Figure 17-33: Choose to show the data as a Map.

After a moment of gyrating, Excel generates a Bing map.

As you can see in Figure 17-34, the initial map will often be fairly useless. How Excel decides to  
initially handle your data is a bit of a black box and varies from data set to data set. You typically need 
to make some adjustments to get the view you need.

Figure 17-34: Excel generates an initial Bing map.
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After you create your map, try moving your location field to the different drop zones in the field list. 
The drop zone you end up on will vary according to how you want to see your data. In this example 
(see Figure 17-35), moving the Gen_Zip field to the LOCATIONS drop zone fixes your map and  
creates a nice view of your data by Zip Code.

Figure 17-35: Moving the Gen_Zip field to the LOCATIONS drop zone creates a nice view by Zip Code.

You have limited control over how your map looks. With your map selected, you can go to the Layout 
tab and customize the map title, legend, data labels, and map background (see Figure 17-36).

Figure 17-36: The Layout tab provides a limited set of options for customizing your Power View map.

The map is fully interactive, allowing you to zoom and move around using the buttons at the  
top-right corner of the map, as illustrated in Figure 17-37.

Figure 17-37: You can interactively zoom and move around on the map.

You can use the COLOR drop zone to add an extra layer of analysis to your map. For instance,  
Figure 17-38 demonstrates how adding the Waste_Code field to the COLOR drop zone differentiates 
each plotted location based on waste code.
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Figure 17-38: Add data fields to the COLOR drop zone to add an extra layer of analysis to your map.

Changing the look of your Power View dashboard
Excel grants you limited control over how your Power View dashboard looks. On the Power View tab 
(see Figure 17-39), you see a Themes group. Here you can set the overall font, background, and 
theme for your Power View dashboard.

Figure 17-39: Changing the theme of your Power View dashboard.

The theme you choose changes the colors for your charts, backgrounds, filters, tables, and plotted 
map points. The Bing map will not change to match your theme. Figure 17-40 illustrates a full Power 
View dashboard with an applied theme.

Figure 17-40: A completed Power View dashboard with an applied theme.
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18
Integrating External 
Data into Excel 
Reporting
In This Chapter

● Importing data from Microsoft Access databases

● Importing data from SQL Server databases

● Running SQL Server stored procedures from Excel

● Creating dynamic connections with VBA

● Creating a data model with multiple external data tables

Wouldn’t it be wonderful if all the data you come across could be neatly packed into one easy-to-use 
Excel table? The reality is that sometimes the data you need comes from external data sources. 
External data is exactly what it sounds like: data that isn’t located in the Excel workbook in which 
you’re operating. Some examples of external data sources are text files, Access tables, SQL Server 
tables, and even other Excel workbooks.

This chapter explores some efficient ways to get external data into your Excel data models. Before 
jumping in, however, your humble authors want to throw out one disclaimer. There are numerous 
ways to get data into Excel. In fact, between the functionality found in the UI and the VBA/code  
techniques, there are too many techniques to focus on in one chapter. So for this endeavor, you 
focus on a handful of techniques that can be implemented in most situations and don’t come with a 
lot of pitfalls and gotchas.
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Importing Data from Microsoft Access
Microsoft Access is used in many organizations to manage a series of tables that interact with each 
other, such as a Customers table, an Orders table, and an Invoices table. Managing data in Access 
provides the benefit of a relational database where you can ensure data integrity, prevent redun-
dancy, and easily generate datasets via queries.

Excel 2013 offers several methods for getting your Access data into your Excel data model.

The drag-and-drop method
For simplicity, you just can’t beat the drag-and-drop method. You can simultaneously open an empty 
Excel workbook and an Access database from which you want to import a table or query. When both 
are open, resize each application’s window so that they’re both fully visible on your screen.

Hover the mouse over the Access table or query you want to copy into Excel. Now click the table and 
drag it to the blank worksheet in Excel (see Figure 18-1).

Figure 18-1: Copy an Access table using the drag-and-drop method.

The drag-and-drop method comes in handy when you’re doing a quick one-time analysis where you 
need a specific set of data in Excel. However, the method isn’t so useful for the following:

➤ You expect this step to occur routinely, as a part of a repeated analysis or report.

➤ You expect the users of your Excel presentation to get or update the data via this method.

➤ It’s not possible or convenient for you to simply open up Access every time you need the 
information.

In the preceding scenarios, it’s much better to use another technique.
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The Microsoft Access Export Wizard
Access has an Export Wizard, and it’s relatively simple to use.

 1. With your Access database open, click your target table or query to select it.

 2. On the External Data tab on the Ribbon, select the Excel icon under the Export group.

  The wizard that you see in Figure 18-2 opens.

Figure 18-2: Export data to Excel using the Excel Export Wizard.

  As you can see in Figure 18-2, you can specify certain options in the Excel Export Wizard. You 
can specify the file location, the file type, and some format preservation options.

 3. In the Excel Export Wizard, select Export Data with Formatting and Layout; then select Open 
the Destination File After the Export Operation Is Complete.

 4. Click OK.

  Excel opens to show you the exported data.

In Access, the last page in the Export Wizard (Figure 18-3) asks if you want to save your export steps. 
Saving your export steps can be useful if you expect to frequently send that particular query or table 
to Excel.
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Figure 18-3: Use the Save Export Steps option if you export your data frequently.

The benefit to this method is that, unlike dragging and dropping, the ability to save export steps 
allows you to automate your exports by using Access macros.

Caution 

You may export your Access table or query to an existing Excel file instead of creating a 
new file . But note the following: the name of the exported object is the name of the 
table or query in Access . Be careful if you have an Excel object with that same name in 
your workbook because it may be overwritten . For example, exporting the PriceMaster 
table to an Excel worksheet that already has a worksheet named PriceMaster will  
cause the worksheet to be overwritten . Also, make sure the workbook to which you’re 
exporting is closed . If you try to export to an open workbook, you will likely receive an 
error in Access .

The Get External Data icon
The option to pull data from Access has been available in Excel for many versions; it was just buried 
several layers deep in somewhat cryptic menu titles. This made getting Access data into Excel seem 
like a mysterious and tenuous proposition for many Excel analysts. With the introduction of the 
Ribbon in Excel 2007, Microsoft put the Get External Data group of commands right on the Ribbon 
under the Data tab, making it easier to import data from Access and other external data sources.

Excel allows you to establish an updatable data connection between Excel and Access. To see the 
power of this technique, walk through these steps:

 1. Open a new Excel workbook and select the Data tab on the Ribbon.

 2. In the Get External Data group, select the From Access icon.
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  The Select Data Source dialog box opens (see Figure 18-4). If the database from which you 
want to import data is local, browse to the file’s location and select it. If your target Access 
database resides on a network drive at another location, you will need to have the proper 
authorization and access in order to select it.

 3. Navigate to your sample database and click Open.

Figure 18-4: Choose your source database.

  In some environments, a series of Data Link Properties dialog boxes open, asking for  
credentials (that is, username and password). Most Access databases don’t require logon  
credentials, but if your database does require a username and password, type them in the 
Data Link Properties dialog box.

 4. Click OK.

  The Select Table dialog box (see Figure 18-5) opens. This dialog box lists all the available 
tables and queries in the selected database.

Figure 18-5: Select the Access object you want to import.
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The Select Table dialog box in Figure 18-5 contains a column called Type . There are two 
types of Access objects you can work with: View and Table . View indicates that the  
dataset listed is an Access query, and Table indicates that the dataset is an Access table . 
In this example, Sales_By_Employee is actually an Access query . This means that you 
import the results of the query . This is true interaction at work; Access does all the  
back-end data management and aggregation, and Excel handles the analysis and  
presentation!

 5. Select your target table or query and click OK.

  The Import Data dialog box shown in Figure 18-6 opens. Here you define where and how  
to import the table. You have the option of importing the data into a Table, a PivotTable 
Report, or a PivotChart and PivotTable Report. You also have the option of creating only the  
connection, making the connection available for later use.

  Note that if you choose PivotChart and PivotTable Report, the data is saved to a pivot cache 
without writing the actual data to the worksheet. Thus your pivot table can function as  
normal without you having to import potentially hundreds of thousands of data rows twice 
(once for the pivot cache and once for the spreadsheet).

 6. Select Table as the output view and define cell A1 as the output location (see Figure 18-6).

 7. Click OK.

Figure 18-6: Choosing how and where to view your Access data.

Your reward for all the work will be a table similar to the one shown in Figure 18-7, which contains 
the imported data from your Access database.

Tip

www.it-ebooks.info

http://www.it-ebooks.info/


Chapter 18: Integrating External Data into Excel Reporting 371

Figure 18-7: Your imported Access data.

The incredibly powerful thing about importing data this way is that it’s refreshable. That’s right. If  
you import data from Access using this technique, Excel creates a table that you can update by  
right-clicking it and selecting Refresh from the pop-up menu, as shown in Figure 18-8. When you 
update your imported data, Excel reconnects to your Access database and imports the data again.  
As long as a connection to your database is available, you can refresh with a mere click of the  
mouse.

Figure 18-8: As long as a connection to your database is available, you can update your table with the latest 
data.

Again, a major advantage to using the Get External Data group is that you can establish a refreshable 
data connection between Excel and Access. In most cases, you can set up the connection one time 
and then just update the data connection when needed. You can even record an Excel macro to 
update the data on some trigger or event, which is ideal for automating the transfer of data from 
Access.
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Importing Data from SQL Server
In the spirit of collaboration, Excel 2013 vastly improves your ability to connect to transactional  
databases such as SQL Server. With the connection functionality found in Excel, creating a connected 
table or pivot table from SQL Server data is as easy as ever.

Managing external data properties
When you import external data into a table, you can control a few adjustable properties via the Properties 
dialog box. You can get to the properties of a particular external data table by clicking the target table 
and selecting the Properties icon under the Data tab.

This activates the External Data Properties dialog box. The properties found in this dialog box allow you to 
further customize your query tables to suit your needs. Take a moment to familiarize yourself with some 
of the useful options in this dialog box.

● Include Row Numbers: This property is deselected by default. Selecting this property creates 
a dummy column that contains row numbers. The first column of your dataset will be this row 
number column upon refresh.

● Adjust Column Width: This property is selected by default, telling Excel to adjust the column 
widths each time the data is refreshed. Deselecting this option will cause the column widths 
to remain the same.

● Preserve Column/Sort/Filter/Layout: If this property is selected, the order of the columns 
and rows of the Excel range remains unchanged. This way, you can rearrange and sort the col-
umns and rows of the external data in your worksheet without worrying about blowing away 
your formatting each time you refresh. Deselecting this property will make the Excel range 
look like the query.

● Preserve Cell Formatting: This property is selected by default, telling Excel to keep the 
applied cell formatting when you refresh.

● Insert Cells for New Data, Delete Unused Cells: This is the default setting for data range 
changes. When data rows decrease, you may have errors in adjacent cells that reference your 
external range. The cells these formulas referenced are deleted, so you will get an #VALUE 
error in your formula cells.

● Insert Entire Rows for New Data, Clear Unused Cells: When the unused cells are cleared 
instead of deleted, the formula may no longer return an error. Instead, it continues to refer-
ence cells from the original range — even though some of them are blank now. This could still 
give you erroneous results.

● Overwrite Cells for New Data, Clear Unused Cells: The third option should be the same as 
option two when rows decrease as unused cells are cleared.
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Start on the Data tab and follow these steps:

 1. Select From Other Sources to see the drop-down menu shown Figure 18-9; then select From 
SQL Server.

Figure 18-9: Select From SQL Server from the drop-down menu.

  Selecting this option activates the Data Connection Wizard, as shown in Figure 18-10. The 
idea here is that you configure your connection settings so Excel can establish a link to the 
server.

 2. Provide Excel with some authentication information.

  As you can see in Figure 18-10, you enter the name of your server as well as your username 
and password. If you’re typically authenticated via Windows authentication, you simply 
select the Use Windows Authentication option.

Figure 18-10: Enter your authentication information and click Next.

 3. Select the database with which you’re working from a drop-down menu containing all  
available databases on the specified server.

  As you can see in Figure 18-11, a database called AdventureWorks2012 is selected in the 
drop-down box. Selecting this database causes all the tables and views in it be shown in the 
list of objects below the drop-down menu.
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 4. Choose the table or view you want to analyze and then click Next.

Figure 18-11: Specify your database and then choose the table or view you want to analyze.

 5. In the screen that appears in the wizard, enter descriptive information about the connection 
you’ve just created (see Figure 18-12).

Figure 18-12: Enter descriptive information for your connection.

  This information is optional. If you bypass this screen without editing anything, your  
connection will work fine.

  The fields that you use most often are

● File Name: In the File Name input box, you can change the filename of the .odc (Office 
Data Connection) file generated to store the configuration information for the link you 
just created.

● Save Password in File: Under the File Name input box, you have the option of saving 
the password for your external data in the file itself (via the Save Password in File check 
box). Placing a check in this check box actually enters your password in the file. This pass-
word is not encrypted, so anyone interested enough could potentially get the password 
for your data source simply by viewing your file with a text editor.

www.it-ebooks.info

http://www.it-ebooks.info/


Chapter 18: Integrating External Data into Excel Reporting 375

● Description: In the Description field, you can enter a plain description of what this  
particular data connection does.

● Friendly Name: The Friendly Name field allows you to specify your own name for the 
external source. You typically enter a name that is descriptive and easy to read.

 6. When you are satisfied with your descriptive edits, click Finish to finalize your connection  
settings.

  You immediately see the Import Data dialog box where you can choose how to import your 
data. As you can see in Figure 18-13, this data will be shown in a pivot table.

Figure 18-13: Choosing how and where to view your SQL Server data.

When the connection is finalized, we can start building our pivot table.

Passing Your Own SQL Statements  
to External Databases
If you’re proficient at writing your own SQL queries, you can use the connection properties to write 
your own SQL statements. This gives you more control over the data you pull into your Excel model 
and allows you to perform advanced actions like running SQL Server stored procedures.

Manually editing SQL statements
After you’re connected to your external database, you can go to the Data tab on the Ribbon and 
select Connections. This activates the Workbook Connections dialog box illustrated in Figure 18-14. 
Choose the connection you want to edit and then click the Properties button.
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Figure 18-14: Click the Properties button for the connection you want to change.

The Connection Properties dialog box opens. Here you can click the Definition tab (see Figure 18-15). 
Change the Command Type property to SQL and then enter your SQL statement.

Figure 18-15: On the Definition tab, select the SQL command type and enter your SQL Statement.

Running stored procedures from Excel
If you’re connecting to an SQL Server database, you can use your own SQL Statement to fire a stored 
procedure. The SQL Statement demonstrated in Figure 18-16 executes the SP_MarketSummary 
stored procedure.

Figure 18-16: Running an SQL Server stored procedure from Excel.
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Some stored procedures require parameters (criteria inputs) to run successfully. If your stored  
procedures require parameters to run, you can simply include them in your SQL statement.  
Figure 18-17 illustrates this by running a stored procedure with two parameters:

➤ A parameter that passes the required market name

➤ A parameter that passes the required quarter

Figure 18-17: Running an SQL Server stored procedure with parameters.

Using VBA to create dynamic connections
You may have noticed that the preceding examples hard-coded the criteria in the SQL statements. 
For example, in Figure 18-17, Tulsa is specified directly in the SQL statement WHERE clause. This  
obviously would cause the data being returned to always be data for Tulsa.

But what if you want to select a market and have the SQL statement dynamically change to respond 
to your selection? Well, you can use a bit of VBA to change the SQL statement on the fly. Follow these 
steps:

 1. Designate a cell in your worksheet that will catch the dynamic selection for your criteria.

  For example, in Figure 18-18, cell C2 is where users can select a market. You typically give 
users a way to select criteria with either a combo box or a Data Validation list.

Figure 18-18: Designate a cell to trap the criteria selection.

 2. Click the Connections button on the Data tab to open the Workbook Connections  
dialog box.

  Note the name for the connection you want to dynamically change. In Figure 18-19, the  
connection name is Facility Services.

www.it-ebooks.info

http://www.it-ebooks.info/


Part V: Working with the Outside World378

Figure 18-19: Take note of the connection name (Facility Services, in this example).

 3. Close the Workbook Connections dialog box and press Alt+F11 on your keyboard.

  The Visual Basic Editor opens.

 4. Select Insert➜Module from menu bar.

 5. Enter the following code in the newly created module:

Sub RefreshQuery()

ActiveWorkbook.Connections(“Facility Services”).OLEDBConnection.
CommandText = _

“SELECT * FROM [Sales_By_Employee] WHERE [Market] = ‘” & _
 Range(“C2”).Value & “’”

ActiveWorkbook.Connections(“Facility Services”).Refresh
 
End Sub

  This code creates a new macro called RefreshQuery. The RefreshQuery macro points to the 
correct connection (Facility Services) and specifies the Command Text for that connection.

  The Command Text is essentially the SQL Statement you want the connection to run when 
triggered. In this example, the Command Text selects from the [Sales_By_Employee] table 
and sets the criteria for the [Market] field to the value in cell C2. The code then refreshes the 
Facility Services connection.

 6. Close the Visual Basic Editor and place a new command button on your worksheet.

  To do so, click on the Developer tab, select the Insert drop-down button, and add a Button 
Form control.

Cross-Ref
 

Refer to Chapter 12 for a detailed overview on using Form controls in your dashboards 
and reports .

 7. Assign the newly created RefreshQuery macro to the command button, as shown in  
Figure 18-20.
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Figure 18-20: Add a command button and assign your newly created RefreshQuery macro.

If all goes smoothly, you’ll have a nifty mechanism that allows dynamic extraction of data from your 
external database based on the criteria you specified (see Figure 18-21).

Figure 18-21: You now have an easy-to-use mechanism to pull external data for a specified market.
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19
Sharing Your Work with 
the Outside World
In This Chapter

● Controlling access to your dashboards and reports

● Displaying your Excel dashboards in PowerPoint

● Saving your dashboards and reports to a PDF file

● Saving your dashboards to the web

The focus of this chapter is preparing your dashboard for life outside your PC. Here, we discuss the 
various methods of protecting your work from accidental and purposeful meddling and discover 
how you can distribute your dashboards via PowerPoint and PDF files.

Securing Your Dashboards and Reports
Before distributing any Excel-based work, always consider protecting your file by using the security 
capabilities native to Excel. Although none of Excel’s protection methods is hacker-proof, they do 
serve to protect the formulas, data structures, and other objects that make your dashboard tick.

Securing access to the entire workbook
Perhaps the best way to protect your Excel file is to use Excel’s protection options for file sharing. 
These options enable you to apply security at the workbook level, requiring a password to view or 
make changes to the file. This method is by far the easiest to apply and manage because there’s no 
need to protect each worksheet one at a time. You can apply a blanket protection to guard against 
unauthorized access and edits. Take a moment to review the file-sharing options, which are as  
follows:
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➤ Forcing read-only access to a file until a password is given

➤ Requiring a password to open an Excel file

➤ Removing workbook-level protection

The next few sections discuss these options in detail.

Permitting read-only access unless a password is given
You can force your workbook to go into read-only mode until the user types the password. This way, 
you can keep your file safe from unauthorized changes yet still allow authorized users to edit the file.

Here are the steps to force read-only mode:

 1. With your file open, click the File tab.

 2. To open the Save As dialog box, select Save As and then double-click the Computer icon.

 3. In the Save As dialog box, click the Tools button and select General Options (see Figure 19-1).

  The General Options dialog box appears.

 4. Type an appropriate password in the Password to Modify input box (see Figure 19-2) and 
click OK.

 5. Excel asks you to reenter your password, so reenter your chosen password.

 6. Save your file to a new name.

  At this point, your file is password protected from unauthorized changes. If you were to open 
your file, you’d see something similar to Figure 19-3. Failing to type the correct password 
causes the file to go into read-only mode.

Figure 19-1: The File Sharing options are well hidden away in the Save As dialog box under General Options.

Figure 19-2: Type the password needed to modify the file.
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Figure 19-3: A password is now needed to make changes to the file.

Tip
 

Note that Excel passwords are case-sensitive, so make sure Caps Lock on your keyboard 
is in the off position when entering your password .

Requiring a password to open an Excel file
You may have instances where your Excel dashboards are so sensitive only certain users are  
authorized to see them. In these cases, you can require your workbook to receive a password to open 
it. Here are the steps to set up a password for the file:

 1. With your file open, click the File tab.

 2. To open the Save As dialog box, select Save As and then double-click the Computer icon.

 3. In the Save As dialog box, click the Tools button and select General Options (refer to  
Figure 19-1).

  The General Options dialog box opens.

 4. Type an appropriate password in the Password to Open text box (as shown in Figure 19-4) 
and click OK.

 5. Excel asks you to reenter your password.

 6. Save your file to a new name.

  At this point, your file is password protected from unauthorized viewing.

Figure 19-4: Type the password needed to modify the file.

Removing workbook-level protection
Removing workbook-level protection is as easy as clearing the passwords from the General Options 
dialog box. Here’s how you do it:

 1. With your file open, click the File tab.
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 2. To open the Save As dialog box, select Save As.

 3. In the Save As dialog box, click the Tools button and select General Options (refer to  
Figure 19-1).

  The General Options dialog box opens.

 4. Clear the Password to Open input box as well as the Password to Modify input box and  
click OK.

 5. Save your file.

Tip  

When you select the Read-Only Recommended check box in the General Options dialog 
box (refer to Figure 19-4), you get a cute but useless message recommending read-only 
access upon opening the file . This message is only a recommendation and doesn’t  
prevent anyone from opening the file as read/write .

Limiting access to specific worksheet ranges
You may find that you need to lock specific worksheet ranges, preventing users from taking certain 
actions. For example, you may not want users to break your data model by inserting or deleting  
columns and rows. You can prevent this by locking those columns and rows.

Unlocking editable ranges
By default, all cells in a worksheet are set to be locked when you apply worksheet-level protection. 
The cells on that worksheet can’t be altered in any way. That being said, you may find you need  
certain cells or ranges to be editable even in a locked state, like the example shown in Figure 19-5.

Figure 19-5: Though this sheet is protected, users can enter 2006 data into the input cells provided.

Before you protect your worksheet, you can unlock the cell or range of cells that you want users to be 
able to edit. (The next section shows you how to protect your entire worksheet.) Here’s how to do it:
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 1. Select the cells you need to unlock.

 2. Right-click and select Format Cells.

 3. On the Protection tab, as shown in Figure 19-6, deselect the Locked check box.

 4. Click OK to apply the change.

Figure 19-6: To ensure that a cell remains unlocked when the worksheet is protected, deselect the Locked 
check box.

Applying worksheet protection
After you’ve selectively unlocked the necessary cells, you can begin to apply worksheet protection. 
Just follow these steps:

 1. To open the Protect Sheet dialog box, click the Protect Sheet icon on the Review tab of the 
Ribbon (see Figure 19-7).

 2. Type a password in the text box (see Figure 19-8) and then click OK.

  This is the password that removes worksheet protection. Note that because you can apply 
and remove worksheet protection without a password, specifying one is optional.

 3. In the list box (see Figure 19-8), select which elements users can change after you protect the 
worksheet.

  When a check box is cleared for a particular action, Excel prevents users from taking that 
action.

 4. If you provided a password, reenter the password.

 5. Click OK to apply the worksheet protection.

Figure 19-7: Select Protect Sheet in the Review tab.
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Figure 19-8: Specify a password that removes worksheet protection.

Protect sheet elements and actions
Take a moment to familiarize yourself with the some of the other actions you can limit when  
protecting a worksheet (refer to Figure 19-8). They are as follows:

● Select Locked Cells: Allows or prevents the selection of locked cells.
● Select Unlocked Cells: Allows or prevents the selection of unlocked cells.
● Format Cells: Allows or prevents the formatting of cells.
● Format Columns: Allows or prevents the use of column formatting commands, including 

changing column width or hiding columns.
● Format Rows: Allows or prevents the use of row formatting commands, including changing 

row height or hiding rows.
● Insert Columns: Allows or prevents the inserting of columns.
● Insert Rows: Allows or prevents the inserting of rows.
● Insert Hyperlinks: Allows or prevents the inserting of hyperlinks.
● Delete Columns: Allows or prevents the deleting of columns. Note that if Delete Columns is 

protected and Insert Columns is not protected, you can technically insert columns you can’t 
delete.

● Delete Rows: Allows or prevents the deleting of rows. Note that if Delete Rows is protected 
and Insert Rows is not protected, you can technically insert columns you can’t delete.

● Sort: Allows or prevents the use of Sort commands. Note that this doesn’t apply to locked 
ranges. Users can’t sort ranges that contain locked cells on a protected worksheet, regardless 
of this setting.

● Use AutoFilter: Allows or prevents use of Excel’s AutoFilter functionality. Users can’t create or 
remove AutoFiltered ranges on a protected worksheet, regardless of this setting.

● Use PivotTable Reports: Allows or prevents the modifying, refreshing, or formatting pivot 
tables found on the protected sheet.

● Edit Objects: Allows or prevents the formatting and altering of shapes, charts, text boxes, 
controls, or other graphics objects.

● Edit Scenarios: Allows or prevents the viewing of scenarios.
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Removing worksheet protection
Just follow these steps to remove any worksheet protection you may have applied:

 1. Click the Unprotect Sheet icon on the Review tab.

 2. If you specified a password while protecting the worksheet, Excel asks you for that password 
(see Figure 19-9). Type the password and click OK to immediately remove protection.

Figure 19-9: The Unprotect Sheet icon removes worksheet protection.

Protecting the workbook structure
If you look under the Review tab in the Ribbon, you see the Protect Workbook icon next to the 
Protect Sheet icon. Protecting the workbook enables you to prevent users from taking any action 
that affects the structure of your workbook, such as adding/deleting worksheets, hiding/unhiding 
worksheets, and naming or moving worksheets. Just follow these steps to protect a workbook:

 1. To open the Protect Structure and Windows dialog box, click the Protect Workbook icon on 
the Review tab of the Ribbon, as shown in Figure 19-10.

 2. Choose which elements you want to protect: workbook structure, windows, or both. When a 
check box is cleared for a particular action, Excel prevents users from taking that action.

 3. If you provided a password, reenter the password.

 4. Click OK to apply the worksheet protection.

Figure 19-10: The Protect Structure and Windows dialog box.

Selecting Structure prevents users from doing the following:

➤ Viewing worksheets that you’ve hidden

➤ Moving, deleting, hiding, or changing the names of worksheets
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➤ Inserting new worksheets or chart sheets

➤ Moving or copying worksheets to another workbook

➤ Displaying the source data for a cell in a pivot table Values area or displaying pivot table 
Filter pages on separate worksheets

➤ Creating a scenario summary report

➤ Using an Analysis ToolPak utility that requires results to be placed on a new worksheet

➤ Recording new macros

Choosing Windows prevents users from changing, moving, or sizing the workbook windows while 
the workbook is opened.

Linking Your Excel Dashboards to 
PowerPoint
You may find that your organization heavily favors PowerPoint presentations for periodic updates. 
Several methods exist for linking your Excel dashboards to a PowerPoint presentation. For current 
purposes, we focus on the method that is most conducive to presenting frequently updated  
dashboards and reports in PowerPoint — creating a dynamic link. A dynamic link allows your 
PowerPoint presentation to automatically pick up changes that you make to data in your Excel  
worksheet.

Tip  

This technique of linking Excel charts to PowerPoint is ideal if you aren’t proficient at 
building charts in PowerPoint . Build the chart in Excel and then create a link for the 
chart in PowerPoint .

Creating the link between Excel and PowerPoint
When you create a link to a range in Excel, PowerPoint stores the location information to your source 
field and then displays a representation of the linked data. The net effect is that when the data in 
your source file changes, PowerPoint updates its representation of the data to reflect the changes.

On the Web
 

You can find the example Chapter 19 Samples .xlsx file for this chapter on this book’s 
companion website at www.wiley.com/go/exceldr .

To test this concept of linking to an Excel range, follow these steps:

 1. Open the Chapter 19 Samples.xlsx file.

 2. Click the chart to select it and press Ctrl+C on your keyboard to copy the chart.
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 3. Open a new PowerPoint presentation and place your cursor at the location that you want to 
display the linked table.

 4. On the Home tab in PowerPoint, choose Paste➜Paste Special, as shown in Figure 19-11.

Figure 19-11: Select Paste Special from the Home tab in PowerPoint.

  The Paste Special dialog box appears (see Figure 19-12).

Figure 19-12: Be sure to select Paste Link and set the link as an Excel Chart Object.

 5. Select the Paste Link radio button and choose Microsoft Excel Chart Object from the list of 
document types.

 6. Click OK to apply the link.

Your chart on your PowerPoint presentation now links back to your Excel worksheet (see Figure 19-13).

Figure 19-13: Your Excel chart is now linked into your new PowerPoint presentation.
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If you’re copying multiple charts, select the range of cells that contains the charts and 
press Ctrl+C to copy . This way, you’re copying everything in that range of cells — charts 
and all .

Manually updating links to capture updates
The nifty thing about dynamic links is that they can be updated, enabling you to capture any new 
data in your Excel worksheets without re-creating the links. To see how this works, follow these steps:

 1. Go back to your Excel file (from the example in the previous section) and change the values 
for Samsung and Nokia, as shown in Figure 19-14.

  Note the chart has changed.

 2. Return to PowerPoint, right-click the chart link in your presentation and choose Update Link, 
as demonstrated in Figure 19-15.

  You see that your linked chart automatically captures the changes.

 3. Save and close both your Excel file and your PowerPoint presentation and then open only 
your newly created PowerPoint presentation.

  Now you see the message shown in Figure 19-16. Clicking the Update Links button updates 
all links in the PowerPoint presentation. Each time you open any PowerPoint presentation 
with links, it asks you whether you want to update the links.

Figure 19-14: With a linked chart, you can make changes to the raw data without worrying about re-exporting 
the data into PowerPoint.

Tip
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Figure 19-15: You can manually update links.

Figure 19-16: PowerPoint, by default, asks if you want to update all links in the presentation.

Automatically updating links
Having PowerPoint ask you whether you want to update the links each and every time you open 
your presentation quickly gets annoying. You can avoid this message by specifying that PowerPoint 
automatically updates your dynamic links upon opening the presentation file. Here’s how:

 1. In PowerPoint, click the File tab to get to the Backstage View.

 2. In the Info Pane, go to the lower-right corner of the screen and select Edit Links to Files, as 
shown in Figure 19-17.

  The Links dialog box opens (see Figure 19-18).

 3. Click each of your links and select the Automatic radio button.
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Figure 19-17: Open the dialog box to manage your links.

Figure 19-18: Setting the selected links to update automatically.

When your links are set to update automatically, PowerPoint automatically synchronizes with your 
Excel worksheet file and ensures that all your updates are displayed.

Tip
 

To select multiple links in the Links dialog box, press the Ctrl key on your keyboard 
while you select your links .

Distributing Your Dashboards via a PDF
Starting with Excel 2010, Microsoft has made it possible to convert your Excel worksheets to a PDF 
document. A PDF is the standard document-sharing format developed by Adobe.

Although it may not seem intuitive to distribute your dashboards with PDF files, some distinct  
advantages make PDF an attractive distribution tool.
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➤ There are many advantages to publishing a Balanced Scorecard in PDF.

➤ Distributing your reports and dashboards as a PDF file allows you to share your final product 
without sharing all the formulas and back-end plumbing that comes with the workbook.

➤ Dashboards display in PDF files with full fidelity, meaning they display consistently on any 
computer and screen resolution.

➤ PDF files can be used to produce high-quality prints.

➤ Anyone using the free Adobe Reader can post comments and sticky notes on the distributed 
PDF files.

➤ Unlike Excel Security, the security in a PDF is generally better, allowing for multiple levels of 
security, including public-key encryption and certificates.

To convert your workbook to a PDF, follow these simple steps:

 1. Click the File tab and then choose the Export command.

 2. In the Export pane, select Create PDF/XPS Document (see Figure 19-19).

 3. The Publish as PDF or XPS dialog box opens. Click the Options button, as demonstrated in 
Figure 19-20.

 4. In the Options dialog box (illustrated in Figure 19-21), you can specify what you want to 
print. You have the option of printing the entire workbook, specific pages, or a range that 
you’ve selected.

 5. Click OK to confirm your selections.

 6. Click Save.

Figure 19-19: In Excel 2013, you can natively save as PDF.
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Figure 19-20: Select a location for your PDF; then click the Options button.

Figure 19-21: Excel allows you to define what gets sent to PDF.

Distributing Your Dashboards to SkyDrive
SkyDrive is Microsoft’s answer to Google Spreadsheets. You can think of it as a Microsoft Office  
platform in the cloud, allowing you to save, view, and edit your Office documents on the web.

When you publish your Excel dashboards or reports to SkyDrive, you can

➤ View and edit your workbooks from any browser, even if the computer you’re using doesn’t 
have Excel installed.

➤ Provide a platform where two or more people can collaborate on and edit the same Excel file 
at the same time.
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➤ Share only specific sheets from your workbook by hiding sheets you don’t want the public to 
see. When a sheet in a published workbook is hidden, the browser doesn’t even recognize its 
existence, so there is no way for the sheet to be unhidden or hacked into.

➤ Offer up web-based interactive reports and dashboards that can be sorted and filtered.

To publish a workbook to SkyDrive, follow these steps:

 1. Click the File tab on the Ribbon, click the Save As command, and choose SkyDrive, as demon-
strated in Figure 19-22.

  The SkyDrive pane allows you to sign in to your SkyDrive account.

Tip

 

If you don’t have a SkyDrive account, you can sign up for one using the Sign Up link .

Figure 19-22: Go to the SkyDrive pane.

 2. Sign in to your SkyDrive account.

  After signing in, the Save As dialog box in Figure 19-23 appears.

 3. Click Browser View Options to select which components of your workbook will be viewable 
to the public.
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Figure 19-23: Click Browser View Options.

  The Browser View Options dialog box allows you to control what the public is able to see and 
manipulate in your workbook.

 4. Click the Show tab (illustrated in Figure 19-24).

  Here, you can check and uncheck the Sheets and other Excel objects. Removing the check 
next to any sheet or object prevents it from being viewable through the browser. Again,  
this is a fantastic way to share your dashboard interfaces without exposing the back-end  
calculations and data model.

Figure 19-24: You have full control over which sheets and objects are available to the public when 
publishing to the web.

 5. After you confirm your browser view options, save the file into your Documents folder.

  At this point, you can sign in to Live.com and navigate to your SkyDrive documents to see 
your newly published file.
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There are several ways to share your newly published workbook: 

➤ Copy the web link from the browser address bar and e-mail that to your cohorts.

➤ Click the File tab in the web version of your file, choose Share (as shown in Figure 19-25), and 
then click the Share with People command to send an e-mail to anyone you specify.

➤ Use the Embed command on the same Share pane to generate HTML code to embed your 
workbook into a web page or blog.

Figure 19-25: Sharing options in an Excel web document.

Limitations when publishing to the web
It’s important to understand that workbooks that run on the web are running in an Excel Web App 
that is quite different from the Excel client application you have on your PC. The Excel Web App has 
limitations on the features it can render in the web browser. Some limitations exist because of  
security issues, whereas others exist simply because Microsoft hasn’t had time to evolve the Excel 
Web App to include the broad set of features that come with standard Excel.

In any case, the Excel Web App has some limitations:

➤ Data Validation doesn’t work on the web. This feature is simply ignored when you publish 
your workbook to the web.

➤ No form of VBA, including macros, will run in the Excel Web App. Your VBA procedures  
simply will not transfer with the workbook.

➤ Worksheet protection will not work on the web. Instead, you will need to plan for and use 
the Browser View Options demonstrated earlier in Figure 19-23.

➤ Links to external workbooks will no longer work after publishing to the web.
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➤ You can use any pivot tables with full fidelity on the web, but you cannot create any new 
pivot tables while your workbook is on the web. You will need to create pivot tables in the 
Excel client on your PC before publishing on the web.

www.it-ebooks.info

http://www.it-ebooks.info/


399

Index

Symbols and 
Numerics
, (comma), using in numbers, 23
$ (dollar symbol), indicating monetary 

values with, 23
- (minus symbol) for negative numbers, 

38, 42
( ) (parentheses) for negative  

percentages, 39
+ (plus symbol) for positive  

numbers, 38, 42
0 (zero). See also decimal places

replacing empty pivot table  
cells with, 301

starting vertical scale at, for  
trending, 173–175

3-D rotation effect, 145
30-day trial version of Power Utility Pak, 7
thousands and millions, formatting 

numbers in, 34, 39–41, 45,  
156, 158

A
A Date Occurring (Highlight Cells Rules 

option), 63
abbreviating month names on  

labels, 176–177
Above Average (Top/Bottom Rules 

option), 66
Access. See Microsoft Access databases
activating charts, 92, 93, 132
ActiveX controls versus Form  

controls, 272
AddDataBars macro, 268–271
aligning

headers to match numbers 
beneath, 35

numbers, right-aligning, 34
analysis layer

adding to pivot table, 287–288
for check box control, 254
for combo box control, 260
for list box control, 263

for option button control, 257
overview, 229
worksheet tab for, 231

area charts, trending using, 172, 173
Arial font, 36
arrays

converting range references  
to, 127–128

formula conventions in this book, 3
aspect ratio for sparklines, 53
audience of dashboard project, 14
automatic border, 140
automatic fill, 139
average

pivot chart conditional formatting 
for, 319

for smoothing data, 190–191
Average function (pivot table), 294
axes. See also category axis; scales for 

axes; value axes
adjusting scaling for sparklines, 55–56
of charts, 94
creating a chart with four, 129–130
date axis for sparklines, 58–59
gridlines for multiple axes, 164
of pivot charts, 315–316
removing, 21, 162
secondary category, 135
secondary value, 128–129, 135, 

182–183, 216
series, 135
titles for, 147
value versus category, 152–153

AXIS drop zone (Power View), 357

B
backgrounds, de-emphasizing, 19
bar charts. See also data bars

bullet graphs, 212–219
in-cell, 194
vertical, for trending, 177–178

Below Average (Top/Bottom Rules 
option), 66

Between (Highlight Cells Rules 
option), 63

bevel effect, 145
BI (Business Intelligence), 1–2
bin tables for histograms, 198–202
borders

chart options, 140
de-emphasizing, 19, 31–32
formatting, 32–33
removing, 20, 84

Bottom 10 Items (Top/Bottom Rules 
option), 66

Bottom 10% (Top/Bottom Rules 
option), 66

bubble charts
bubble size in SERIES formula, 117
not available for pivot charts, 316
value axes in, 153

bullet graphs
adding data to, 216–217
development of, 212–213
fixing the direction of, 214
horizontal, 218–219
parts of, 213
qualitative bands for, 218
steps for creating, 213–216

Business Intelligence (BI), 1–2
button control. See also option  

button control
adding and configuring, 251
assigning a macro to, 270–271
described, 249, 251
for navigation buttons, 274–275
renaming buttons, 271

buttons, pivot field, 313, 326

C
Calibri font, 36
Camera tool. See also live pictures

adding to Quick Access toolbar, 
82–83

for consolidating disparate ranges 
in one print area, 85
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Camera tool (continued)
creating live pictures with, 83–84
described, 82
for horizontal bullet graph, 218–219
live pictures updated  

automatically, 84
removing borders around 

pictures, 84
rotating pictures from, 85–86

cascading filters, 330
case-sensitivity

Excel not case-sensitive, 4
of passwords, 383

category axis. See also axes
described, 94, 134
multiline, 161–162
secondary, 135
time-scale, 159–161
value axis versus, 152–153

Caution icon, 5
chart area

described, 134
formatting, 141

Chart Elements dropdown, 132,  
133–134

chart formatting
activating charts for, 132
axes, 151–163
borders, 140
bullet graphs, 217–219
chart area, 141
chart elements, 101–102
copying, 104, 142
custom versus conditional number 

formatting in, 43
data labels, 164–168
data tables, 169–170
effects, 145
emphasizing bottom values, 207
emphasizing top values, 204–207
examples in this book, online, 143
fills, 138–139
Format dialog box for, 137–138
free-floating text, 148–149
gridlines, 163–164
legend, 149–151
Mini Toolbar for, 136–137
need for, 131
plot area, 141–143
Ribbon commands for, 101,  

135–136
selecting elements, 132–134

single data point, 184–185
template creation, 142
titles, 136, 146–148
of top and bottom values, 193–197
trial and error in, 131

chart junk, avoiding, 19–21
chart series or data series. See also 

ranges
adding labels to, 164
adding to existing chart, 109–112
changing data with drop-down 

selector, 259–261
changing the range highlight, 111, 

113–115
comparing different units of  

measure, 182–183
cumulative percent series, 201–202
data labels on markers, 166–167
deleting a legend entry, 151
deleting a series name, 119
deleting from a chart, 113
editing, 112
examples in this book, online,  

107, 143
Excel handling of, 91
filtering by hiding data, 124–125
formatting, 143–146
identifying without a legend, 151
maximum per chart, 96
from multiple sheets, 122–123
naming in SERIES formula, 118
naming on chart creation, 117
noncontiguous ranges in, 121–122
plot order for, 120–121
renaming, 118–119
Select Data Source dialog box for, 

111–112, 115
SERIES formula for, 112, 116–117
sizing markers, 167
smoothing data for, 188–191
specifying for charts, 107–108
toggling with check box control, 

253–255
unlinking from charts, 125–128
value axes for, 94

chart sheets. See also charts
activating, 132
converting embedded charts  

to, 103
copying, 103
creating for range of data, 92
data tables with, 170

deleting, 104
overview, 93
printing, 105

Chart Tools context tabs,  
displaying, 92, 93

charts. See also chart formatting; chart 
series or data series; pivot 
charts; trending

activating, 92, 93, 132
adding elements, 100
adding new series to, 109–112
applying styles, 99–100
benefits of, 90
bullet graphs, 212–219
changing the type, 98–99
chart sheets for, 92, 93, 103
converting to pictures, 126
copying ranges and pasting  

in, 110–111
copying the formatting, 104, 142
copying the whole chart, 103, 142
data orientation for, 98, 108
deactivating, 132
defined, 89
deleting elements, 100, 101
deleting series from, 113
elements common to  

(table), 134–135
embedded, 92, 103
examples in this book, online, 90
Excel handling of, 90–91
filtering by hiding data, 124–125
four value axes for, 129–130
limitations of, 96
locations in workbooks, 91
missing data in, handling, 123–124
modifying the range for a series, 

113–117
moving a chart, 102, 103
moving elements, 101
noncontiguous ranges for, 121–122
numeric category labels in, 109, 152
as objects, 91
parts of, 93–96
for performance against a target, 

209–221
Power View, 354–358
in presentation layer of data  

model, 229
preventing from printing, 105
printing, 105
renaming, 104
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Ribbon commands for, 101, 135–136
secondary value axis for, 128–129
selecting as an object, 132
series from multiple sheets  

in, 122–123
series names in, 117–119
series plot order for, 120–121
sizing, 102
specifying data for, 107–108
standalone, connected to pivot 

tables, 326–328
standard, creating from pivot 

tables, 324–325
static, 125–128
steps for creating, 96–97
switching row and column orienta-

tion, 98, 108, 214
templates for, 142
thermometer-style, 212
unlinking data ranges from, 125–128
updated automatically, 91
vertical, for trending, 177–178

check box control
adding and configuring, 251–252
described, 249, 251
staging tables for, 254
states of, 252
toggling a chart series with, 253–255

CHOOSE function
applying formulas to a data  

model, 242
described, 241
list box control using, 263–264
syntax, 242

clearing. See also removing or deleting
color from table cells, 31
filtering on slicers, 333
filters from pivot tables, 305

clip art, avoiding in dashboards, 19
codes. See also syntax

for colors, 42–43
for date and time formats, 44–45
Unicode characters for symbols, 79

Color Scales
applying, 68–69
conditional formatting rule type  

for, 322
colors

applying using conditions, 45
codes for, 42–43
for data bars, 68
formatting cells with Color  

Scales, 68–69

key metric indicated by, 34
number formatting using, 42–43, 45
Power View dashboard, 361
for ranges in data model, 26, 232
removing from table cells, 31
for slicers, 335
for sparklines, 54–55
subdued, for labels and headers, 

34–35
using sparingly, 19, 30–31

Column Labels area of pivot table,  
282–283

Column sparklines
changing to another type, 54
described, 49
illustrated, 50

columns of charts
security actions for, 386
switching orientation with rows, 98, 

108, 214
combination charts, trending using, 

172–173
combo box control

adding and configuring, 258–259
changing chart data with drop-

down selector, 259–261
described, 249, 258
INDEX function for, 260–261
staging table for, 260

Comic Sans font, 36
comma (,), using in numbers, 23
comments, data model, 25, 232
Compact Form of pivot table, 291
companion website for this book, 5, 29
comparative trending

described, 179
secondary axis for, 182–183
side-by-side time comparisons, 

179–180
stacked time comparisons, 181

component questions, 15
conditional formatting

automatic reevaluation of, 65
basic, 62–70
Color Scales, 68–69
custom, for pivot charts, 319–323
custom formatting rules for, 70–73
data bars, 67–68, 75–77, 194
described, 61
editing formatting rules, 68
Highlight Cells Rules, 62–65
how Excel applies rules, 72
icon sets, 69–70, 73–79

identifying cells for, 320–321
integration with pivot charts,  

316–319
macros for, 268–269
for numbers, 43, 45
predefined options for, 62
removing from pivot tables and 

charts, 319
rule types for, 321–322
showing data bars and icons  

outside cells, 75–77
showing only one icon, 73–75
showing trends with icon sets, 77–79
Top/Bottom Rules, 65–67

consistency of data, 26–27
conventions in this book, 3–4
converting

charts to pictures, 126
embedded charts to chart  

sheets, 103
Excel tables to ranges, 245
range references to arrays, 127–128
ranges to Excel tables, 244–245, 345
workbook to PDF, 393–394

copying
chart formatting, 104, 142
charts, 103, 142
pivot tables, and pasting, 290
range and pasting in chart, 110–111

Count function (pivot table), 294, 295
Count Nums function (pivot table), 294
Cross-Ref icon, 5
cumulative percent series, creating for 

histogram, 201–202

D
dashboards. See also Form controls

actionable data in, 302
Camera tool for enhancing, 85–86
components in presentation layer 

of data model, 229
described, 12
design principles, 17–23
distributing to SkyDrive, 394–398
distributing via PDF files, 392–394
examples in this book, online, 11
key attributes of, 12
linking to PowerPoint, 388–392
Power View, creating, 353–361
questions to ask before distributing, 

24–27
reports compared to, 12–13
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dashboards (continued)
usefulness for Business Intelligence, 1
user requirements for, 13–17

data. See also chart series or data series; 
data model; grouping data

availability and measures for, 16
establishing accuracy of, 26–27
hiding for sparklines, 53–54
limiting to support the purpose, 18
smoothing for trending, 188–191
sparklines linked to, 51

data bars
in-cell bar charts using, 194
changing colors for, 68
conditional formatting rule type  

for, 322
creating, 67–68
macros for, 268–269
in pivot charts, 317–318
showing outside cells, 75–77

data labels. See labels
data layer

lookup tables as, 233
overview, 226–229
worksheet tab for, 231

data model. See also internal Data Model
adding VLOOKUP formulas to, 235
analysis layer of, 229
applying CHOOSE formulas to, 242
applying HLOOKUP formulas to, 238
applying SUMPRODUCT formulas 

to, 240–241
avoiding excess data in, 230–231
comments and labels for docu-

menting, 232
data layer of, 226–229
documenting your dashboard, 

25–26
end-to-end process for, 226
Excel functions for, 233–242
Excel tables for, 243–245
pivot-table-driven, 229
presentation layer of, 229
separating data into layers, 226–229
tabs for documenting and  

organizing, 231–232
testing before using, 232
three-tiered, usefulness of, 226, 227

data points
adding labels to, 164
in charts, 94
described, 135
formatting a single point, 184–185

label position relative to, 165
maximum per chart, 96
maximum per series, 96
missing, handling, 123–124
selecting with the mouse, 133
sorting on, 35
sparklines emphasizing, 55

data series. See chart series or  
data series

data sources. See also external  
data sources

adding to bullet graph, 216–217
changing for a sparkline, 52
as data layer in data model, 226
determining for dashboard  

project, 16
indicating on dashboard or  

report, 23, 25
pivot table update for, 289–290
Select Data Source dialog box for, 

111–112, 115
specifying for pivot table, 285
for top and bottom displays, 194

data tables. See also Excel tables
adding, 169
bin tables for histograms, 198–202
for bullet graphs, 213–214
described, 134
flat, for data layer, 228
hard-coded, avoiding, 226, 227
problems and limitations  

with, 169–170
removing, 169

Data Validation functionality,  
drop-down lists using, 236

databases
Facility Services Access, 350
importing from Access, drag-and-

drop method for, 366
importing from Access, Export 

Wizard for, 367–368
importing from Access, Ribbon 

command for, 350–353,  
368–371

importing from SQL Server,  
372–375

managing Access data properties, 
372

passing SQL statements to external, 
375–379

using in internal Data Model,  
350–353

Date Occurring (Highlight Cells Rules 
option), 63

dates and times. See also trending
abbreviating month names on 

labels, 176–177
comparative trending, 179–181
A Date Occurring (Highlight Cells 

Rules option), 63
directional trending, 187–188
emphasizing time periods for  

trending, 184–187
format codes for, 44–45
implied month labels to reduce 

clutter, 177
moving average for, 189–190
pivot table views for time periods, 

305–310
sparklines date axis, 58–59
time-scale axes for, 159–161
timestamp on dashboard or  

report, 23, 25
deactivating charts, 132
decimal places

syntax for hiding and suppressing, 41
using minimum required, 23, 34, 41

de-emphasizing. See also emphasizing; 
removing or deleting

backgrounds, 19
borders, 19, 31–32
headers, 34–35
labels, 23, 34–35

Delete Columns security action, 386
Delete Rows security action, 386
deleting. See removing or deleting
design principles

formatting numbers effectively, 
22–23

further information, 17
labeling and titling effectively, 23
layout and placement to draw 

focus, 22
simplicity, 18–21
table design, 30–36

Developer tab, making visible, 266–267
dimensions

determining for dashboard  
project, 16

for slicers, 332
directional trending, 187–188
distributing dashboards

documenting before, 25
PDF files for, 392–394
to SkyDrive, 394–398
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documentation
dashboard, 25–26
data model, 25, 232
simple techniques for, 25–26

dollar symbol ($), indicating monetary 
values with, 23

drag-and-drop method for importing 
Access databases, 366

drill-down features, determining, 17
drop lines, 134
drop zones (Power View), 356–357
drop-down lists

adding, 236
changing chart data with, 259–261
combo box control for, 258–261
Filter fields, 329–330
VLOOKUP function with, 236

Duplicate Values (Highlight Cells Rules 
option), 63–64

E
Edit Objects security action, 386
Edit Scenarios security action, 386
effects, 19, 145–146
e-mail for feedback on this book, 7
embedded charts. See also charts

activating and deactivating, 132
converting to chart sheets, 103
copying, 103
data tables with, 170
deleting, 104
overview, 92
preventing from printing, 105
printing, 105

emphasizing. See also de-emphasizing
bottom values in charts, 207
key data points in sparklines, 55
time periods in trending, 184–187
top values in charts, 204–207

empty cells
displaying in charts, 124
replacing with zero or n/a value, 301

empty pivot table, creating, 284–285
error bars, 134
Excel

enabling macros in Excel 2013, 
272–274

hyperlink feature, 275
not case-sensitive, 4

suitability for Business  
Intelligence, 1–2

versions supporting Power  
View, 343

versions supporting sparklines, 47
Excel tables. See also data tables; table 

design
adding to internal Data  

Model, 346–347
converting ranges to, 244–245, 345
converting to ranges, 245
in Excel 2003 as List feature, 243
features of, 243
ranges automatically expanded  

for, 245
relating using the internal Data 

Model, 344–348
Excel Web App limitations, 397–398
external data sources

Access Export Wizard for  
importing, 367–368

drag-and-drop method for  
importing, 366

managing data properties, 372
Microsoft Access databases,  

350–353, 366–371
passing SQL statements to external 

databases, 375–379
Ribbon commands for importing, 

350–353, 368–375
SQL Server databases, 372–379
using in internal Data Model,  

350–353

F
Facility Services Access database, 350
feedback on this book, e-mail for, 7
Few, Stephen (designer)

bullet graph development  
by, 212–213

Simplify mantra of, 18
website of, 17

file extensions, 273
fills

chart options, 138–139
for data tables, 169
plot area transparent without, 141
using sparingly, 19, 139

Filter area of pivot table, 283–284
Filter fields, 329–330

filtering. See also pivot table views;  
slicers

cascading filters, 330
clearing on slicers, 333
determining for dashboard  

project, 16
by hiding data, 124–125
pivot table Filter fields for, 329–330
Power View filter pane for, 353–354
SUMPRODUCT function  

for, 239–240
for top and bottom displays, 195–197

filters, defined, 16
floor of a 3-D chart, 135
fonts, 36, 141
forecasting, representing, 186–187
Form controls. See also interactive  

controls
ActiveX controls versus, 272
adding to a worksheet, 250
button, 251, 257, 270–271, 274–275
check box, 251–255
combo box, 258–261
configuration options for, 250
examples in this book, online, 253
finding, 248–249
list box, 261–264
need for, 247
option button, 255–258
types available, 249
using slicers as, 339–342

Format Cells security action, 386
Format Columns security action, 386
Format Rows security action, 386
formatting. See also chart formatting; 

conditional formatting; design 
principles; number formatting

borders, 32–33
security actions for, 386
simplicity principle in, 18–19
slicers, 333–336

formulas. See also functions
in analysis layer of data model, 229
array, 3
conventions in this book, 3
excess data increasing the number 

of, 230
for histogram frequencies, 199
identifying bottom values, 207
identifying top values, 205
median line, 211
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frames, removing, 20
free-floating text, 148–149
frequency distribution, 197. See also 

histograms
FREQUENCY function, 199
functions. See also formulas

CHOOSE, 241–242, 263–264
conventions in this book, 4
for data model, 233–242
FREQUENCY, 199
HLOOKUP, 237–238
INDEX, 260–261
LARGE, 205
MEDIAN, 211
pivot table, 294–295
SERIES, 112, 116–122, 127–128
SMALL, 207
SUMPRODUCT, 238–241
VLOOKUP, 233–236

G
Get Color Codes tab (sample file), 43
glow effect, 145
gradient fill, 139
gradient line border, 140
grand totals in pivot tables, removing, 297
graphics. See pictures and graphics; 

visualization techniques
graphs. See charts
Greater Than (Highlight Cells Rules 

option), 63
gridlines

adding, 164
described, 95, 135
formatting, 164
illustrated, 94
removing, 20, 31, 32, 164
for two different axes, 164
uses for, 163

group box control, 249
grouping data

emphasizing bottom values, 207
emphasizing top values, 204–207
formulas for, 198–200
histograms for, 197–204
listing top and bottom values,  

193–197
need for, 193

H
hard-coded tables, avoiding, 226, 227
headers, de-emphasizing, 34–35

hiding data
displaying hidden data in  

charts, 124
filtering charts by, 124–125
pivot table data items, 297–299
for sparklines, 53–54
toggling series with check box  

control, 253–254
hiding pivot table items without data, 

299–301
Highlight Cells Rules

applying options, 64
described, 62
If…Then…Else… statements  

compared to, 62
options, 63–64

high-low lines, 135
histograms

bin tables for, 198–202
creating using a pivot table,  

202–204
cumulative percent series for,  

201–202
described, 197
formula-driven, 198–200

HLOOKUP function, 237–238
horizontal bullet graph, 218–219
HORIZONTAL MULTIPLES drop zone 

(Power View), 356
human error, macros for avoiding,  

265–266
hyperlink feature, 275, 386

I
icon sets

applying, 69–70
applying to a range, 69–70
conditional formatting rule type  

for, 322
defined, 69
showing icons outside cells, 75–77
showing only one icon, 73–75
showing trends with, 77–79

icons in margins of this book, explained, 4
If…Then…Else… statements, rules 

compared to, 62, 65
images. See pictures and graphics; visu-

alization techniques
importing external data

Access Export Wizard for, 367–368
drag-and-drop method, 366

Excel stored procedures  
for, 376–377

into internal Data Model, 350–353
managing data properties, 372
from Microsoft Access, 350–353, 

366–371
Ribbon commands for, 350–353, 

368–375
from SQL Server, 372–379
SQL statements for, 375–379
VBA for, 377–379

INDEX function, combo box control 
using, 260–261

Insert Columns security action, 386
Insert Hyperlinks security action, 386
Insert Rows security action, 386
interactive controls. See also Form  

controls; macros; slicers
changing chart data with drop-

down selector, 259–261
conditional formatting, 268–269
controlling multiple charts with one 

selector, 262–264
executing macros, 251, 270–271
menu using slicers, 340–342
navigation buttons, 274–275
one-touch reporting options,  

276–277
rearranging pivot table data,  

275–276
showing many views with one 

chart, 256–258
toggling a chart series on and off, 

253–255
internal Data Model

adding Excel tables to, 346–347
building out, 344–348
concept behind, 344
described, 343
external data sources in, 350–353
relating two tables using, 344–348
using in a pivot table, 348–350

intuitive dashboards, 26

K
Key Performance Indicators (KPI), 14–15
Key Performance Indicators  

(Parmenter), 15
keyboard

conventions in this book, 3–4
selecting chart elements with, 133
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L
label control, 249
labels

abbreviating month names  
on, 176–177

adding, 164
avoiding unnecessary, 21
for chart data, 134
in data model, 25
for data model documentation, 232
de-emphasizing, 23, 34–35
for display units, 134
editing, 165–167
effective, 23
implied, to reduce clutter, 177
indicating monetary values with, 34
information types in, 165
leader lines for, 165
legend key in, 166
linking to a cell, 167
moving or deleting chart data 

labels, 101
nesting for clarity, 178
numeric category, 109, 152
overriding text on, 167
pivot table areas for, 282–283
positioning, 165–167
problems and limitations  

with, 167–168
removing, 164, 168
selecting, 165
separator character for, 166
in SERIES formula, 117
on series markers, 166–167
tick mark, 158–159

LARGE function, identifying top  
values using, 205

layout
component questions for mockup, 15
drawing focus using, 22
pivot chart, 314
pivot table, 285–288, 291–292
simplicity principle for, 18–21

leader lines for labels, 165
legend

adding or removing, 150
avoiding, 21
changing the text, 150
described, 135, 149
formatting, 150

identifying series without, 151
key image in labels, 166
moving or resizing, 150

LEGEND drop zone (Power View), 356
legend entry

deleting, 151
described, 135

Less Than (Highlight Cells Rules 
option), 63

limitations
chart, 96
data tables, 169–170
Filter field, 330
labels, 167–168
pivot chart, 316
web publishing, 397–398

line breaks in titles, 147
line charts, trending using, 172
Line sparklines

changing to another type, 54
described, 49
illustrated, 50

line width for sparklines, 54
linking

automatically updating dynamic 
links, 391–392

dashboards to PowerPoint  
dynamically, 388–390

data label to cell, 167
manually updating dynamic  

links, 390–391
not functional in Excel Web  

App, 397
text box to a cell, 149
title to a cell, 148

list box control
adding and configuring, 261–262
CHOOSE function for, 263–264
controlling multiple charts  

with, 262–264
described, 249, 261
staging table for, 263

live pictures
for consolidating disparate ranges 

in one print area, 85
creating with Camera tool, 83–84
creating without Camera tool, 84
removing borders, 84
rotating, 85–86
sizing and moving, 85
updated automatically, 84

logarithmic scale
standard scale compared to, 156, 157
for trending, 175–176

lookup tables. See also VLOOKUP  
function

described, 233
forms of, 233
lookup range for, 235
VLOOKUP function for, 233–234

M
macros

adding a description to, 267
button control for executing, 251, 

270–271
for conditional formatting, 268–269
conventions in this book, 4
described, 265
Developer tab for, 266–267
enabling in Excel 2013, 272–274
examples in this book, online, 266
file extensions for workbooks  

containing, 273
naming, 267
navigation buttons using, 274–275
not functional in Excel Web  

App, 397
for one-touch reporting options, 

276–277
rearranging pivot table data,  

275–276
recording, 267–269
running, 269–270
security message for, 272
shortcut key for, 267
storing in This Workbook, 267
trusted locations for, 272–274
uses for, 265–266

maps (Power View), 358–361
markers

for bullet graphs, 215
data labels on, 166–167
for significant events, 185–186
sizing, 167

Max function (pivot table), 294
MEDIAN function, 211
median line, creating, 211
merging cells for sparklines, 53
message of dashboard, 14, 24
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Microsoft Access databases
drag-and-drop method for  

importing, 366
Export Wizard for importing,  

367–368
managing data properties, 372
Ribbon command for importing, 

350–353, 368–371
using in internal Data Model,  

350–353
millions, formatting numbers in, 39–41, 

45, 156, 158
Min function (pivot table), 294
minus symbol (-) for negative numbers, 

38, 42
Model Map, adding to data model, 25
monetary values, indicating, 23, 34
month-over-month variance view 

(pivot table), 309–310
months. See also dates and times

abbreviating names on labels,  
176–177

implied labels to reduce clutter, 177
month-over-month variance view 

(pivot table), 309–310
pivot table views by, 305–307

mouse
chart tip display for, 133
conventions in this book, 4
selecting chart elements with,  

132–133
moving around. See navigation
moving average, smoothing data  

using, 189–190
moving objects

chart elements, 101
charts, 102, 103
legend, 150
live pictures, 85
plot area, 142
positioning labels, 165–167
range highlight, 114
slicers, 333
tick mark labels, 158–159

multiline category axis, 161–162

N
naming and renaming

buttons, 271
chart series, 117–119
charts, 104
check box control, 252

macros, 267
pivot table fields, 292–293

navigation
buttons for, 274–275
hyperlink feature for, 275
macros easing, 266, 274
user-friendly, 26

negative numbers, formatting, 38–39, 
42–43

nesting labels for clarity, 178
New Feature icon, 4
no fill option, 139, 141
no line border, 140
noncontiguous ranges, 121–122
Note icon, 4
number formatting

for axes, 157, 163
basics, 37–39
commands versus Format Cells  

dialog box for, 36
conditions for, 45
custom versus conditional, 43
dates and times, 44–45
effective, 22–23, 34–35
percentages, 34, 38–39
in pivot tables, 293
positive and negative numbers, 38, 

42–43
symbols in, 80–82
syntax for, 37–42
in thousands in millions, 34, 39–41, 

45, 156, 158

O
objects, charts as, 91
On the Web icon, 5
option button control

adding and configuring, 255–256
described, 249, 255
showing many views with one 

chart, 256–258
staging table for, 257

organizational trends, showing  
performance against, 210–211

Outline Form of pivot table, 291

P
parentheses [( )] for negative percent-

ages, 39
Parmenter, David (Key Performance 

Indicators), 15

passwords
removing protection from work-

books, 383–384
requiring for workbook access, 

382–383
Paste Special command, 110–111
pattern fill, 139
PDF files

advantages for distributing  
dashboards, 392–393

converting workbooks to, 393–394
percentages

Bottom 10% (Top/Bottom Rules 
option), 66

cumulative percent series, 201–202
custom format for, 38–39, 42–43
indicating positive and negative, 

38–39, 42–43
minimum decimal places in, 34, 41
percent distribution view (pivot 

table), 307–308
showing trends with icon sets, 

77–79
Top 10% (Top/Bottom Rules 

option), 65
using Number setting for  

thresholds, 78
performance against a target

bullet graph for, 212–219
defined, 209
organizational trends as target, 

210–211
range as target, 219–221
thermometer-style chart for, 212
variances for showing, 210

picture fill, 139
pictures and graphics. See also icon 

sets; visualization techniques
appropriateness of, 144
avoiding in dashboards, 19
converting charts to, 126
inserting in plot area, 141
live pictures, 83–86
of pivot charts, 325–326
for series formatting, 143–144

pivot cache, 290, 314
pivot charts

alternatives to, 324–328
axes of, 315–316
conditional formatting integrated 

with, 316–319
creating a picture of, 325–326

www.it-ebooks.info

http://www.it-ebooks.info/


Index 407

creating from pivot tables, 312–314
custom conditional formatting for, 

319–323
data bars in, 317–318
deleting the underlying pivot  

table, 325
described, 311
disconnecting from pivot tables, 

324–326
layout of, 314
limitations, 316
pivot field buttons on, 313, 326
pivot tables as basis of, 311
pivot tables’ link with, 314–316
removing conditional formatting 

from, 319
removing pivot field buttons from, 

313, 326
standard charts versus, 311–312
updated when pivot table changes, 

313–314
pivot slicers. See slicers
pivot table views

changing, 288–289
macros for, 276–277
by month, quarter, and year,  

305–307
month-over-month variance,  

309–310
percent distribution, 307–308
removing filters, 305
top and bottom, 195–197, 302–305
year-to-date (YTD) totals, 308–309

pivot tables. See also slicers
adding analysis layers, 287–288
adding fields to, 285–287
blank cells and Count versus Sum 

function, 295
changing summary calculations, 294
changing the layout, 291–292
Column Labels area, 282–283
Compact Form, 291
copying and pasting, 290
creating, empty, 284–285
creating pivot charts from, 312–314
creating standalone charts con-

nected to, 326–328
creating standard charts from,  

324–325
data model for, 229
described, 281

disconnecting pivot charts from, 
324–326

in Excel Web App, 398
expanding the Fields List, 287
Filter area, 283–284
Filter fields, 329–330
functions, 294–295
hiding and showing data items, 

297–299
hiding and showing items without 

data, 299–301
for histogram creation, 202–204
laying out, 285–288
macros for filtering, 276–277
macros for rearranging data,  

275–276
number formatting, 293
Outline Form, 291
pivot charts based on, 311
pivot charts’ link with, 314–316
pivot charts updated for changes  

in, 313–314
removing all subtotals, 295–296
removing conditional formatting 

from, 319
removing grand totals, 297
removing subtotals for one  

field, 296–297
renaming fields, 292–293
replacing empty cells with a  

value, 301
Row Labels area, 282
security actions for, 386
sorting, 301
space and memory required for, 290
standalone charts connected  

to, 326–328
suitability for dashboards, 281
suppressing subtotals in, 295
Tabular Form, 291
for top and bottom displays,  

195–197
underlying pivot charts, deleting, 325
updating, 289–290
using the internal Data Model in, 

348–350
Values area, 282

plot area
described, 135
formatting, 141–143
illustrated, 94
transparency of, 141

plot order for series, 120–121
plus symbol (+) for positive numbers, 

38, 42
points. See data points
positive numbers, formatting, 38–39, 

42–43
Power Utility Pak, 7, 168
Power View

canvas, 353, 354
changing the dashboard look, 361
charts, 354–358
creating a dashboard using, 353–361
described, 343
Excel versions supporting, 343
field list, 353, 354
filter pane, 353–354
visualizing data on a map, 358–361
worksheet created for, 353

PowerPoint
automatically updating dynamic 

links, 391–392
linking dashboards to, 388–390
manually updating dynamic  

links, 390–391
presentation layer

excess data degrading the  
performance of, 230

overview, 229
worksheet tab for, 231

printing
charts, 105
checking dashboard’s before  

distributing, 26
consolidating disparate ranges  

for, 85
preventing embedded chart  

from, 105
priority zones of focus, 22
procedure conventions in this book, 4
Product function (pivot table), 294
protection. See security
purpose

checking before distributing  
dashboard, 24

of dashboard project, 14
performance measures  

supporting, 15

Q
qualitative bands for bullet graphs, 218
quarter, pivot table views by, 305–307
Quick Access toolbar, 82–83
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R
ranges. See also chart series or data 

series
applying icon sets to, 69–70
applying worksheet protection to, 

385–386
auto-updating for sparklines, 59
changing the highlight for, 111, 

113–115
colors for, in data model, 232
consolidating in one print area, 85
converting Excel tables to, 245
converting references to arrays, 

127–128
converting to Excel tables, 244–245, 

345
copying and pasting in  

charts, 110–111
creating chart sheets for, 92
in data model, colors for, 26
noncontiguous, 121–122
performance against a  

target, 219–221
removing worksheet protection 

from, 387
Select Data Source dialog box for, 

111–112, 115
unlinking from charts, 125–128
unlocking editable, 384–385
updating for pivot table, 289–290

read-only access for workbooks,  
382–383

recording macros, 267–269
reference line for sparklines, 56–58
RemoveDataBars macro, 268–271
removing or deleting. See also  

de-emphasizing
axes, 21, 162
borders, 20, 84
chart elements, 100, 101
charts, 104
color from table cells, 31
conditional formatting from pivot 

tables and charts, 319
data bars, macro for, 268–271
filtering on slicers, 333
filters from pivot tables, 305
frames, 20
gridlines, 20, 31, 32, 164
labels, 164, 168

legend entirely, 150
legend entry, 151
pivot field buttons from pivot 

charts, 313, 326
pivot table grand totals, 297
pivot table subtotals entirely,  

295–296
pivot table subtotals for one  

field, 296–297
pivot table underlying a pivot  

chart, 325
security actions for, 386
series from a chart, 113
series name, 119
sparklines individually, 52
suppressing pivot table  

subtotals, 295
workbook-level protection, 383–384
worksheet-level protection, 387

renaming. See naming and renaming
repetitive tasks, macros for, 265
reports

actionable data in, 302
dashboards compared to, 12–13
described, 12
key attribute of, 12
macros for one-touch options,  

276–277
resizing. See sizing
Ribbon commands

for chart formatting, 101, 135–136
for importing Access databases, 

350–353, 368–371
for importing SQ Server databases, 

372–375
right-aligning numbers, 34
rotating

live pictures, 85–86
3-D rotation effect, 145

Row Labels area of pivot table, 282
rows of charts

security actions for, 386
switching orientation with columns, 

98, 108, 214
running macros, 269–270

S
scalability, excess data limiting, 230–231
scales for axes

automatic calculation of, 153
keeping constant across related 

charts, 155

logarithmic, 156, 157, 175–176
Minimum and Major Unit value 

adjustment for, 174
misrepresenting data using, 153, 

154–155
overriding automatic  

calculations, 154
Reverse Order option, 156
starting at zero when trending, 

173–175
time-scale category axes, 160–161
values on, 94

scatter charts
creating from pivot tables, 326–328
not available for pivot charts, 316
value axes in, 153

scope, indicating on dashboard, 25
scroll bar control, 249
secondary category axis, 135
secondary value axis

for bullet graphs, 216
for comparative trending, 182–183
creating, 128–129
described, 135
title, 135

security
Excel Web App, 397
limiting access to specific work-

sheet ranges, 384–386
message for macros, 272
for PDF files, 393
removing workbook protection, 

383–384
removing worksheet protection, 387
for workbook access, 381–384
for workbook structure, 386–387
worksheet-level protections  

available, 386
Segoe UI font, 36
Select Locked Cells security action, 386
Select Unlocked Cells security action, 386
selecting

chart as an object, 132
chart elements with Chart Elements 

dropdown, 133–134
chart elements with keyboard, 133
chart elements with mouse, 132–133
data labels, 165

separator character for labels, 166
series. See chart series or data series
series axis, 135
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SERIES formula
adding new series using, 112
category labels in, 117
converting range references to 

arrays, 127–128
deleting a series from, 119
editing, 116–117
multiple sheets in, 122
naming series in, 118
noncontiguous ranges in, 121–122
plot order for series in, 117, 120
renaming series in, 119
syntax for, 117

series lines, 135
shadow effect, 145
sharing your work. See also security

distributing dashboards to 
SkyDrive, 394–398

distributing dashboards via PDF 
files, 392–394

linking dashboards to PowerPoint, 
388–392

side-by-side time comparisons, 179–180
simplicity principle

avoiding chart junk, 19–21
in formatting, 18–19
keeping to one page or screen, 21
limiting data to support the  

purpose, 18
Single Accounting underline, 32, 33
sizing

bubbles in bubble charts, 117
charts, 102
legend, 150
live pictures, 85
plot area, 142–143
series markers, 167
slicers, 333–334
sparklines, 52–53
titles, 147

SkyDrive
advantages of distributing dash-

boards to, 394–395
publishing a workbook to, 395–396
ways to share a published work-

book, 397
web publishing limitations, 397–398

slicers
clearing filtering on, 333
colors, 335
creating standard, 331–333

data item columns for, 333–334
described, 329
Filter fields versus, 329–331
formatting, 333–336
menu using, 340–342
for multiple pivot tables, 336
placing, 333–334
settings, 335–336
sizing, 333–334
styles, 335
Timeline, 337–339
using as Form controls, 339–342

SMALL function, identifying bottom 
values using, 207

smoothing data for trending
custom calculation for, 190–191
moving average for, 189–190
need for, 188

soft edges effect, 145
solid fill, 139
solid line border, 140
Sort security action, 386
sorting

on key data point, 35
pivot tables, 301
security action for, 386

sparklines
aspect ratio for, 53
auto-updating ranges, 59
axis scaling options for, 55–56
changing the type, 54
colors for, 54–55
Column, 49, 50
creating, 50–51
date axis for, 58–59
deleting, 52
described, 47
development of, 47
displaying in a different sheet, 51
displaying in cells, 51, 53
editing individually, 52
emphasizing key data points, 55
Excel versions supporting, 47
groups of, 52
hiding data for, 53–54
Line, 49, 50
line width for, 54
merging cells for, 53
reference line for, 56–58
showing hidden data in, 54
sizing, 52–53

ungrouping, 52
updated automatically, 51, 59
usefulness of, 48–49
Win/Loss, 49, 50

spin button control, 249
Spreadsheet Page website, 7
SQL Server databases

importing, 372–375
passing SQL statements to, 375–379

SQL statements
editing manually, 375–376
in Excel stored procedures, 376–377
passing to SQL Server databases, 

375–379
VBA with, 377–379

stacked time comparisons, 181
staging tables

for check box control, 254
for combo box control, 260
for list box control, 263
for option button control, 257

StdDevP and StdDev functions (pivot 
table), 294

stock charts, not available for pivot 
charts, 316

styles
applying to charts, 99–100
applying to slicers, 335

subtotals in pivot tables
removing all, 295–296
removing for one field, 296–297
suppressing, 295

Sum function (pivot table), 294, 295
SUMPRODUCT function

applying formulas to a data  
model, 240–241

described, 238–239
filtering values using, 239–240
syntax, 239

symbols. See also icon sets
described, 79
showing trends with, 79–82
steps for using, 80–81
Unicode characters for, 79

syntax
CHOOSE function, 242
HLOOKUP function, 237
for number formatting, 40–42
number formatting, 37–39
SERIES formula, 116–117
SUMPRODUCT function, 239
VLOOKUP function, 234
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T
table design. See also design principles

examples in this book, online, 29
number formatting, 34–35
principles, 30–36
underestimation of, 29, 30

tables, data. See data tables
tables, Excel. See Excel tables
tables, pivot. See pivot tables
tabs

Chart Tools context, displaying,  
92, 93

for data model documentation and 
organization, 231–232

Tabular Form of pivot table, 291
templates, chart, 142
testing your data model, 232
text. See also labels; titles

free-floating, 148–149
keyboard shortcuts for, 137
legend, 150
overriding for a label, 167

text boxes
for free-floating text, 148–149
linking to a cell, 149
for titles, 147

Text That Contains (Highlight Cells 
Rules option), 63

texture fill, 139
Themes (Power View), 361
thermometer-style chart, 212
30-day trial version of Power  

Utility Pak, 7
thousands, formatting numbers  

in, 34, 39–41, 45, 156
3-D rotation effect, 145
tick marks, axis, 158–159
Timeline slicer, 337–339
times. See dates and times
Times New Roman font, 36
time-scale axes, 159–161
timestamp on dashboard or  

report, 23, 25
Tip icon, 4
titles

adding to a chart, 147
black on white, 136
category axis, 134
chart, 134
descriptive, 23, 25
editing the text, 147

formatting the text, 147
line breaks in, 147
linking text to a cell, 148
in pivot charts, 316
secondary category axis, 135
secondary value axis, 135
sizing, 147
text boxes for, 147
types of, 146
value axis, 135

top and bottom displays
concept behind, 193
insufficient records for, 304
organizing source data for, 194
in pivot charts, 319
pivot tables for, 195–197, 302–305
ties for a rank in, 197, 304

Top 10 Filter
for pivot table views, 303
for top and bottom displays,  

195–196, 197
Top 10 Items (Top/Bottom Rules 

option), 65
Top 10% (Top/Bottom Rules option), 65
Top/Bottom Rules

applying options, 66–67
If…Then…Else… statements  

compared to, 65
options, 65–66

transparency of plot area, 141
trend, defined, 171
trending. See also performance against 

a target
chart types appropriate for,  

172–173
comparative, 179–183
directional, 187–188
dos and don’ts, 171–178
emphasizing time periods, 184–187
forecast representation, 186–187
icon sets for showing, 77–79
label management for, 176–178
logarithmic scale for, 175–176
moving average for, 189–190
performance against organizational 

trends, 210–211
pivot chart limitations for, 316
popularity of, 171
small-scale changes, 175
smoothing data for, 188–191
sparklines for showing, 48

starting vertical scale at  
zero, 173–175

symbols for showing, 79–82
tables not suited for, 48
vertical bar chart for, 177–178

trendline equation, 135
trendlines

avoiding, 21
described, 135

trial version of Power Utility Pak, 7
trusted locations for macros, 272–274
Tufte, Edward (visualization guru), 47

U
underline, Single Accounting, 32, 33
ungrouping sparklines, 52
Unicode characters for symbols, 79
unlinking ranges from charts, 125–128
unlocking editable ranges, 384–385
updating

charts, automatic, 91
dashboards, 17, 25
dynamic links, automatically,  

391–392
dynamic links, manually, 390–391
live pictures, automatic, 84
pivot charts, automatic when pivot 

table is updated, 313–314
pivot tables, 289–290
sparkline ranges, automatic, 51, 59

up/down bars, 134
Use AutoFilter security action, 386
Use PivotTable Reports security  

action, 386
user requirements for dashboards

audience, 14
data sources, 16
dimensions and filters, 16
drill-down features, 17
importance of gathering, 13–14
Key Performance Indicators, 14–15
purpose and message, 14
update schedule, 17

user-friendly dashboard features, 26

V
value axes. See also axes

category axis versus, 152–153
creating a chart with four, 129–130
creating secondary, 128–129
described, 94, 135
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illustrated, 94
number formats for, 157, 163
scale values on, 94
scales for, 153–159
in scatter charts and bubble  

charts, 153
secondary, described, 135
secondary, for bullet graphs, 216
secondary, for comparative  

trending, 182–183
tick marks for, 158–159
title, 135

Values area of pivot table, 282
variances

month-over-month variance view 
(pivot table), 309–310

performance against a target  
using, 210

VarP and Var functions (pivot table), 294
VBA

dynamic connections using,  
377–379

not functional in Excel Web  
App, 397

VERTICAL MULTIPLES drop zone (Power 
View), 356–357

visualization techniques. See also 
charts; dashboards; pictures and 
graphics; specific techniques

conditional formatting, 61–79
icon sets, 69–70, 73–79
live pictures using Camera tool, 

82–86
sparklines, 47–59
symbols, 79–82

VLOOKUP function
adding formulas to a data  

model, 235
described, 233

drop-down lists using, 236
lookup range for, 235
syntax, 234

W
Walkenbach, John (co-author), 7, 168
walls of a 3-D chart, 135
websites

chart examples (chapter 5), 90
chart formatting examples  

(chapter 7), 143, 151
chart series examples  

(chapter 6), 107
companion site for this book, 5, 11, 29
data grouping examples  

(chapter 9), 195
distributing dashboards to 

SkyDrive, 394–398
Facility Services Access  

database, 350
Form control examples  

(chapter 12), 253
internal Data Model examples 

(chapter 17), 345
macro examples (chapter 13),  

266, 274
pivot table examples (chapter 14), 284
Power Utility Pak trial version, 7
sharing your work (chapter 19), 388
The Spreadsheet Page, 7
Stephen Few’s, 17
VLOOKUP formula examples  

(chapter 11), 235
web publishing limitations,  

397–398
Win/Loss sparklines

changing to another type, 54
defined, 49
illustrated, 50

workbooks
chart locations in, 91
macro storage in This  

Workbook, 267
macro-enabled, file extensions  

for, 273
protecting the structure of, 386–387
read-only access for, 382–383
removing protection from, 383–384
requiring a password to open, 383
securing access to, 381–383

worksheets
adding Form controls to, 250
limiting access to specific ranges, 

384–386
maximum charts in, 96
maximum referred to by a chart, 96
for Power View, 353
protections available for, 386

X
.xlsm and .xlsx file extensions, 273

Y
year, pivot table views by, 305–307
year-to-date (YTD) totals view (pivot 

table), 308–309

Z
zero (0). See also decimal places

replacing empty pivot table cells 
with, 301

starting vertical scale at, for  
trending, 173–175
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